12 Cadence IC 5.1.41 FIEAREE

A& Cadence IC 5.1.41 Ziil MITANTIERE,  H BE L3 78 NIFE Al 2 014 1 i ik
XESERDNRET — AN TE. ARTEFRZEHNEWT: [1] JH3) Cadence IC HIHIHER; [2]
Command Interpreter Window (CIW, iy 447 % [1); [3] Library Manager B&il E5 #L 48 [4]

Virtuoso® Schematic Editor Hi i 2% 24 /1 [5] Virtuoso” Analog Design Environment (ADE) fi
AN
o

1.1 J33IarnEs

HEYE Unix/Linux {# f] Cadence IC 5.1.41 T2 4 {R4UE LR 4 1F

[1] fRIUE Cadence IC 5.1.41 T4 i 00 IEM b e /r i b JF HERAF AR D2 WA
SE o

[2] 7& Shell T E T IEM IS AL 5.
WK Cadence IC )22 3¢ % A2 M Shell 85548 5, Cadence IC 5.1.41 A AEIEHI21T - LA Cshell
J3f5], Cadence IC #% Z¢3%1E T /tools/cadence/ic5141, WIF5EAE~/ .cshre SCAFH I IXFE ) 442
LW zaEIE

setenv ic50 /tools/cadence/ic5141

set LD _LIBRARY_PATH=($ic50/tools/lib  $ic50/tools/dfIl/lib  $ic50/tools/tcltk/  tcl8.0/lib
$LD LIBRARY PATH)

set path = ($ic50/tools/bin $ic50/tools/dfIl/bin $ic50/tools/dracula/bin $path)

WA DS BRI W E S AR — AR B SR B0, R B i I B S A CE S
/env/cadence 5141 H1, WJw] PAZE~/.cshre H IIA—1T

source /env/cadence 5141

L1l EZEEMH: .cdsinit

.cdsinit & 7E Cadence IC H i B IE 4T 1) SKILL A SO o 1% SCAHBCE T 1R 2 Cadence IC
5.1.41 (AEENCE, AR SOR g . ABERCE . D7 A BARC E 25 . Wk Cadence IC
WA 2. edsinit ST, BAFH R PRAESE S D REEANBRIE H

Cadence IC 8% .cdsinit XN, HESM RN ESN RS, REEREPZH T EH%.
%ilhn: FE~/project H % FIiZAT ictb&, WNJE 4% Cadence IC & 2R N\ ~/project/.cdsinit. 471 FIX 4
SAFAAFAEN 22 2 3~/ cdsinit.

BRI B ST A
<Cadence T_H H 3x>/tools/dfll/samples/local/cdsinit

112 AR E S
WURFFEL, {ERE e iiatr H st 2 HA ) J5 S EC & S, n.cdsenv .cdsplotinit, display.drf %
TXLEELE SO A H SR H

cdsenv: T CEJH BN AT AR &

.cdsplotinit: Cadence IC F7 E[1F14 tH &l 284 (1) 1



display.drf: i P&l 2 45 s 527 B0 S5 1 T
TXSEWE B SO R AR e AT A B H e LGB I H S e XSS E SO REA
R

.cdsenv: <Cadence ‘%% H s%>/tools/dfll/samples/.cdsenv
.cdsplotint: ~ <Cadence ‘Z3% H s%>/tools/plot/samples/cdsplotinit.sample
display.drf: <Cadence “%%% H >%>/share/cdssetup/dfll/default.drf

1.1.3 WERITERESMH: cds.lib
WU (library)BC & SCAFUCE AE Cadence 1C FE/FIIBATERR . LW AE~/project H 3 FigAT
Cadence IC, WFFZAE1ZH 3 F#EA eds.lib SCAF. IXANSCAFXCE 192 Cadence IC H AW T PE ) %

VA
120

i H iy A 4% 2
® DEFINE
#3: DEFINE <[4 > <JF 15>
® INCLUDE
#5: INCLUDE <J5j4b—A" cds.lib 114 42>
o #

ITHERESE, AT B I NNZAT AL
W eds.lib XA, W) Cadence IC FATHPEHR LSS . A TS INEA TG
fEE, FRE—SEIEA O, AT BAAE ceds.lib SCAEF AN —A4T:

INCLUDE <Cadence %% H>/share/cdssetup/cds. lib

1.2 24T & 0 (Command Interpreter Window, CIW)

SER IR EE 2 5, Wi LAFE T 24T FI24T Cadence 1C5.1.41 KA
icfb &

Cadence IC [y 24T % 1 (PR N fr 2R 4y, Command Interpreter Window, CIW) st 2 H I

icfb - Log: fhome1/gongwc/CDS. log T T P

ey -

7,¢$ ——» | File Tools Options Help | 1
Loading schWiew. cxt

Loading selsctSw. cxt

Loading seismic. oxb

Loading UltcaSin. cxt

PN [END OF USER CUSTOMIZATION

P

AT —> 1
Bk A

EL:LJ‘/]VHLE/,(\—V mouse L: M: R:
o>

fth ——>

B1.1 m&fTEa (CIW)
T DR LA 2 SRR, W . AT Bbsm A, R

1.2.1 98 4TH O (CIW) K3
CIW PRI 2 DUR IR, T R 48 Ho be A B ) — S e I



File Tools Options

MHews | Conversion Tool Box... ‘ .
Library Manager... Save 3ession...
DRt il 22 e Save Defaults...
A piios i -
Export o
Synopsys Integration... User Preferences...
itk Router Browser Preferences...
Make Read Only,., | onstraint Manager..
Mixed Signal Environment Log Filter...
Close Data... Analog Environment License...
Defragment Data VEHE
- -tr'-lg Technology File Manager... Checkout Preferences...
wibon Display Resource Manager... Checkin Preferences...
CDF
AMS
Camera
SKILL Development...
A1.2 CIWEEEFAR
File>New
FENT BT ZE (Design Library) 5l % 311 CellView;
File—>import
SN, TG B gds &l L cdl MK, BIYEEFL 4 verilog ARRS 4%
File>Open

FTTF “Cell” (1) “View”, HRIEAFIF “View” [FJZET, Cadence K IEFEIE 1 gl i,
R —A “View” J&— N5 (symbol)l] Cadence ¥fi%F¢ Virtuoso Symbol Editor ] 7F;
FZ—NHEE K (schematic) NI Cadence 43 1EFf Virtuoso Schematic Editor 4T JTF; Wit g—
A B (layout) £ H Virtuoso Layout Editor 1 F; Wi /& Verilog 5% Verilog A AR5 )2 F 5C
ARGt 2FTIT o

File>Export

S, [FEE, ALK Cadence BEVHZE S H APl SC A28,
File> Exit

iR icfb TAEHEL,



® Tools—>Library Manager

4 AR L E‘:':‘n WA HI = — NRE NG P
MRS AL BT R s, S Qe 1.3 Frse JE iR iEg 4 i s
brary Manager: Directory ...e1/gongwc/project/SDIC_bandgap o [l
Fle Edit View Design Manager Help
Show Categories Show Files
Library Cell View
US_8ths fhsize o Teymbol
SDIC_bandgap Asize symbol
US_8ths Asize_hook
ahdlLib Asize_hook_c
analogLih Asize o
basic Balze
cdsDefTechLib Esize_c
functional Csize
rfExanples Csize o
rfLih Dsize
£sme35mm Dsize_c
Esize
Esize o
Fsize
Fsize ©
Messages
in /libs/TSMC3. 3¥5V/Tsmc_035SMM_PDE_200606/cds. 1ib
to suppress this warning message.

Kl 1.3 “Library Manager” 51

® Tools—>Library Path Editor

File Edit View Design Manager Help
Libraries
Library Path
teme3Smm . /tsmc35nm
cdsDefTechli|. . /.. /. . /tools/dfII/etc/cdsDefTechLib
basic . F0 4 fetefodslib/basic
US_8ths . f f . fetefodslib/sheets /US_Sths
analogLib CF 4 fetesodslibfartist/analoglib
functional |../../ ./etefcdslib/artist/functional
cfLib CF 4 feamplesfartist/ofLib
cfExamples |, . /. ./ . fsamplesSartist/rfExamples
ghdlLib LF 4 feamplesfartist/ahdlLib
SDIC_bandgap | /homel/gongwe /project/SDIC_bandgap/SDIC_bandgap
To add a new library definition, type the hame in the Library column and the path
to the library in the Path column. Press RETURH to continue adding libraries.
When done, select the menu ‘File -» Save As ~5’ to save your edils into another file.

&l 1.4 “Library Path Editor” 5t

ROZ M IRAZ SEBE T P L B S (cds lib) I B AL SR 1T, WP 1.4 s e AR AN F i b m] A EDW
MR cds.lib SCAFHEATAE ORI N o
® Tools—> Verilog Integration
A 2 AR5 i Verilog-XL FI NC-Verilog, J&Fifl Verilog 1 XLHEE, FIFHRAE
o LR R L ) O
® Tools—> Analog Environment
PSR TR I, BT LA
Simulation: T JF Virtuoso®” Analog Design Environment (ADE)



Virtuoso?Analog Design Environment (2)

Status: Ready T=27 C Simulator: spectre 8
Session Selup Analyses VYariables Oulpuis Simulation Results Tools

Help
Design Analyses _%

# S £s. .. . Enzhl
Lib TEST Type rqunents nable :?;RN
anc
Cell sampled
19 =
View  schematic l 3 I
Design Variables Outpuls [Ej

#  Neme Value #  Name/Signal/Expr Value Plot Sawe March

Plotting mode: Replace

5 wwlew <

K 1.5 “Analog Environment” 5t
Calculator: T X0 45 AT HE— P BT HE 2 TR
Result Browser: 1)j B 45 B9 % 28
Waveform:  {fi HL.45 Rer IR P . 1R 2L T HE AP A S A E A2,
® Tools>Technology File Manager
T BT PE RIS 2 TR) R0 Y R R

Technology File Tool Box s el
File Help a3
Hew ... Attach...
Load ... Dump...
Edit Layers... Edit Rules...
Check... Save...
Qcell... Discard...

1.6 “Technology File Manager” St
® Options
ISR A R BT T ] T L. icfb PRI IF CR A7 /BN T SR & - iz i it 7R T
R AR TR

1.2.2 CIW i H At ER 2

B O, WP 17 B B EOR— SR E R A AR SRR, A R A R £ L
BRI . XA B T T A R ) el

AT EIX R4 LUEAT SKILL 5 5 1 2, AL a4 nl LIk i b (T4 200 5 B4 74
PR B S e 8 4 LR R, BRI LA SKILL 1 5 45461 o

Or remove or conment out DEFINE analogLihb
in flibs/TSMC3. 3VEW/Tsme_ 035MM PDE 200606/ cds. lik
to suppress this warning nessage.

1.7 CIW Hh iy & 1 5 AT
CIW HP Iy 7 VR AT P E— i S b B2 — N & 5. 215 52 SKILL 55 . EIE
T PR AT IR o 7 B ST b (AT AnT 45 1 o3 R e S ol ok oy 247k e 28 52
. DR B A AT ] LASE s — U034, 48R a8 SEBR B H H IX FEAOFAN T (3
AT B AR 2 ] LUK F R 5 45 S 2 B384, I oo DAEAT 0O, ¥ & 5 SR Ak



2

XAE R TR A AR A S I, X2 Cadence IC IXANFAF ) HE 25U
PRk 1.8 s, R B ARl ey B AR B S AT SKILL fir 4o

mouse L: H: E:
B 1.8 Elbrdn & & 1
FORES: X P> Sk, s 1.9 R, ORI T IEAE Cadence IC FEFF I DIRESE R .
|»

Kl 1.9 $RigH
DU AR — M e vk Rt v A S, o — 8 T LA T PR A
1. 3 Library Manager % v & F 2%
IR T R P A4S (Library Manager). & 1.3 I U2 B R HASE 1, W4T

FFF- B B2 (11 73 S (Category) [ AR AT SCAF - (Files) THIAR W Z 7= S an &l 1.10 Fros. 514 A W
NI AL, TR SRR IR B RN AR B, LU —— A

Library Manager: Directory ...e1/gongwc/project/SDIC_bandgap

File Edit  View Design Manager Help

» Show Categories ~ Show Files

cfLib
tame35mm

Library Cell-level View -level
SDIC_bandgap Cells In Library Wiews In Cell
Us_8ths peapacitor ani
shdlLib d pdiode aucdl
analoglib pinductor aulvs
hasic Dmind cdsSpice
cdsDefTechLib presis tor hspicel
functional Do hspices
cfExanples spectre

spectre
aymbol

Messages

in /libs/TSMC3. 3WEV,/Tsnc_035MM_PDE_200606/cds. Lib
o cuppress this werning message

B 1.1 &iHEE R 22 (Category) EMRFIH (Files) HR

13,1 Bl PR SR

BT FED AR AN & 1.10 Prose AR T3 FER AR 1 s, WZE B30 4 £,
MR BETEEE (Library)s 2851 (Category)s H.yt (CelD. fon (View) #2. A7 3 *éqjﬁﬁ
th A O PR IS A A IR A AR A TR i ) I IR R s P ) o AR v SR R R et R
“analogLib” TN, IO BRI gie 702K “Parasitics” H T INE, FAE “View” £
FRGH s BT “peapacitor” ITALE RN 2F

T34, ERTLAFT I “Show Files” BEIR, Won&ANHICHT “View” Frvf WSO, sl &
PR BESS AT R AP AL, FREE “Files in Library” 1 “Files in Cell”. X LR — F &4 2
DI X, DA B AR IR A 1) FH 3
® Uit RAE cds.lib U E . — N EET AT BLE A 2ot SRR Bovk AT LA

Ferm A RGP B e B ] DL ARSI H o R R RO . X
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FEAES G R &4 . A SRR IR R ).

® FITILZE— N AR, — AT Y T RS I — AN, XML A LUK ZE
B, FRoREsr s Wl OB TR, RN

® [ —AHITIE R TR R R IR 5%, B — ML R AT, At T A A PR I i
AR T B T R R O F R L T S | RS R I e ) 55 20K o o — AN R 5 B
TS ] ERD B 1] B 7R BRI TR s A R B R — AN 50 o T A — N R T b 2 2 R R oR T
X, BN “Views”o EIIZS B nf LA HL ] (schematic) #HFFTS5 (symbol). i
(layout) =/~ (View)o FEW TN MLRAER—4 “Cell” &4 “View” JEERLIM .

®  MIRAE BRI ICZ A A G IN — AN PR IR, 2 — B R R LR (1 I,
Al LA 3 20 07 SRERRE W B B e A 2. AE /NI B TR T A A AN L B, XN RT LA
LE TR S /s B A B 74328 (Show Category) £, 4328wt kil .

FEZTRC, AR A Rl vk L HoeEE “View” At i El. s TR
2 A%, WadTIT. MER. Bah. 2l mikdE. XL s B KB A &, IXH
AR 4

1.3.2 Wi FEN A S

SRR 22 A 2 RN BT R BRLAS T AR ) A B A oP 1K 2 S AH R X L R BN ]
AP A S
® Files S H:
B Files>New->Library/Cell View/Category: #7 i 31/ #.I0 View/7r 3
B Files>Save Defaults/Load Defaults: ¥ 5 112 31 Yo 8% ¥ B AR A7 7E.cdsenv LR
B Files>Open Shell Window: ] JT Shell fir 475 11, 765 BV TF e (1IN 20 B )
Bl — SRR, X AT LT IF Shell % H, AEfr 247 kA7 SO A
® Tools 3¢t
B Tools>Copy Wizard: mZR MBI I T XA SR AN, v LI7E S
R —AT IR S I £
S (Simple), W& 1.11 fin. EXAMEE L “Add To Category” A%7]
DLAR € #5 DUk 265 i s oo s v R F B I FEAN 732K
“Destination Library” "N d e T ¥ VUK H AR UH
Pl mPOE T ARE R 2 H PR P AT P DL SRR TT I 9136 o ARz 8 3 TP i B — AT AT
DA 3E ik 328 B e o T PR ¢ €0 el 2 FHAZ 00 ()9 DA S POk e 8 08T Jid SRR
P DU . T I =N T PR BT EE B G .
WCE SE U mith OK JEAT#E DUHAE



Copy Options

Simple Hierarchical Exact Hierarchy By View By Configuration
Add To Category |} Cells

Generate Copy List (not needed})

Destination Library SO0TC_bandgap v Update Instances:  f Esties Libvary
Fram Lib Fram Cell From View To Gell To View
® SDIC bandgep bandgep_compens |schematic bandgap_compens |schematic
®|SDIC_bandgap | bandgap_ush prop s bandgap_ush prop.
®|SDIC_bandgap | bandgap_ush schematic bandgap_ush schenatic
®|SDIC_bandgap | bandgap_ush schematicl  |bendgep_ush schematicl
»|5DIC_bandgap | bandgsp_ush_new |schematic bandgap_usb_new |schematic
»|5DIC_bandgap | bandgsp_ush_new |schematic bandgap_usb_new |schematic
»|5DIC_bandgap | bandgsp_ush_new |schematic bandgap_usb_new |schematic
»|5DIC_bandgap | bandgsp_ush_new |schematic bandgap_usb_new |schematic
® | SDIC_bandgap / prop.sx / prop. s

N

Select All| Deselect All| Clear All

oK Apply Check Files Cancel Help

Bl 1.2 B aEXER
J2 IR G5 #3E D1 (Hierarchical ) RIS 2R 45 ## U1 (Exact Hierarchical)# =4 &l 1.12 fr
TRo

Copy Wizard py Wizard

Copy Options Copy Options
Simple Exact Hierarchy ) By View By Configuration Simple Hierarchical By View By Configuration

Copy Hierarchically Copy Exact Hierarchy

Top Library EDIC_bandgap ) Ty SE ey
Top Cell Top call
Views To Copy Top View
. Extra Views
s . Us_Bths shdlLib analogLib basic cdsDefTechLib functional
p Libraries =
rfExamples rflib tsme3Smm 3K , U5_8ths ahdlLib analoglib hasic cdsDefTechLib functiomal
p Libraries e
rfExemples cfLib tenc3Smm
Add To Category |§ Cells ¥

Add To Category || Cells |}
Generate Copy List (needed) s i T
enerate Copy List (neede

Destination Library 'SDIC bandgap ¥| ¥ Update Instances:  Of Entire Library Destination Library 'SDIC_bandgap w| W update Instances:  Of Entire Library

Complex Copy Operation Complex Copy Operation

o sal i [infite copy o tion | sadpirtiitheldes Eedlliform ation gy §  Ptease fil in the copy option fields with the desired information
) et ile s gy (057 i Wit (e i b press the Cainaat Copy List’ button when finished 1o obtain
0 O [ 01 TS (G e a valid list of views to copy.
0K Apply Check Files Cancel Help oK Apply Check Files Cancel Help

K13 éﬂ«/\fnﬁ%mﬁﬁmgﬁf/\«nﬁ%m
AR E TR BTG, XA W] LKA —AN B0 I [F) L vh B el e 482 5 | I i) A7 530G
*i%ﬁlo AR, JRIREEFHE DI A FRX L Ie P T “ View”s  TIASAHZHZA
ShkEs VI UEERE R “View” B UL,
“Add to Category” F1  “Destination Library” 3 I ff)/F H A1 {5 5045 U1 A 46 AR TR

*E??E“View” (By View)[{1#5 UL, Wikl 1.13 fros. iX PR, K de e e e 15t )€ (Filter)
RIS DR S G,



Copy Wizard

Cupy Oplions
simple  Wierarchical | Exact Hiersrchy |7 Dy view ] 1 By Configuration
Copry Dy View
Library [S010_bandgap
Cell Filler
Maws To Copy | [+
Aeld To Categary ']_ cons I
Generate Copy List (needed)
Destmation Libeary SN0 _handgap v | Uptiate instances:  Of Cibirs Library
Comphys Copry Operation
1 P 8 in the copy option fekds wilh S desined ifeamation
and prass e “Ganarata Copy LISt bitton whoan fshad 1 ol
a valld st of views 10 copy.
0K Spply Chick Filies Comend Help

K 1. 13 RIE “View” HIEEN

IR¥E configuration (By Configuration) H#5 UL, Wik 1.14 frx. XABECR, K
config view H [FIHC B KL B 77 2285 DU L0 R View.

[ Copy Wizard
Copy Options
Simple Hierarchical Exact Hierarchy By View By Configuration

i

oK

Copy Using Configuration

Library ISDIc bandgap
cell ‘bandgap_conpensated
Config View ischematic
S i s '%ifﬁi&i%ﬁﬁ?ﬁ%ﬁ basic cdsDefTechlib functional
Add To Category | Cells ¥
Generate Copy List (needed)
Destination Library [SUTC_bandyap v Update Instances:  0f Eties §ibrary

Complex Copy Operation

Please fill in the copy option fields with the desired information
and press the ‘Generate Copy List’ button when finished to obtain
a valid list of views to copy.

Apply Check Files Cancel

Help

Tools=>Rename

1. A 33 “configuration” HIFE N
Reference Library

A W 115 fos. XA a2 0T DUH TR S o vk s ooz m 5,
181 P HR S T A K e 1T A SDIC _bandgap H BT 51 H B analogLib H ) #.ITGEK
Jy5 B % tsme35mm.



Rename Reference Library ©—x

In Library
BDIC bandgap b

Rename Instances

From Library

fanaloglib ki
To Library

famc35mm '

« Refresh Session

oK Cancel Help

1.15 “Rename Reference Library”#% Uil

B Tools>Delete by view

Delete By View

Library Name S0IC_bandgap
cell Filter W
View Filter ‘schematic

Add Viewr Hame To Selection List

Find Copied Yersions Only

Anply

Cancel

Help

K 1.5

“Delete by view” % Il

w116 froas. EASE a5t 7 — ik ukds M MR vt b R E

) “View”,
B Tools—>Access Permission

i a e 117 Fros, RGeS sl BEvk 8 1 BT BONALRR

Access Permission —

Cell-View schematic (Library SDIC I gap Cell | jay I 1)

Owner _§gongwc

Group | istudent

Access Permission

Owner + Read ~ Write Execute

Group « Read Write Execute

Others + Read Write Execute

Apply Close Help
1.17 “Access Permission” & I

B Tools—>Catagories...
—UEHRENL, B, MERGKaS
B Tools—>Library Paths
& 1.4 *1f¥) Library Path Editor
® View:
B View->Filter: Wy E 1L
B View>Refresh: JilHris

1.4 Virtuoso® Schematic Editor FEL % B G E oS TR A

TERL BB R, RO R PR 1AL T 2 R A5 R I G 4R 45 (Schematic Editor) 58, HL
% Pl G s ] DL AR CTW B Bt A S o g 5 4T T SR eI Fa % I8 (schematic) View”

10



797 HHEEAFHIE 1,18, N 0421 v i B 2 4 s OO A8 D ik

" Virtuoso?Schematic Cditing: TEST sampleA schematic
Conelz Sali 0

Toots Design Window Edit Add (heck Sheet Oplions

€& [

2

o)
~

DS || A A

moune L: achSinqgleselectPt() M: achHiMouarPopOp () R achHidbjectProperty()

péeM S HLE

Kl 1. 18 HLEkgmit ds

1.4.1 FEERIEAR M AN

R A o T E B AR A . T HEA. TEX. Bt gk,
B OREES: WK, SR NI AT RS, WARBIRIEACIBAT I A e s R
BATIRAS . 15 FURL B Ry SLe 2R A
SRR, THAL AR TOIRERS N R RE A0 %k, FLIR A 0 R e TP I A
TAEX: wiE B B ERIES 2SR FH k2 il v i B 8 4
bR 2 B SRR IR 20 R A B 23 S 6F I FR iy 4 o
PR ORI AT A A IR B

142 EH&GS
AR LB B R 8 T R & BT LU R LA
® Nnasft:

m AR DUERE (07 S Add->Instance; %] ‘U..

B G-
Add Instance ==
Hide Cancel | Defaults Help
Library |I | Browse
Cell
View symbol,
Names |
Arvay Rows |1 Columns | L
Rotate Sideways Upside Down

1.19 “Add Instance” % I
1t Library fil Cell FHANTFELGI T, tHnl LA Browse f&4, $TF—"Mikil
PEX S, MG EA H Y s e e, Sl 1.19 Pros.
B AR G, w O S I SR I e S AR S . T DRI T B
N E gt 25, HA WA 1.20 fros.

11



" Add Instance -

Hide Cancel | Defaults Help
Library analoglili Browse
Cell idg
View | symbol]

Hames |
Array Rows |1 Columns L

Rotate Sideways Upside Down

AC magnitude

AC phase

DC current

Hoise file name

Humber of noiseffreq pairs g
Multiplier i
Temperature coefficient 1
Temperature coefficient2 |,

Hominal temperature

B 1. 20 TSRS HE
XN KRR BT 11 P B o 4 25 1) AR DR AT S8 I A 5 BB R BT #2 8
R4 Rotate. Sideways. Upside Down UZE TAE X H TR (P83 2FRF 5 2 A1 N e
e IR Y o Bt /9 LS
XN AR TAEX Bk, S8 A B, £ O — DA 1 5245 o

ETAEX i 2 850, WRAE “Array “F21 “Rows”. “Columns” CAHEH A K

T 1B s A NN B S — MR E S IR B o [ 81 A S 81 PR 25 B30 X A
AR TER: WS KA s 7T S (Symbol View).

® SR

VEDAReS
PR w/W 23 2 4 2R 4 s
L L. HZ R Add>Wire (Narrow) Fl Add-> Wire (Wide);

PR A&, AR T AR Dl BUbs Ao B R 12— D, SRS B b, KA
FEL M EL DT B ri A, TTRAFEA R AE Ly s e PR R B
PRZCERE, WE S A, A E .
PERE 35 /N0 T, W% F3 B TR A BOE W] 1.21 PR AR AE . I
AL E EL T BUE ML e B, GAX LRI A MR 2k
X HE AL Z 580 0, TRHZ Y 0.0625,

12



" Rdd Wire [l

Hide ‘ Cancel |Defaults| Help

Draw Mode 7 = Lock Angle 2l =

wan [T
coor Wi |

=

B 1,21 EEZRERE
o MO
m O ML p Fompin: K. AddSPin: Hedl: T
A5, R 120 FrR MR R B A g, 1T e
WARR. K, RERL. ik, W,

" add Pin -
Hide Cancel | Defaults Help
Pin Hames |NewPort |
Direction output Bus Expansion 4 off . on
Usage schematic Placement # single . multiple
Attach et Expression: @ No . Yes
Progoviy Hamw
Sefault Het Hame o
Pt Hehgt P Hivie SHOK
Embfinaling fwrardnniay sy Syl fwed afisel
Rotate Sideways Upside Down
Bl 1. 22 3 L EIBEE
® N INbR4(Label)
ahc

WO DedERE: 1 389 Add-Label; 4. ——

B GG, BoRwE 1.23 FOoRRFEIEBEHE. WAL E )G, A
Frie ) L 1], T2 R EIRE SRR RS S IFRAS s BRbR sl o An B8 B o o W SR
BEWBCEAEELR L, MZIEL S PRS2 s .

" Add Wire Name [l

Hide | Cancel | Defaults| ﬂ
~ Wire Name |Net Expression
Names II |
Font Height ,W Bus Expansion 4 off s on
Font Style stick Placement 4 single . multiple
Justification  lowerCenter Purpose 4 label . alias
Entry Style fized offset . Show Offset Defaults

Rotate

Bl 1. 23 IREERIBRE
® B UGt

B XA 3R
[1145 VI (Copy), RFiksEF7r 2Hl; [2[4E5))(Stretch), FEENLLEFIy, 157015 HL
Tt AR > R HFIERE; [3188I(Move), BBl ilsr, %l R AREFIE

13



W A4 PREERE: o/m/M 20 5l DN/ 3
SEHL Ed1t%Copy/Stretch/ Move 7375 WAt 5h/# 3))

izl %mﬁ” mmﬁ”
WA = A 4 A
S B AT L M, RLIREROR. MESk. AR MO, ARSI A4
SSCIHF 5 e BT 7 A S M 4, KIS 3 B e DL 5 0 b B A 530, 752
BT T LA BT 5 2 OB , T o BUBT A S 2 0 P
a4 ESC HEEU .
(OB A2 5 R R, T LA F3 SRR b, SO 124

B

Hide Cancel | Defaults Help

Array Rows |1 Columns Eﬁﬁf.i?m"é'%seg“’e"‘s W instance M pin _| wire Snap Mode anyAngle
B 1.24 $E00. 30, BIhThRERIJEME
15 3 M A e . BiiR . BUER ST M 538k, £E45 UK Array 3350
HHORT LABEE DA K I S Bl 50 S R MRS 3 AR 8l (R 10 mT LU R 3% 8 0
T o R L e e T
VER: T U] BUPRAE AT DXHERE FE B 1) — 870 s 4%A41 Shift SENEIERSIBIN AR 20 5
AL Ctrl BEHEE R RHEBR 70 WIAEIR— A dcfo "R FTIT KA ) v i B 22 TR 5
DI B2 Tﬁd]ﬁﬁ’%ﬁ‘ﬁ‘%?iél AT R R AT o
® MHERET
W AL del B SEHL Edit%Delete
L N vl & 3 NS 1 R i1 DR G DA R 15 S s i s I R 193
o ittt

W7 BERL: q B SEH: Edit>Properties>Objects...; 44l : T

B OUERBRN R, BRI A, W LR MEXT AR, sl 1.25 Bros.
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Edit Object Properties

OK | Cancel| Apply | Defaults| Previous | Next Help

Apply To only current instance
Show system M user W CDF

Browse Reset Instance Labels Display

Property Value Display

Library Mame |usnun5ms{ off

Cell Name rnoad, off

View Hame symbal] off

Instance Name ML off

Add Delete Modify

CDF Parameter Value Display
R PR T off
Multiplier K off
Length i off
Total Width Jou B off

K 1.6 o E bk

B /& Apply To(BH TR —AN R b o] DOk B8 NV HTE HlL, 2 B ey i
#+1(only current)id 2 3 H T BT 1 72 25 4(all selected); 25—/ F 32 0] LLIE &
TEAE TR R, S BE A 5L (instance) i J: 1E F2 2k (wire segment)

B AR CE B A RIREE . & EEAT S ] .

UK i/ I8 B

AL (B JEE. PEENFORGED. K. EEBERE

S Window—=>Zoom=>Zoom out by 2 / Zoom in by 2 47N, UK
Window=>Fit & b %e

=2 ':‘i:.lz
P TN TN RSN Ok
TR 2 VR R

AJ DUl X J LA A EAH LS T R, PR (Rl 1) 46
B XEHA3IA WL
TR, BN — AN C B R AR 2 B Bk sk
B0
IREREE, R AR
MR, @R NS T e, n DA A RE] R )R
m
S E/e/Ctl+E 23 il 2 dmiE. Hik. LR
S Design—>hierachy->Descend Edit / Descend Read / Return 435l /2 g/ A
[ IEIBIES
TRAE
B JLARAERI T RIE(Save). 0 2 58 B 1: IF-OR A7 (Check & Save). 73 f7(Save As)
B A
B4 S/X/ Ctrlts BRI IRAE . W EIFRAE. IiA7
S Design—>Save / Check and Save / Save As 73 BB IRAE . KB IRAE . FA7

2 @ B/%%U%%ﬁ\ R I ORAF
VER: VLR 07 P 20 W MRS L B R A A B DD e Ak — SR B AR, BT Bl — R
AL AT B ORAF BT, T AN L9 AT R A
AN A RS Bl — A AR A FE 48D
BEAE: u/ U B R A A
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SEH: Edit>Undo / Redo 43 Hi) S e A =i

'
el ® Qﬁ%ﬂ%ﬁ%ﬁ%u@%ﬁé\

1. 4.3 % S

7t Cadence IC #fFH F A —LehnifE ()88 IXLLIRARE R Wb i &0 B, X Leas 1
HALTAE “analogLib “Ho WIRFKAFIXAS “Libaray “, WINAZIZHITH 1.1.5 &GN B T7E
IMANIXANFE

gnd

TEHEE RO 0 AL, FIEAHIEMZRL 4 N gnd, WAHRESEL
vdd

AEAERLL A N vddo XA H AR RS AL, A .

vdc/idc

LU/ AR, T B SR B B RS R . RN AT AR AT R R, fE AC
MR AR .

vpulse

AR YR, 5 DC 234 n] LU [ 2 1) DC HLHs, AC 3 b n] LU H [ 2 1) AC
ML, FEBRAS AT ] DLAR AN [A] LI O . ARk BRIB I AR At

nmos4 / pmos4 / pnp

M FH 4 311 NMOS # /PMOS # /PNP =

AR, (R A FR(Model Name)— 42 75 ZEARHE AN [R] ) T 21 (Model Library) 1) 5E Sk
fRE .

boan: 7EREANBIAL A NMOS B85 44 4 nvn, PMOS EHIE 40 nvp, PNP )4
M4 pnp5, NIZE nmos4 #3F5L411¥) Model Name £~ 438 - nvn. pmos4 H nvp. pnp
I pnp5, 75 ) LR AN e TEBEA T ) 5L

res / cap / ind

XA AR B A A ORI TR T I, RS SRR B P AN
TR B RR, R IR G AR RN BUAR G A o i SR AR AR T2 Pr a5 5, AT LA



TEGTFZHBCE T, AR T2 R B A HUR AR g SO T
1.5 Virtuoso® Analog Design Environment (ADE) &4}

ADE ¢ Cadence IC [{JEIEALD ELAEG . mf LU T 5 4T

® 1 UUTE CIW & I HHIEHSZ H Tools=> Analog Environment—=> Simulation, X F£4] F 1) ADE
&R AT R E AT U7 FLIK LK

® o E R g A S . Tools=> Analog Environment, 1X/&F]FF ] ADE % I H &
ZWCE NPT E ] ADE [ LS 2]
TEN BT REZ AT, 64— ADE 5t .

1.5.1 ADE ZEARmH
K| 1.26 J& ADE [R3EA T . 7 D ) 225354 A 7E B bR .

" Virtuoso?Analog Design Environment (2) P ——
VP A L

PR Status: Ready T=27 C Simulator: spectre 8
SR ——>| Session Setup Analyses Variables Outputs Simulation Results Tools Help
IR Analyses -E{
L TEeT ® e Arguments...............+.. Enable ;‘:m

s ML <pc
ikt eit —>f cel samplea ==
: T+
View  schematic i
Design Variables Outputs [Ej
# MName Value # Name/Signal/Expr value Plot Save March _;/
a7 ——

\ o [
kA > £

Plotting mode:  Replace

PLRF z I IQ

!
HERE T

o>
1Tk

B 1.26 ADE EAFH

1.5.2 /] ADE BAT i R INEAFE
1. JEFEOT I L
AR N CIW B AT TR0 BOAE, WG R B B fe % . XN AT LA
® i3kt Setup>Design

® /eIt R L 5
MR s B 1.26 Frostd 1, AR AT DLk w207 S R B AR B P (A



Choosing Design -- ¥irtuoso?Analog Design Enviro...

OK ‘ Cancel| Help

Library Name TEST =

Cell Hame EIASL ]

BIASZ
EIAS2E
BIAS3

Dep
INVERT
Inwverter
Layout Ex
HAND

view Name schematic —

Open Mode % edit ._read

B 1.7 B EE0 B

WE TSR

B T EHIE P AR BT S S AT A A TR TR T2 R ISR, 75 A8 AR T
] PRI o X BRI ¥ spectre 17 LA R UL, M8 ses BRBLE SRR, b T I AR
RIPE, A] LAAESE R P Setup>Model Librarie, 2R )54 41& 1.28 Fron s I HI I,

| spectre0: Model Library Setup [l
oK | Cancel |Defaults| Apply | Help
Exaniie

#Disahle |Model Library File Section .. . |

Model Library File Section (opt.)
I E

Figdet | Dolpts | Chamnm | it e | Browse...

K 1.8 TZEXHRE
TEXANE L] AYE “Model Library File “A= 4 N\ 75 2248 FH (IR PE S 44, 7E Section £
BT NS ST A 75 (1) B (Section) o
WA eSO 44 B AR Lh K, aT Ll fa R A “Browse “#%4. FTJF Unix SCHHYE
PR ZE B SO o SO A A FH VAN A T

Unix Browser =

OK | Cancel| Apply |M ﬂ

File
| s0Emixddst02v221. scd |

.. (Go up one directory)
0v. gds

OVNEZ. gds

Readme. txt

cemc 0. Eum mask layers.doc
curve_trend. pdf
hi5Smixddst02v221. 1ih

model application note.pdf
res_va. va
s0omizxddstlEvEE]l. scs

Current Directory
| /1ibs/2p3nSic fspice_221

B 1.9 TEEXHRERE
FESCAE 3 S e b 0k 5 T BRI SO 2 5 i ok %A, SCERIEs AR S 1 BhEAE Model
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Library File £, X it Add #4, XAPESCAEHABIMA SRR SR A, XK, BEATLL
BREZAS B RSO, o m] AAERE R R SR B3R e % — A s LA AR T R
16 M B 51

YA
T LB () B0 2 i B T B A7 T P o M, 37 DA ML B AIEAT SO, 2835 2
B S — A B SO B8 T L — A MOS A% B S w=w1, 11l W1
M — AR BB A R (7 L A TR, AT R REAEAT
— MV TR (ESEH Lk PE “ Variables=>Copy from Cell View “ ) H 4% & b (1 8 1148 1
S ARG ADE th, JF7E ADE % 11 048 LR g1

| | i
I 4 Variables> Edit 57 ADE JLH 0k (1At st b 598 L 1 1.30
O T A B, 0 T T B R 2 B M T b s B 2 T4

Editing Design Variables -- Virtuoso?Analog Design Environmen...™%

OK | Cancel | Apply | Apply & Run Simulation Help

Selected Variable Table of Design Varables

Name #  Name Value

Value {Expr)

Add | Delete | Change | Mext | Clear| Find

Cellview Variables Copy From | Copy To

B 1.10 fTERZEKRE

YR

HRA AN [ (T8, T AR WL AT R IR T . S0 DC 40T, AC 47 Wi
(Transienty /7. WEF AT W07 . Horh ST = 3

VOB LR, T LA S5 Analyze>Choose SUIHL 206, 41 131 FEFF I EL B R
VB S 4T TT

Choosing Analyses -- Virtuoso?Analog Design Environm... =< |
OK | Cancel | Defaults| Apply Help
Analysis 4 tran dc ac noise

=f sens dematch sth
pz sp envip pss
pac pnoise pxf psp
qpss gpac gpnoise gpxf
qpsp

Transient Analysis

Accuracy Defaults (enpreset)
conservative moderate liberal

Enabled Options...
L1 B E P

e T E T RS, %7 AR BB 2 s AT HE A o 2 SRR BB DO 4R AR B I

SETTLLA AT F A1 Options #64M. %34k, 42 F 4 1¥9 Enable ¥ 50451 — 0 2L T8
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5. WEKH
R AR IR 0 L R S 75 B e sl B AR I R 25 . F 2 2 BTV EMT A :
® {EXHTRIERE “Output>To be ploted—> Select on the Schematic “, Hi i P & 2 HBL.
7 AL % P e BRI 2 s 7 i TR AR DI 2R IR L R
TERE— AN AR R 1 U) 28 A A sty 11 PR FL AR ki s
RPN ) S A AR 0 A v 1 R AR I A\

[k
o rLITFAInft, 7S ERE Output->Edit B s == nf LU JFan R H
[ Sciting Outpuls - Virtuosa?Analog Design Emviranment (2)
OK | Cancel | Apply Help
Selected Output Table Of Qutputs
Hame (opt.) #  Name/Signal/Expr Value Plot Sawe March

Expression
Calculator  Open| Get Expression | Close
Will Be H Plotted/Evaluated

Add | Delete | Change | Mext| Mew Expression

B 1. 12 EiimeiE
TEAZ T U a] LA I ZE 00 4 H i 208 2. R Rk AU & 2%, 16 v] LA gty Calculator
¥ open 444, $TJF Calculator(J5 HIIE 2 VEAN A 4348 FH i), (ELhgmiirRiA=0G,
76 L % O F b Caleulator £#£1¥) Get Expression $2411, #3820t 2 #% #HX 21] Expression
=

6. PiHEIdRE

A EHER)G, M358 Simulation> Netlist & Run 8 i idd ;IR

BB, WA LA E 4L Simulation> Run B {240 & o 2 ROy #in] LT AA (T E .

E HOLRE A, an R 7 AT DL A 32 5 Simulation—> Stop HH KT 47 B,
R TR A5, nT IR R CIW & T A S AR B, o Fr R,
MR —DERBELEE O3 .. A EERHE, LR “Result>Plot

Outputs “oZ el . | 6 BLNTE 1,33 i LT
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TEST BIAS2 schematic : Mar 1500:40:29 2007 [17]

File Edit Graph Axis Trace Marker Zoom Tools Help
Grn#EeEl HE [/]Label | |
Expressions l
—~ Canventional + Cascode — Tri-Branch
10%
109
1073
=
=]
L
107
1073
10% . . . . . .
101 102 102 10% 10° 10% 107 108
fred (Hz)
#[> graph-1 selected: double-click to bring up attribute dialog cadence

B 1.13 ESRERFH

L E

® L NMA MR LIS HE T B BRI EE . RS AR
fuh s R HR R D .

®  ZHL Design—>Temperature 1] DLH K 15 & 477 H IR BEIR T

PRAF AT N TR

® iifizE i Session>Save State 1 LAORAF U HT I EACE . XUEHEWT T, nf DLEFERAKTR
BRAE G o RAF PRSP A7 AE~/ artist_states/<library name>/<cell name>/spectre H
KN

M

Saving State -- Yirtuoso?Analog Design Environment (2]

0K | Cancel| Apply Help

Save As | statel] |

Existing States

What to Save H Analyses M Variables B Outputs
H Model Setup M Simulation Files H Environment Options
H Simulator Options H Convergence Setup M Wavefonm Setup
M Graphical Stimuli M Conditions Setup M Results Display Setup

H Device Checking Setup

A 1. 14 FERERLRLT
® NI Session>Load State 1] LA A LLRTPRAZ I LIS « XTURHEWT T, AT LUEFET
TR, T8N
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Loading State -- Virtuoso?Analog Design Environment (4)

OK | Cancel| Apply | Delete State| Help
Library TEST =1
Cell BlASZ
Simulator spectre
State Name statel =
stated
stated J
What to Load W Analyses MW Variables W Outputs
W Model Setup W Simulation Files W Environment Options
W Simulator Options W Convergence Setup _| Waveform Setup
_ | Graphical Stimuli _| Conditions Setup _| Results Display Setup

_ | Device Checking Setup

A 1. 15 SARETFRFERES
Rt 3Z . Session—>Save Script AJ LUK ILLE (1417 B % B R AT il OCEAN JHUA, Tl FHiZ A,
A LAFE A AT HAT 7 HAT 5 o
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%2 E BEASHT (Transient Analysis)

2.1 THEER AR 4A

WS 07 TUOI TR AESS RE AT NS 1 FEBERE AR IS 18] Vi R P T A0 P ) IS Sl 25 i 17 78 E
LHGUE Vvt FRBR IRSE Ik, TERE, AR L 55 i AL I 28 1 25 b S D00 A% 25 20 M A4 RE A IR A )
FAr o FEAE A AT BEE RS 07 AL 70 BT o BB AEFL AR IR L B0 b o AR S B s
UL, AR E RIS S ECA BEFLE VA FL s PR e . ARSI RIS B B ferh, 1
FEAE I EOR My 03 P 22 Te) A 5 B AR T 288 o 12 Tl DA% vt HL B 10 8 55 ol 07 L8 T S
S BPTTAL RN R . RN, 38 w) UG FRER WIARIRAS, it B8 DA 5 45 A A1
SR

2.2 (FESHEE

ZM 17 1.5 W%, $JF “Analog Design Environment” - “Analyses” = “tran”, &K
SRR E WK 2.1 P, FENBFEHTHE07 B TR “Stop Time” FH T4 il {7 Bk
JEFURE LR “ Accuracy Defaults Cerrpreset)” %€

OK | Cancel | Defaults | Apply Help
Analysis & tran dc ac noise

=f sens domatch . sth

pz sp envip pss

pac pnoise pxf psp

qpss gpac fpnoise qpxf

qpsp

Transient Analysis

fAccuracy Defaults (enpreset)
M conservative | moderate | liberal

Enabled W Options...

&l 2.1 PSR NS HEGE

221 BEASHRE

®  “Stop Time”: j EZ 1IN B [ BE o
TEERA B E PRI S t =0 NZITFIR U B . B LU T BB 5 B2 b Ta) o IS Ja] S
e Frbk, WREFOR AR, RIS R E= MR 4GS “m”. AR
) i ) A AL

® “Accuracy Defaults” Cerrpreset): 1/j FLRE A 5 F1H S 3 €
ALERE A EORE IR . WEAAR (liberaD), J&H'[Y) (moderate), {R5FfY (conservative). H:
H, “liberal” )7 B RE SR PR, AHE RS BE A o X IORS B2 1R 07 B00E 5 T 4507 L Bl 2
AT B AU L% “moderate” fF 07 ELASERIA I &, HORSHIFE 2R T- M SPICE2 tf
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HT LR “conservative” [ H A & m WAS A SRR B B, 18 G T RUSK AT v 2% 1)
o

WL H T L BN “conservative” SSRGS, RILAHEEE H L “Option” G0 144 2%
FEBHL (reltol) BB AH/NFIEUE. “Option” ZEFHEHIF T PHENH. LR =M RGN
PURSFE VB SR B2 (reltoD), AHXF S (relref), 1707730 (integration method),
e RIFA2PK (maxstep), #iTIRZELL (lteratio) 25541, HAKE IR 2.1 fin. EHE
H &S, & LUE BIAH N ) S 80 B G O BARS AN 7S50 7 ORI B oK 7 o S
RWEFTHNH,

2.1 =MERKETHSERERRL

errpreset | reltol | relref method | maxstep | lteratio

liberal %10.0 allglobal | gear2 <=T/10 3.5
moderate %x1.0 sigglobal | traponly <=T/50 3.5
conservative %0.1 alllocal |gear2only <=T/100 10.0
0K ‘ Cancel ‘Defaults| Apply | Help
SIMULATIOH INTERVAL PARAMETERS
start |
outputstart |

TIME STEP PARAMETERS

step |

maxsiep |

INITIAL COHDITION PARAMETERS

ic _ldc _Inode |dev _|all

skipdc _|yes _|no _| waveless
_ | rampup _ | autode _| sigrampup

readic [

CONYERGEMCE PARAMETERS

readns II

l‘:min [

2.2 BRI B SRR A
222 MEASHKRE
R 2.1 B “options”, R EAE B S HIAT R
® “Options”:
“Spectre” i ELIRAT RV REW FE I B S48, WasN P, K, B J5
SRR E. B 22 BSHORER . JiHAN “Options” #4045

“SIMULATION INTERVAL PARAMETERS”
& “start”: (IEITURINZ]. P EEBOATTARINZI Os.
¢ “outputstart”: fi LN L WA Y5 E AR, i N TS N TR B
RGEEARFE, T LUE R %S B
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“TIME STEP PARAMETERS”
& “step”: H/NWREZEUE. BRAEDY 0.001 X (L QERZ) — LRI %D
€ “maxstep”: F KM, MG “errpreset” HORGE 1w HUSERIME -
“INITIAL CONDITION PARAMETERS”
FH AT LA BE S ARSI IGLTE ) (ic statement) B HL 7Y, HELBCAEAR TR Py (K41 46 4 1F
ZHY (ic parameters) PP AN BES T BV F . AR BE R E, iESHER
F B HT (DC analysis) H45 A A WIda 51
& “ic”: v ARy BCERIAR A
® ic=dc: ZEATATEREMVIMSME, BHHERHBERDIINE R,
® ic=node: ZEEHLA . HUKSEIF B E VI &AM, s “ic
statement” W& W UH SRR H
® ic=dev: ZW&HI “ic statement” WEIMHIIHFAM, HA. B LY
IR RE R
® ic=all: WIFPHIME SR AT HR IR o BB R AT R A RIS, “ic
parameter” [t “ic statement” A5G Z% 5 & o

—H P IR E TG 44T, “Spectre” i Eaw bl i — R B AR T 5 LS 1R 52 BRl aatk
Ao XA, “Spectre” MAERHILHZAF AN B s EJn—A> s HJ50RT FL B AR IE . 24132
FIEIT “ic statement” KA LR W USRS, G 0T BEAAAEA — Bk . bL i /e %
FER Y m R RCE R B R AR A R (1) S BB E AR F . W BB N R AR A — 3
W), S ALETE SR R A RS SR . AR, RS SRR (P 46 4 A 5840 2152 IV 4%
o FTLL, FEE B oE XIS, ke g RIS OL, 75 W7 SLaRoks 25 = A S Sk )

e ESCHui B, 23] TG IER) “ic statement” MG SEL “ic parameter” HIMES
“ic parameter” MW BRI, WM AT — N HEN S H R E & Dol LLUE F| “ Initial
condition”, FEHAH I EWIAGIHE AR AT, v ER, X H NGRS R . 1w 2 R
WaAE, FERENEHEMME. £ 229, S THA RS Mum OS5,

CDF Parameter Value Display
Capacitance lu E off
Initial congition |I | off
Model name off

B 2.3 HERSHKE

“ic statement” [FJ#% ) ic signalName=value .25 U1 1
ic Voff=0 X3.7=2.5 M1:int_d=3.5 L1:1=1u
AJFRIRI R R A Vot ERIGA R OV fEF LS X3 2R 7 51 sl EHR(E N
2.5V; 7E MOS & M1 (i R 2 3.5V ERE LT B vIaE B2 TuA.
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R 2.2 A O R S

Component Internal Node Specifications
BIT int_c, int_b, int_e

BSIM int_d, int_s

MOSFET int_d, int_s

GaAs MESFET int_d, int_s, int_g

JFET int_d, int_s, int_g, int_b
Winding for Magnetic Core int_Rw

Magnetic Core with Hysteresis L

T iR A B, BB W AR 45 B — Se R SR A 46 . W LS cadence SCA4IY “Spectre

simulator user Guide = 7. Control Statement” fi(it— 25 11 T it .
€ “skipde”: B BRSO, EEREERSTTIEOLT, RIS IR
filt, B “readic” & SCHFHP WIS 45 F . IR “readic” WA E X, T
2K “ic statement” HERENPIGASAE. AR EEGE HR T, 4 EAILG &
PHEE AR R I o WA A B PRI SA, B B S0 A BE R 0.
S E R FEAR S 5 AT ARSI ) . HEE AT %S4, BARE R ] 7 W

“Spectre Circuit Simulator Reference—>3. Analysis Statements”

&  “readic”: MNP EEEWIGE AT

“CONVERGENCE PARAMETERS”

2 HL BT BN A7 AR JE PR R P e T3 () G — A RS YT SO AEAEAE AT L2 ), “Spectre” 4l
ELA I RE ARSI E . O T R ) L, FREE “omin” SELGE T MR E NG
(P b L A

€ “readns”: M CPFHH O R BE AT BTG AL AR o
& “cmin”: BOE RN RUN LR B /N LAY

250 — AN T 2 A L, U “write” FIl “readns” S8, IF H GBI SCE A

i A AH R o TR AL LI 53 BT R WSS Tl e

“STATE FILE PARAMETERS” CN? FMHD
IR (State File) AT P Ak
A CBORAE TORBPRE S TR g 5 b Bende—IxBES s ORAF T 2%
1L ZIAE B, 8 N — KBRS T, BB LIS ZI0E Jy S i i gk S 2 0 1) ity
5T o
B.  H P REEAI FPIRA SCEE B 8 58 T4 2 A4 1K 58T

B e I LR — IR 73T AT AR I 20 A i el o 2 b 20 A i 2R BRSSO o

R, HPRRETFahdm'sS — M IRESCE. 7 “Spectre” i EgsH, nJ LIk E — A K “State File”
MZH, WK 2.4 Fios.
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STATE FILE PARAMETERS

wiite |3pectre. ic
writefinal | spectre. f6
ckptperiod |

Kl 2.4 “State File Parameter” 1% &
“write”: KBRS AT IR R S B4R E S 25
“writefinal”: KBRS /M I B AR S IR SO 2.
“ckptperiod”: {E45E KA A 2 AE T B 404 o

L 2R 2R 4

¥ spectre.ic (“/simulationfAnalysis/spectre/schematic/netli. .. |

File Edit Tools Syntax Buffers Window Help

DUHdEE S B p Q>a4aY BES RO

# CHECKPOINT_VERSICN 1

# Generated by spectre from circuit file “input.scs' during analysis tran.
# 2:11:02 PM, Wed Mar 14, 2007

# Number of eguations = §

[*]

Vo:p -0.000554599340013668

V3:p 0

VIN 2.5

VouT 2,76812477293 564

vdd! B %

[<]

9,6-9 All

K] 2.5 “Spectre.ic” SCAH

¥, spectre.fc (" /simulation/Analysis/spectre/schematic/netli... |'
File Edit Tools Syntax Buffers Window Help
DUES S ¢ DO B> Y GBEHS |
# CHECKPOINT_VERSION 1 Z
# Generated by spectre from circuit file “input.scs' during analysis tran.
# 2:11:02 PM, Wed Mar 14, 2007
# Number of equations = §
Vo:p —-0.000554602563433008
V3:p -3.10349863301165e-13
VIN 2.5
VouT 2. 76918825315257

P
wdd! Z
- ~
"spectre.fc” 9L, 246C 9,6-9 All

K 2.6 “Spectre.fc” T4
EE 25 Fl 2.6 Rl T “Spectre.ic” Fl “Spectre.fc” . XA SCHH) H % &
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~/simulation/cell name/spectre/schematic/netlist. #4274 “cell name” & ] J7 1/ F A HLM FL G4 o
“Spectre.ic” FiC K AT UG B ZPIRSAH . “VO:p” F1“V3:p” F 7 AN HA, I 35 ) 1 3 B A, “ VIN,
“VOUT”, “vdd!” K&/ SR, “Spectre.fc” 3L ZIME, ST AT

FIEC 75 SR “Spectre.ic” HAR A

N AR TR SO ROAS S VR KL Ui AT IR G K, T AR
B S A AEAR N () 2 8 BB B ],

altTemp alter param=temp value=0
Drift dc param=temp start=0 stop=50.0 step=1 readns="ua741.dc0" write="ua741.dc0"
XferVsTemp xf param=temp start=0 stop=50 step=1 \ probe=Rload freq=1kHz readns=""ua741.dc0"

AT AT AR S T —IRAEIRE T=0 1500 F I ER AT (DC Analysis). /7240 1%
W\MEE’J,H%%?EH:@I# “ua741.dc0” 1.

ARG EE N 0 3] 50 FE I3

5 IR MAE TR 20 BT (Transfer Function Analysis) o 75 Z0RHE & BT E N 00 WHRAME
Jil “State File”, 4 T8R4 T840, ¥ FEEHME ER T/ WRARGEK, it
T2 BRI, w2 W E R AR AT ROk I “State File”, “Spectre” HJ DL H 424 F HL 1
AR T=0 K& N AR A e 5. W2 i — e R Lo, 7 SLId%
WA ML TG EA £ .

“INTEGRATION METHOD PARAMETERS” (AFISFE? D
ZSHH v N GUAR B 07 B0 B RN BRI RS G AR 0 T 2. “Spectre” 1 HLAs
3 FOASFE R4 53 “backward-Euler” |, “Trapezoidal”, “The second-order Gear”. HR4fiX 3

oy —3L 4l A 6 R, 435 8 “ euler”, “ traponly 7, “trap 7, “ gear2only 7, “ gear2 7, “ trapgear2
*22 ?%TT%%EF*D/\ﬁiE?FM%TZIEﬂ PRI YR R o

R 2.3 BRI 7 AR L 18] (R0 SR AR

Backward-Euler | Trapezoidal Rule | Second-Order Gear

euler

traponly

trap

gearZonly

gear?2

trapgear2

MR PR RS AR, AT LLERE “trapezoidal” R4y 7. (HIE, XFR T ERZE
(error tolerances) RIS FFA AE— PR G OERE . 32 RN & 0 R — AN 20 v 550 7= A 1 %
ZedE BB W RAE A ZE AR T BRI AR I U, B UFid &1k FE “Second-order Gear”
ik,
“Second-order Gear” FR4rvk L “backward-Euler” VESE IR #. (HM R vEai S mfih &
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SHIFEE M. “Second-order Gear” FHZ:VE X Pl 22 RN BEARRS AN—2L . Pn > FH ) 75 22475 1
—NE Q (E IR #3915 o3 BB e # i, 1 H “ Second-order Gear” [#)45 SE2x 3R I H B2 4
%, 1M “backward-Euler” NJZRILH B oR ) Wik Frbl, EXMIHN T, NiZKH “trapezoidal”

Bk

“ACCURACY PARAMETERS”

*

*

“relref”: MXTWSHRHENIZ, TEIMEZM “errpreset” 135, WFHM T JLAE
BT

® “relref = pointlocal”, I, relref=/aj#ll fi: XA E HIRE & RN sUHIE
AT T4 23 B 19 R U A R 22

®  “relref = alllocal”, R, relref=)m¥lfi mi: & HAGUS 2 1 BT IS 8] RO
AR T 45 K A AR 52 22

®  “relref=sigglobal”, HlJ, relref=PFH15 5 rl: &8 HEREA B HAE S EAXT
TP AR S P B OC A BA R 22

® “relref=allgolbal”: [F] b, J3&NOIREANTY mi s Kads R (E %€ LTS, it
AN Fi I A2 R R FL T

“Iteratio”: LU REL, H T Newton 71 LTE A 7.

2.22.8 “ANNOTATION PARAMETERS”

*

*

“states”: HUtEE AT SRR AR R, T2 AR S S 2 7 ) Ve AR
TMGETE27 20 A W W e v e 42 Xk T 2R R 2 [0 R 7RI, WideRH
IR AR T G o i S50, BB DX SRR iy 7 3R AE T 2 22 s, mionT
LA T GEvt 22 0 Mo X040 BT B SE IO X T 2 S s EA R EUE S 2 U5, 5t
A DA B0 T2 R R o IX PPt 22 T RV E SR < B 0 A o
“annotate”: VIR LI

2.22.9 “OUTPUT PARAMETERS”

“Spectre” (i ELAF NGO N ST O A A ORAT IR (HAT IR AT 2P I Edh =
“Spectre” SCVF LS ORAT T IS . 8K, WERT ZATBERGAAIM ST IR, o nl A KA
St Al B LAl Ok A DR A7

*

*
*
*
*

“strobing”: {ELRAT KM BCE — NI [AIRG . EAR (7 L vH L X Lo 84, (H 2
IBATR AR i

“skip time point”: H ' REGSIE LT LA ORAE 2 /DA R

“compression”: FHEE(S T E LI MER.

“outputstart”: ¥ E )] L5 AT FF IR CRA-H -

“Infotime”: FCVFH P ORAEHELE F 8 N ZI TAE ol . a0 75 2R A7 2 AN )
M) AR, BN ) R 5 22 1) 2 LAAE AR B O o an SR P 3N 1 B e R Bl

“Spectre” e 7EmH & LA . W ROTE ), it “Results Print” - “Transient
Operating Point” S5, SR 570 U B Pk AN 0F, o SoRordia e I () f i %)
M TAE%dE . T “OUTPUT PARAMETERS” S ARLH AL, KILiEdn A
KiEZ% “Spectre” WH T
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2.22.10 “NEWTON PARAMETERS”

€& “maxiters”: FERENI D B 2 kAR 2 D IR
&  “restart”: WIRAHATEERAEBN, &G MNBRIFIGEFF ERE. DERAER T
8, BHEBERH LRI

2.22.11 “CAPTAB PARAMETERS”
€& “captab”: HAEVIRZH, FmwE 2.7 Fion. fE5ER—IR “Spectre” i E G,
H P Rt 15 2 S g B A G . ks athth, PR “infotimes”
SRR E AT LN 2 SR B TP I A S B W R AR IRTR €, I AR ER
INMRAEZ LN ZI A SR . W iz S8, SRz S i E.

CAPTAB PARAMETERS

captab L

timed

threshold 0.0

detail H node nodetoground nodetonode
sort H name value

& 2.7 HATIRSH

& “timed”: KA “infotimes” SECKIRAFH A,

€ “threshold”: 7 ZORAF LA () dRe /M. FREE P A/ T B A A AN 2 th
AR S . BRIAEA 0.0,

& “detail”: 1] LA i E N 1T A (node ), 11 5 H L 2 (nodetoground ), nodetonode
=AM

& “sort”: frraA.
2.8 45t T ANHESIR o PR Pl B U B2 RN 2 45 B .
| T

Capacitance Table ‘finalTimeCap’

*hEdkrttEr it it r bbbkt bbbk E b LS

Capacitance values computed in Tran analysis ‘tran’ at time = 2 ms (T = 2T C).
netl® : netl®  fixed=1 87085 £ warizble=5. 38123 f sum="7. 25207 £

VOUT : vOUT fixed=1 u warizhle=93 0868 £ sum=1 u

vdd! : wddl fixed=455. 342 a varizhle=89. 3356 f sum=85. 7909 f

& 2.8 HATIRG]

AN RFTHA R B A 2.9 Fios: Hod “net19”7 A2 FR“MO0”MOS & 1M . “ vdd !
PRI S MOS & “M1” [ . “Vout” F5 50 8 B BT i i H1F MOS 411
Uity 1125 A2 R ZE R MOS [ TAEIRZS Ao L HUR A G, Brbh, AR A& 7 [ e riL 7% (fixed)
FIa]AZ i 7% (variable) PI. SHLZE (sum) APEFIINAIL,
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Yirtuoso?5chematic Editing: HeBook Analysiz schematic — Virtuoso?Anal. .. E]@
Cmd: Sel: 0 Status: Ready T=27 C Simulator: spectre 2
Tools Design Window Edit Add Check Sheet Options Help

R: geScrollinil "n" nil)

M: schHiMousePopUp ()

mouse L: schSingleSelectPt()

J'k

K 2.9 BHESIR (F2.8) Friiidr s

23 %Fﬁ?ﬁmﬂiﬁﬁgﬁﬁb—i}] IJ—&A/?SUQE

FEASTE (VI T REST 41 0 04 20 5 BB 25 07 LN 7 B8 FATBEvE 2 Pl it CARIAEE, 2 hp A
WS RAE R o XA URH H TS 07 2 B0 . SRk E 5 2 BUE 5 5 8UE 5
IESEAE 555 . IXEERFUIEH T LLE “analogLib” FRHkF]. IX L85 SIS DL R B A4 i,
A AL AR BRI -

2.3.1 fkMES “vpulse”

“vpulse” 15 ‘5 T A4 A VE T3 o fﬁ?)%ﬁ%ﬁil‘ﬁp Al TiCh MOS B R dIE 5,

W n] R R Al b el R B I RS . 4TI “vpulse” IS AR WIE 2.10 PiR. %54
Y RAIFEWI S “Property” Al “CDF Parameter”o Hrp “Property” #i7r{EM “analogLib” Hrik
PESHEEHRAANAES . (ET RN, /£ “View Name” — 2B KH] “symbol”.
2.10 1 “CDF Parameter” S | —#0 A KBS HNSHRE . (2R 24 Pl T FESH
AR, oS0, SEBIRIFRA 545 B e 18] 210 v T MR A9 v L 1) RS 7 sk 0 L ith 42
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|1uuu E]

Apply To all selected | instance | of Same master
Show _ | system M user Il CDF
Browse | Reset Instance Labels Display |

Property Value Display

Library Name IanalogLi]i | off —

Cell Name [vpulse Coff |

View MHame |3Y'mb°]§. off

Bistanne Hane off

add | Delete | Modify |
mamn:;e User Property Master Value Local Value Display
| Ivsignore |TRUE l off

CDF Parameter Value Display
AC magnitude [ off
AC phase l off |
DC voltage [ off
Voltage 1 |SDD.Dm ¥ off
Voltage 2 s off
Delay time |1nu. Ou = off
Rise time l off —
Fall time i Coff |
Pulse width 50.00u & off
Period off —

K 2.10 fkMHfES “vpulse” HIEE

F 24 “vpulse” HIiZESHE N

28 P S| ERA
Voltage 1 B | 500m |V
Voltage 2 ik e 5 v
Delay time FELIR B[] 100p s
Rise time isSagingl! 0 s
Fall time N3] 0 S
Pulse width el Es 50p S

Period Ji S 1] 100p | s
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File Edit Graph Axis Trace Marker Zoom Tools Help

& 0 # & [Label | |

Transient Response m

Ea/netl

0 250 500 750 1.0
time (ms)

M cadence
K 2.11 R 24 WERIKMES “vpulse” ¥

2.3.2 7 BfES “vpwl”

B o N BB 2 2 T LA “vpwl” (5 5. & SR VR REMS 5 Lo Bt %)
FZRZI A A5 SRR ESHR “vpulse” 55 5EAAM . R 2.5 PHET EES
HAHR, &30 SEBIMPAL JF HARPE B 2], 7ER 2.12 shaath 1T izfs S ¥R Zh 2k

R 25 HBES “vpw” SR E

ZH X S Li¥A
Number of pairs of points A i BH 4

Time 1 51 AEAT I A 0 s
Voltage 1 AN S 2 v

Time 2 55 2 N EAT R TA] 2501 s
Voltage 2 52 AN N 2 v

Time 3 55 3 AN EAT U 1] 500u s
Voltage 3 B3 AN M 5 v

Time 4 5 A AN U] Im s
Voltage 4 A AT N 5 v
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2.3.3 “vexp”

File Edit Graph Axis Trace Marker Zoom Tools Help

& 0 Bt [Labe | |

Transient Respanse |

B /netl
5.5

5.0

4.5

6] 250 500 750 1.0
time {ms)

s[> |cadence

Bl 2.12 A5 SRR 07 E it 2%

FREUE SRR s B [FIFE, XSG T EESH L AN g B 4k . 75 B A
A&, IXHLHY “Damping factor” J& AW A FRA7 25 Hi 1) o 38 2.7 gt T &S50 i W s 2 1] [ 4
HKR. Hrp “Dti” £IR “Delay timei”, “Dfi” K7~ “Damping factori”s

#26
ZH X S
Voltage 1 AU 0
Voltage 2 EAENEENA 5
Delay time 1 A CRE iR 0
Damping factor 1 T CREE) BRI s 2L 100p
Delay time 2 TR (R #ER 500
Damping factor 2 T CEFE BRI 2L 100p
*®27
I} (] L B
0~Dt1 V1
Dt1~Dt2 V1+(V2—V1) (1—exp (t—Dt1) /Df1)
Dt2~Stop V1+(V2—V1) (1—exp (t—Dt1) /Df1) (exp (t—1t2) /Df2)
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File Edit Graph Axis Trace Marker Zoom Tools Help

& 0 Bt [Labe | |

Transient Respanse |

B /netl

0 250 500 F50 1.0
time {ms)

s[> |cadence
Kl 2.12

2.34 “vysin”

IESEAE T W2 — M EBES O B HINAE S . fEE IS0, “Damping factor” {547
& 187 IESEAE SR ERT I/ MG 5 T (AC Analysis) " EEZEFRIIR . P T2 DX A1) S
W A AE 5 B AR ACURAR 5 B A A ) 25 S

#28
ZH P S LiE A
Amplitude P 3 v
Frequency Y& v A% 10 Hz
Delay time SEIR B[] 0 S
Damping factor FHJE X+ 1 1/s
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[

File Edit Graph Axis Trace Marker Zoom Tools Help

& 0 H# Eiafey —

Transient Response m

= /netl

I |'|
||||||||'||||.| NACAC,
J||||H|I|#Jrrr’ fﬁ' Jﬁfhrﬁh

H “||||'Ihllfﬁfﬂ Yoy
b

|||+
1 |
=

0.0 5 1.0 1= 2.0
time (s)

of [cadence
K 2.13

2.35 “vsource”
“vsource” FRHYEE— PP B M YR, A DUH T 5e sk Bl BT A IR ShEE . AE R

K “source type” S L B FE Pty ZE NI B IR B AT, TR I 42 i 15 XS 2B ) 5%
S
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EditObject Properties E
Hel

OK | Cancel| Apply | Defaults| Previous| Hext p

Amplitude scale factor off

off

!
i
Time scale factor l
Breakpoints T off
i
i
I

Period off
Period start time off
Transition width off
Display small signal params | off
Display temperature params | off

Display noise parameters [ off —

Apply To all selected | instance | of ame master |
Show _| system M user Wl CDF
Browse | Reset Instance Labels Display |
Property Value Display
Library Hame |analUEILth M
cell Hame vsource Coff |
View Hame |3Y'mb0]§. M
mstanng Mamg | VU off
add | Delete | Modity |
Change .
Al User Property Master Value Local Value Display
| Ivsignore |TRUE l off —
de
CDF Parameter SHliTe Value i
pulse
DC voltage exp off
Source type Mﬂ off
Frequency name 1 l off
Waveform Entry Method 4 File . Voltage/Time points off
File name l off
Delay time off
DC offset

i fs o fs ol { o o ok 4

Multiplier [ off

K 2.14

>

2.4 MBRESELSG

KA AR RC 750 F R e il RIS T B, Bk B ] 2.15 B, H BRI i 2%
6K “analogLib” H i BLAL v BILKS BRI AR i 2 SRR o JHURIUBE “vpluse” FIRIMETT . R
“conservative” [FR§IE . B THRAWEVIRSME, AR EHATHIL T, BI85 R W viih
fit, DiLLEEIRWE 2.16 P,
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Cmd: Sel: 0 Status: Ready T=27 C Simulator: spectre
Tools Design Window Edit Add Check Sheet Options Help

mouse L: schSingleSelectPt() M: schHiMousePopUp () F: hiUndo()

K 2.15

File Edit Graph Axis Trace Marker Zoom Tools Help
Sr#EE EH []Label | |

Transient Response m

Ba/vout Ellfnetl

VoY)

V(Y]

0 300 L0 15 2.0
time {ms)
»[> graph-1 selected: douhle-click to hring up attribute dialog. |(a dence
Kl 2.16
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®3IFE  HIMSHT (DC Analysis)

3.1 TheEEAR N A

BT A A BT A T Bl . #E “Tran Analysis”s “AC Analysis” 50T e, &
SER e S B IR TAE s . FEIXEAAREG “DC Analysis” ", SEBRELEE AN 7 TH 1K 7047+
(L] AR EGR AR (205 MR E R

B TAE R85 2

X EITAE S AT, DTESS SRS A, &30 iR, O MOS BHISME
WS, HlmeEss (g, BHMERE (Vi), TAEXS (region) 5. 17 AR IR PS5 T
HL% IR (Temperature), W iF78 & (Design Variable), #3/F5% (Component Parameter), #%
A S50 (Model Parameter) 552 NS HUHRFE .

3.2 (FESHEE

I T E HIA LAE S BRI oK, 76 “DC Analysis” Ffi€ “Save DC Operating Point”, U1
REHIR M2, FERERMAAREMPMEE . SHCEEWE 3.1 Pix.

OK | Cancel | Defaults | Apply Help
Analysis tran & dc ac noise

=f sens decmatch sth

pz sp envip pss

pac pnoise pxr psp

qpss gpac gpnoise gpxf

qpsp

DC Analysis

Save DC Operating Point

Sweep Variable

Temperature

Design Variable
Component Parameter
Model Parameter

Enabled W Options...

&l 3.1 “DC Analysis” S 5E

®  “Temperature”: i JEF4, WEHLER B TAF bR FE AL G O .
®  “Design Variable”: Wil EFAH, (Evrh Bk, BT T f 2o/ L it 24

WHENLE, JTEREAES. e, nTRLEYEHR S (Vpp), MOS HIMHS (L) 1
WE (W) BE N E, TR, WA &Mt T 0 TAEE DL,

®  “Component parameter”: #H{1Z4(F1H, F! “Design Variable” A LKL A,
AT EA A e r i h R SO B N8 R (Variable) .

®  “Model Parameter”: IR/ G080 FESCAF BT B 8, ] LI HIZ S84 . 1
JT, TR R th A T B, Jrih, AHER AT HIX .
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e e RS )G, P HREs— PR EHTEE (Sweep Range), F9##77 2\ (Sweep Type)

faray
=T o

DL “ Temperature” 441, 41l 3.2 fro, A LLERIAESHOFEHRIEE (Sweep
Range) F## 7K (Sweep Type), VLI =M IR AT (Add Specific Points)-.

DC Analysis
Save DC Operating Point |l

Sweep Variahle

H Temperature
Design Variahle
Component Parameter
Model Parameter

Sweep Range

# Start-Stop

Start |-20 stop 120
Center- Span

Sweep Type
Automatic

Add Specific Points I | |

K 3.2 “Temperature”i i E

®  “Sweep Range”: faHiiiull, v LIHHIRCIG{E (Start-Stop) B8 & AiH
(Center-Span) #Fi 773,

®  “Sweep Type”: IR . DT LURL MM (Linear), 4t A] LALAXT 7 X
(Logarithmic) Ui, WH KM “Linear” #x(, M/ 75 Zil PHE /N (Step Size)
R AP HE R (Number of Steps ) R A2 il 417 EURS 2RI ELIN H] o 1 21 R FH “ Logarithmic”
B, 7 FLARBRIA B A LA 10 D JE B 2. At 75 BL0d i A AN Eim 9 0T 75 20 1 5 (Points
Per Decade) D HEEL (Number of Steps) SRl EORE PRI 0] o 24 FH 77 %) i Hi A
KBARFHRERES, nTEURH RABIA R E (Automatic). REBIANREE A M 4H1E
HYME /T 10 B, SRALEBH . mfeixbefl T 10 B, SRR EC i .
R TR LI 3.3,

Sweep Type

P e I
Linear Humber of Steps

Sweep Type
i e 4 Points Per Decade
Logarithimic Humber of Steps
Sweep Type
Automatic

B 3.3 “Temperature”$ iR A (5% &
®  “Add Specific Points”: JIANFFEE SV . AEMF B REF, F 7 RT DR e SR N — e T
BIUEL, EZIEIURAS MBI RT . 2% sl 2 ) A B T
TR % $E “Design Variable” Y, “Component Parameter” $794#i, 75 B4 E FH6 1AL &
% (Variable Name) #3444 (Component Name) FliZ#s1FH1 2404 (Parameter Name). & 3.4
SEWOE A . 7L IR S 5, HAR g R R
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3.3 &3l

PA—ANA SRR GO 1 6B “DC Analysis” 105 SRR, HLER QT 3.5 . BT B

Sweep Variahle

Temperature
H Design Variahle Variable Hame
Component Parameter

Select Design Variable
Model Parameter

Sweep Variable

Design Variahle Select Component
H Component Parameter
Model Parameter

Parameter Hame |

3.4 “Design Variable” % &

Wb YEAd S ) “analogLib” = “vde” BT,

3.3.1 i EH “Design Variable”

7EE 3.5 1, Rt MO ) B H s 3V U B AR R “VBIAS”, fiddi “Design Variable”
> “Select Design Variable” 5437 AR IR LA HIE 3.6 TP HEE T A8, Pril
Rz R FIER “OK” 5, A RS S HIAE “Variable Name” 1, B X 'E4F “Sweep Range”
Fl “Sweep Type” JERI v, Kl 3.7 i FL kKR 987 “VBIAS” M OV 2| 5V LI 4

R AR A B
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Sel: 0 Status: Ready T=27 C Simulator: spectre
Tools Design Window Edit Add Check Sheet Options

€% | &

P
2‘_&1

0
“ha

=y
%%
%:
Y

Kl 3.6 PR R
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File Edit Graph Axis Trace Marker Zoom Tools Help

& 0 H# i & [ILabel | |

DC Analysis “dc'; WBAIS = (0 -> 5) m

= ouT

5.0

4.5

4.0

3.5

3.0

V()

2.5

2.0

15

1.0

0.0 1 2 3 4 5
WRAIS

o> [cadence]
Kl 3.7 i EMIE

3.3.2 ##ESHHEF “Component ”

SRR R SRR, s “Component Parameter” > “Select Component”
Jr i P . AT LR MOS B BRI M Z SRS R AR D U7 EN B . R
3.3 F1) NMOS & MO, i iizasfF RIS EE . B RS S 550 2 0 AN S5 iR . T A
X% MOS IIMHCAZ A S 51l . B 3.9 17 30378 MO 5 IOHIHK N Ty 21 200 2240, it v
AL DL o
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Cancel Help

W "Width"
1 1 "Length"
as as "Source diffusion area"
ad ad "Drain diffusion area"
ps D= "Source diffusion periphery"
pd pd "Drain diffusion periphery”
nrd nrd "Drain diffusion res squares"
nrs nrs "Source diffusion res squares"
14 1d "Drain diffusion length"
ls 1s "Source diffusion length"
it I "Multiplier"
trise trise "Temp rise from ambient"
CEglon CEgLOLn "Estimated operating regilon'
deqgradation degradation "Hot-electron degradation”
geo geo "Source/drain selector”
rde rdi "Additicnal drain resistance”
f=1ed LEC "Bdditicnal source resistance
sa sa "Dist. 00 & polyi{one side)"
sh sh "Dist. 00 & poly({other side)"
sd sd "Dist. betn neighbour fingers"

3.8 & 3.5 KIS MO &S5

File Edit Graph Axis Trace Marker Zoom Tools Help

&0 # [F & [\ALaber | |
OC Analysis “do' MOl = (1 m -3 20 m) m
= vouT
4.4

4.38
4.35
%4.33
4.3

4.28

4.25
0 2.5 5.0 7.5 10.0 12.5 15.0 17.5 20.0
I (v
s> graph0 selected: double-click to bring up attribute dialog. |(a dE nce

& 3.9 MO0 & HIMHC A 1pm 2] 20pm 2240, 46 B RIZRL
FUEF ML M HITZ N “DC Analysis” WIS EAR A0 2 T RIBSTH . tin MOS
BRI T2 “Design variable” F “Parameter analysis” JL[RH ], {FE 45K WE 3.10
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PR

7E “DC Analysis” [F=2 EH (Option), G “State File Parameters”. “Output Parameters”,
“Convergence Parameters”. “Annotation Parameters”, “CAPTAB Parameters” 2. XSS5

(FREEBRREE)
 Mar 8'09:48:18 2007 o] E@a

File Edit Graph Axis Trace Marker Zoom Tools Help

SrnEE (ki & -—

DC Response E|

EEM2:d (VG5=1.008+00) EEMZ:d (VG5=1758+00) EEMZ:d (¥C5=2.508+00)
EEM2:d (¥G5=3.25e+00) EEM2:d (VGT=4 008+ 00)

15

T
E.750
500
L2500 1 T [ I 1 1 I [ 1l I I I I.
0
0.0 1 4 5
WDS
o [cadence

& 3.10 MOS BHIFEREME

SR E AR S A N4, T LA [H cadence 1 7 Mt
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F4E ZENKEE (Results Browser)

4.1 “Results Browser” B1E

“Results Browser” & — AR5 S TR, @ik & nl DUSZHOIT A H B 1 (1) H R R 3 11 HE
WA R o I HooT DU ER AT TALEE, {EA ISR S R rh WoR . eAh, I3t 740 e
W, “YvsY” Ihfit. ilid “Results Browser” 1 LLSZIHL LR hfg:

[1] SEEHER;

[2.] BEVHEAERE;

[3.] SEHE LA SRS

[4.] F&5 RALFR R ) I As s b 8o, 0 an Bt R 54 1]

[5.] B mas Rrh iRk X HHEAE N B “Caleulator” AT .

4.2 “Results Browser” & & 4

“Results Browser” KL “Windows” SCIFRGEM 55, K07 HEH 20 P RAFAER AL
e Tl RSCHEe, WTRURE SO ETT, AT HEN T — R3S 3 BAR IR B & 4.1

BREIRE “Results Browser” & M.

Resultz Browszer

File Settings Tools Help

= L C’ Replace -

Location |~fsimulatiunfOptimizerfspectre,fschematic,fpsf | v|
[ |/ horne. firewarks fwangy simul [ tran-tran

= tran-tran : gfinalTimeOP—infn

) ) . H arc-ac

e~ _ :

[ finalTirme0P-info | deop-ac

Ol ac-ac £ deopinfo-info

3 dcop-de A3 de-uc
&[] deOplnfo-info A3 modelParameter-info

=T dc-ac 23 element-infa

) : nutputParameter-info
) Qo LR S : g des?gnParam\fals—infD

®- ] element-info AT variables
-] outputParameter-info :
@[] designPararnyals-info
@ [T wariables

I | Firer E v
[> [cadence

K 4.1 “Results Browser” &
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4.2.1 “Results Browser” [HJ3ZH.,

% 41 FHT “Results Browser” HHTE 1A eI TIHE

%% 4.1 “Results Browser” & 17 )32 5 L& ThRE
SR LI T A4
Open Results FT 7 B 45 2R
Open Graph
Open Graph as Plot -+ DL R 1 B AT R A7 B
Open Graph as Tamplate -~ |DABEAR (178 04T TFORAF B E
File Open Table FITHORAF I A
Clear Wk i 45 R, M “Results Browser” H1EER
HE AT EEIRE, ORIk HERR .
Reload CiR [asd-VE)RERAP S

Save Session

R4 2917 “Results Browser” 1% &

Close M “Results Browser” % Il
P s, EI217 T “Corner Analysis” BY#
Select Data “Parametric Analysis” J&, ZIEIEGE. 7T LIS
elec o et \
e B DR A B R A A R T LA
*
Plot Style
Append TR B AL 28 R
Replace R SEOK B b MR, R B
. New SubWin . . - o= e
Setting TESRI b, LS5 1, R BB e .
New Win I — N F T 1 R B e .
Graph Type
Default BiLT7
Rectangular IERG LT
Polar WA B
Impedance BT [ 3]
Admittance A
RealVsImag SEF VS REH
Calculator ¥+ “Calculator”
Tools
Table I AE
Help |Help FREHS By SCRY
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4.2.2 “Results Browser” % [ [ e f b

“Results Browser” & I [ HRGEEBEWIE 4.2 Pros, S MREEREKIZhREW T -

= 1 B <D |Default v || Mag v || Replace vl
& 4.2 “Results Browser” & 9 f) e fE:

= T RS 25 K . 2% [H] File>Open Results

2, gl “Plot Style” sk PEf 72, LA 7 2 B e 07 20 3

E. 157 “Calculator”, WH7E “Results Browser” ke (i fiai i, T4 B R
A LB “Caleulator” OZEAET,

Do BP0 AR R

VERG: MR LA R AARATAE S M R KA, BIAETT T “Comer
Analysis” 3# “Parametric Analysis” Jio

Sl BRPI MU LYY 7R 07 2 R

HR: PSS — My B A AL 2 MERIE UL T KRR, #lniedT 7 “Corner
Analysis” 8{# “Parametric Analysis” J&o

=, ePes R, AB4T T “Corner Analysis” B{# “Parametric Analysis” J&5, 1%k

THH T o AT DU b & e By e T RE A B e AR B R A g B . 5 R T “ Setting”
- “Select Data”.

P AR, WA 4.3 ProR. % R RS ORI R R, SE[ T “Setting” > “Graph
Style”s VERL: 1% P - FEIE AT LS5 RIN A B
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Eezults Browser : Elrzl

File Settings Tools Help

= {} = |rEEtam_:|uIar "'||| Mag - || Replace - |
Default '

Location |~fsimu|atiu ectre/schematic/ psf ‘ v|

[ 1 jhorme fireworks f'wapolar

Cd tran-tran impedance
[ finalTimeOP-infdad mittance BLUS
Jac-ac realvsimag BLLIS
3 deop-dc :

& 7 dcOpinfo-info
Cddc-de

Cd rodelPararmeter-info
T element-info

] outputParameter-info
3 designPararnvals—info
[ wariahles

§HMr&3EﬂF_____
[cadence

B 4.3 TR

AR, WA 44 PFroR. 2RO R R BRI T AR B . LT RESRAL T
“Calculator” HAIAAE. TERE: % N PSS AR A L
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Eesults Browser |Z| |E| [z|

File Settings Tools Help
= E S |rectangular v |Mag - || Replace v|
Location |~fsimulatiunfOptimizerfsp rhag atic/ psf ﬂ
———Phase
fhome. firewarks fwangyy simul M1 fwPhase
T tran-tran EEIT Real
[ finalTimeGP-infa hyo,(imag
[ ac-ac y1,{dB10
CJ dcop-de ; dB20
@ [ dcOplnfo-info :
[ dc-dc
1 modelParameter-info
1 element-info
| outputParameter-info
CJ designParamyals-info
[ wariables
i =
]| Fiter Al |
[cadence

Kl 4.4 5 AFHgm
Mag: TH{) BL45 TR A
Phase: 107 B4R M (180 FEE+180 By FlTI 50
WPhase: TIFHEFILE RN (0 % 360 JEIEHTHED
Real: U5 H.25 B 152558 .
Imag: BT EL 45 R IR
dB10: X FL45 BT “10logn” 254k,
dB20: X FLE5 BT “20logn” 254k
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Eesults Browser |Z||E|rz|
File Settings Tools Help

= B S 1A ‘rectangular - HWPhase ~ | Append v|
Append

Location |~fsimul;n‘.iun,fltrlptimizenr spectre/schem

Replace
fhome fireworks fwangy/ simulg M1 MNew SubWin
T tran-tran gaT Mew Win
I finalTimeOP-info VO PLUS
[Jac-ac v 1ypLUS
3 dcop-de :

@ [ dcopinfo-info
J de-dc

1 modelPararmeter-info
3 element-info

1 outputParameter-info
3 designPararmvals—info
Cd wariables

|’§HMr%NMI - |

[cadence

& 4.5 HE=ATHRE

® AT RISRANE 4.5 FroR i R R RO e R A W i H AT 2 S5 (R T Setting”
> “Plot Style”.

4.2.3 i REGRRFHAZ,

Uik 4.6 Pz, “Location” #5712 B 0 FLAT R I ORA7 A2

Location |~fsimulatiunfGptimizer;‘spectrefschematicfpsf | - ||

B 4.6 HHIf KSR MREFRE

DA HT I (0 05 B 45 SR R AR DR A AR 1% R e sy, ] DLad o sehe MRS fpons i ps 4%, 08140
45 R 51 N F] “ Results Browser 7 1 o Bl 4 AE & 47 , fE PR BP P EET
“~/simulation/BIAS_P/spectre/schematic/psf”, K ILiZGFEL 45 R HIIAE “Result Browser” 1, 11
Kl 4.7 th e N ) e il o s .
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Results Browser

File Settings Tools Help

= 1 G & Append -

Location |~/ simulation; BIAS_P/ spectre/ schematic/ psf | - |

] ;hc,me~fsimulatiunfBIAS_P;spenrefschematicfpsf -
9 traf~ / simulation, Optimizer/ spectre/ schematic/ psf
3 fin ~fsimulation/ BELAS_P, spectre/ schematic_cascode / psf
3 ac_~fsimulatiunfufspectrefschemalicfpsf
o dc ~ /simulation, Parametric/ spectre, schematic/ psf

o ac ~{simulation, BIAS_P/ spectre/schematic_paper psf i
= dc_~fsimulatiunfBIAstpectrefschematicfpsf :‘

~ /simulation,/BIAS_class/spectre/ schematic/ psf
Ijmn BETF A armTmeEier =1

[ element-info

3 outputParameter-info

3 designPararmvals-info

T wariables :
[ 1 jhorme firewaorks fwangyf simulation /BLAS_Ffspectre

= G

= = C ALy
[> [cadence
B 4.7 T 4 RO RIF BB E

4.2.4 “Results Browser” & 11 E/AEH4

“Results Browser” & [\ AR A ZEAPIRE, Zoill—FE BHIRAE BEAR, DI TR 4544 4> 2%
TRAE LA R o 10— W G aiak b SO e N 25 o AR WSO bt 3 1 S0, WIE
ZHATHIL “ @7 brid. GxAnid v REEFT I S JE A LD

g Rl H A LU NN, WK 45 PEF R, R 42 65T 2 RAHAILEAANZ,
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42 TEAME N

2

AR

tran-tran

W 28 O 0 BT AT 1 R H P ARG % DR AT i
¥ e

final TimeOP-info

DI AR S 2800 AR

ac-ac

AT U7 F BT e A s L R 6 DR AT i
H e

dcOp-dc

TAE R E ST R, P sl i (A
PEORAF i 1 LA

dcOplnfo-info

TAE R ERTE, P asfF 248, 5
AR N LR AL A A4 TSR, )
TRAF A S B TAF RS

dc-dc

BRI TR, B s s {E AT O
A7 ity 1 HLURAE o

modelParameter-info

P FCR IR I 24

element-info

BO U B P T R A S A

outputParameter-info

it 55 B o %S N DL R4
LT SCIEYE, o A B iR A SR A
SIS, Blua 8K E Aeff), HR
B (weff), HRCHFAME (reff), 4% H 24H]

(ceff) Z54%,

designParamVals-info

B

variables

B AR, 2SR N LB AR A A
AT SRR, A RAE A A B AR R 4F

H

/BN o

4.3 B3 “Results Browser” HiZBYFELER

1) Gl FHAEE—F 708380 “Results Browser”s

® {i Unix g AT AN “wavescan &” T .

® £ “Calculator” % 1 i%E+ Tools=>Browser.

® £ “Waveform” 7 H %+ Tools>Browser,

® £ CIW % H i+ Tools=> Analog Environment->Results Browser.
® £ ADE % H 1% $f Tools>Results Browser.

SRJ5 “Results Browser” % 3 H .

2) JEILIEEE File>Open Results B¢ fREERE “ = » $IJF “Choose Data Directory” % I,
i 4.8 Fron, ML H 45 AR A2

53



Choose Data Directory

Directory name:
Shome. firework:s fwandgywark fpaper |
@/ -
@ [ home.fireworks g2

@ B wanay

[ .artist_states
1 .cdpeache
[ .cosdoc

(| .gconf

=3 .aconrd

1 .aftp

1 .anorne

3 .gnomez

1 .gnome2 _private
3 . java

O .1ftp
CJ.mozilla

[ .ssh

8 rae AT

| ok || Apply || Cancel |

B 4.8 fHRERERATHRE TR

“Choose Data Directory” & HFT I, K “icfb” 1A SR A BRIAEZ.
7t ADE [FERIN BB Y, 7 L85 AR IR AT N -

“~/simulation/CellName/Simulator/schematic/psf”

For “CellName” 2 FLHLE I A FK; “Simulator” JEA7 FLAIAFE, BRIMEA “Spectre”,
WUERNINIZ R T — X7 EL, “Results Browser” 2¥ ) BRI FLa R e ATHHAT LR B .

3) i “OK” 5e B L .

4.4 7 “Results Browser” HikiF#iE

STECIE 4.9 F1E 4.10, B]PLAIL “Results Browser” H SCAHH 4 #E 5 201 Windows #:4E R 48 H
SO R G150 28, WIRIZE Window #:17E R4, #E “1C Cadence” [ %t 5 4% H 58 SO
PR FTIFADI, (o iaperh sop e AR srh, de8esids . 130k, sl 1130
¥
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Eesults Browser

[Z”E|g| 85 1 Results Browser

CEX

File Settings Tools Help THE RIEBE FEFW W IAD FBw i
= @GS Avoend . "W Qe - © (P OuE |k | -
| LOE0D |~fsimulationfOptimizerfspectrefschematil:fpsf | hd Hittik (o) |@ E: 4R\ cadence BUEI#T44 Results Browser V| 23|
— Shome firewarks fwangyy si T x
C tran-tran @ Besults Browser
; - ) @ =H7:] - Microsoft Word 344
& [ finalTimeQP-info ) e - 233 XB
g o = d HAyr Eesults Browser
dcop-dc . e REE M) @ Menm
@ 3 deopinfo-info e THE @) 01 | Microsoft Exeel ...
g ;% S e T E)
uﬂ backup 0
|j RO uﬂ P lj Técﬁsoft Excel .
Hwo ) download
vl |7) Entertainment ] “$=zults Browser
9 de-de ) my picture I_J Microsoft Word 344
@ [J modelParameter-info | work
D rwn D) EHRRE “WELZ0S0. tnp
© [ elerment-info B o I& FEE] ;gll’ %f*
[ s = i * B DRk ¥
= | Dk Filter @ @ < ! 1
[cadencelfs +xs@mua=a: 001 ) 8 1 J Eaem

Kl 4.9 “IC Cadence” ™ [ SCA-E 3 & 4.10 “Windows”H ) & HE

4.5 iitH “Results Browser” HpJ&ER

2| “Waveform” &,

451 HERHGTREEGR

X7 L RAEATAT AT, T LIl el

UL iR g R E R 2 “ Waveform”

l

S

o (EEMHEEMGELIE, il B, ERIR “Plot Style” AT,

P I 7 s h K 7 346
® R EI AR, MﬁsMWEﬁ%, PRI S AR, W 4.11 B
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REezult=s Browser

File Settings Tools Help

= B S E*|reclangular v||Phase v||Append v|

Location ‘nﬂfsimulatiunfOptimizerfspectrefschematicfpsf |v|

[ fhome. fireworks fwangy sir =] 5N 1
T tran-tran i Append
@ [ finalTimeOP-infa Replace
Jac-ac New SubWin
] decop-dc Mew Win
@ 3 dcoplnfo-info Table
Cco Calculator
CI Mo :
R0
o
w1
3 dc-dic
@ I modelParameter-info
d vn ;
@ [ element-info |
il IH_EWMEE[Z*

[ [cadence
 4.11 B HEREE

FAEI Dy RE A T -

B “Append”: UL “Plot Style” 24 “Append” W73, WonEd g R,

B “Replace”: LL “Plot Style” i “Replace” [, BRikd i sigi g,

B “New SubWin”: LL “Plot Style” &y “New SubWin” 7\, Wik i B4
xR

B “New Win”: LI “Plot Style” & “New Win” )73, Wik B R,

B “Table”: DIFIZRM T LBk b i 5 8.

B “Calculator”: Wi FL5 R HBHE R “Caleulator” A7 .

HRE: UL, “Results Browser” FXMIE RN TAEHEAEAN. HlanER 4.11
H, FATHRHEER “Phase”, HVAMHITELERNEMA. XANTIREXN LA 5
ANEREER . HENTF “Calculator” IR, i£Z] “Calculator” F KL AHE
HHEE. WREEEREA, WFEELE “Calculator” FXHZEIEMFEH “phase”

4.5.2 B E R H 3] “Calculator” HIZEFEH

AR T BT AR, Adibeeret B, Wi SRR ) “ Calulator”
A7, WATBLA 4.5.0 AN, S RERARL, HEOTE4E A% E)  Caloulator” (9ZEAE .
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4.5.3 HH AR INEE.

P MR R )G, ST st “<1>”7 I “Results Browser” K axfiinikiE s

—AMEELER, WK 412 HEIR. R MR R, BRI “Plot Style” H 1w E
P E S R 258, Bl “Result] — Result2”,

Eesults Browser ['T”El&l
File Settings Tools Help
= MBS RE ‘rectangular - || Mag ||Append v|
Location |~fsimulatiunfOptimizerfspectre,’schematic,’psf | v|

fhome.fireworks fraangyy simul M1

T tran-tran M2

3 finalTimeOP-info eyt

WO FPLUS

Dac-ac AW LiPLUS

CJ decop-de :

3 deoplnfo-info

[ de-dlc

3 modelParameter—info
1 element-info

= outputParameter-info
3 designPararnvals-info
] variables :
Fhome fireworks fwanayy simul

B Z| Ib?ﬁmr&?Em* l
[> Flease select the second signal. Press <ESC > to cancel. |(a dence
B 412 BT RS RNER

4.5.4 BHAMIELERRA “YvsY” KR

LB AT RS, A < b bbEga < %7, I “Results Browser”

B PoRiE# ) MR ER, Wl 412 b, ” EFEE AR AR, R R,
ity AN FL A AL

4.6 MOS ESH 2R

7E “finalTimeOP-info” fil “dcOplnfo-info” #B{RA7 T gk B AFS L. R4 MOS # 11y
L SR BT AR

1) type: MOS & 2KAY, WHEE N n B po

2) region: MOS # I TAEIIL, RN 0~4, J3 A1
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1: KMy

2: ZRPEX

3: MR

4:  WEHX

5: g

3) reversed: MOS FJEH X, THEEA yes B no.
4) ids (A):  FHME IR HLUR

5)  Ix4 (A): ids A%, >4 MOS & J m) B AH I A5
6) 1x50 (A): ATJEHEI.

7)) ves/1x2 (V): HMHEHL .

8) vds/Ix3 (V): JmEHLIE

9) vbs/Ix1 (V): #JEHEE.

10) vth (V): A3 {EH .

11) 1v9 (V): vth 15144,

12) vdsat (V): Jms A

13) 1v26 (V): ~*f-ili 1% (Flat-band voltage).
14) v10 (V): vdsat [F)5 4 .

15) gm/Ix7 (S): ST,

16) gds/1x8 (S): JLJafHEE T,
17) gmbs/1x9 (S): 4K T,

18) betaeff (A/V2): HZ P 1H.

19) cjd/1x29 (F): X 4l 45 7%
20) cjs/1x28 (F): YRIX A4 2
21) 1x12 (Coul): #fJECHLAT (Qb)
22) Ix14 (Coul): M HAT (Qg)
23) 1x16 (Coul): JXHLAT (Qd)
24) 1x24 (Coul): Js[X PN &5 Hifir o
25) 1x26 (Coul): J5[X PN &5 Hifir o
26) cgg/1x18 (F): dQg dVg

27) cgd/1x19 (F): dQg dvd

28) cgs/1x20 (F): dQg dVs

29) cgb (F): dQg dVb

30) cdg/1x32 (F): dQd dvg

31) cdd/1x33 (F): dQd dvd

32) cds/1x34 (F): dQd dVs

33) cdb (F): dQd dVb

34) csg (F): dQs dVg

35) csd (F): dQs dvd

36) css(F): dQs _dVs

37) csb (F): dQs_dVb

38) cbg/Ix21 (F): dQb dVg

39) cbd/1x22 (F): dQb dvd

40) cbs/1x23 (F): dQb_dVs

41) cbb (F): dQb_dVb
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42)
43)
44)
45)
46)
47)
48)
49)
50)
51)
52)
53)
54)

ron(): ‘FiEHLFH.

id/il (A): Y I .
is /13 (A): V5l LI
ibulk /i4 (A): Ff .

Ix5 (A):
1x6 (A):

pwr (W): &b TAF Rl ZhFE .

Yt PN 45 FL UL o
It PN 45 FL UL

gmoverid (1/V): Gm/Ids

1v36 (F):
v37 (F):
1v38 (F):
1x10 (S):

Ix11 (S)

MHIEAZ B FL 2
WA S 2
WA JECAS B FL 2
X T
s X REE S
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H5E M55 (AC Analysis)

5.1 DhfeEANH

LME ST (AC Analysis) 2 FHRVHE FLUES I /ME S8R 0 NARE I o AR50 BT I, (5
TR IR I BV TAE A SRR M B A AR RO B Ze Ak, I LA vl 530 FL B PR A3 1
DI FERE LI RESIE. BT ERSHT (DC analysis), {EACH/ME S0, &
T F A FEH “Frequency”. “Design Variable”. “Temperature”. “Component Parameter”, “Model
Parameter” %5 Z 4L .

52 HESHKE

fmiiti “Analog Design Environment” = “AC Analysis”, #fHAH/AME S SR EE L.
W 5.1 s
AC Analysis
Sweep Varahle

4 Frequency
Design Variable
Temperature
Component Parameter
Model Parameter

Sweep Range
Start- Sto
S, e
Center- Span
Sweep Type
futomatic

Add Specific Points

B 5.1 ZZRAHTIIEE
R IR REM “Frequency” 4, “Sweep Range” 5 EMinyull. HFEMEHE RS
XA [FBEAT 5 R Y o T 7E At 145 5 X R “ Temperature” $94# 91, “Spectre” ELSKH 7
Fa 8 1E AR S AT B . R, FH T EE “ At Frequency (Hz) ” HHIES 4/ HLAIAR, T7E “ Sweep
Range” IS (& BEHIRE . AL S Ed R 0w B el an bt
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Sweep Varable

At Frequency (Hz)

Frequency
Design Variahle

# Temperature
Component Parameter
kodel Parameter

Sweep Range

# Start-Stop

Start Stop
Center- Span

Sweep Type
Automatic

Add Specific Points

B 5.2 AR RERNBE

5.3+ Wt SEpIHH 4 RS

LA 5.3 o ) BUBOR A8 D SEB BEAT AW ME 5 70 W AEBURASBEE Y, oDl
& R A AL BEIR AR AL TS DL o AESZBR BT rh, AEAE IR SRR A IO 2 AP

Arlfl_:o
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Cmd: Sel: 0 Status: Ready T=27 C Simulator: spectre 2
Tools Design Window Edit Add Check Sheet Options

D2 g% | [€]

mouse L:schSingleSelectPt( M: schHiMousePopUp() R:geScrollinil "&" n

NplE

B 5.3 W Hrsedil

FEM “AC Analysis” B, WAZ5E4 R E — NG 5. HLL “AnalogLib” = “vsin”
F5 s, £’ 53 1, BT RESREEMN “MO” ERMmA, BAfERARL
TAE SRS, DAL % MOS 5B — N E U E R . 7045 5 IR T 77 2 B AT R
MEFRE. WK 54, £ “vsin” 755 0%EPOFEZRGG SIEE (AC magnitude), ¥t
{55407 (AC phase), Hiftf'E H)E (DC voltage) ZEZ %I, “AC magnitude” ¥ Al
BCEN 1V, “-17 KR 180° MLLEHHE . 4%, BorhH M LB BE “AC phase” K&
AL, “ AC phase” S48 W B4 0. “DC voltage ” H3 45 52 Bm H 5 152 B & B AT o 1% HL H BL 1R
LR IMQ HLBH A 9128

AC magnitude -1 hoth
AC phase off
DC voltage <} both

M 5.4 ZHESHRE

T BT N X AT B TP AT S R LU B S 2 S N P 5.3 o, Mo
(P E RSN 1.5V, SRR EEREN 1V, % MOS & EEHIE 1V. 4 “M0”
SAGHENBIEXWE (1.5V-1V<IV) ? SZFp EATEEE R TR “MO” A AT GEdE AIEIX
TEA T I PRIA L, “AC Analysis” [FHiFE2EHAT T “DC Analysis”. Frlh, HUERE
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W58, IIAAS UG 5 o A B TAE il 70T Fa S S s 2 I, 477 S 2 i o i 1)
A T IRAERR LU AAZ IS SR . FrLl, “AC magnitude” WE N 1V &N T HETHE
ML GE R, A TAE. B4, WAL B AG SBK, SEmE ik E
T CAE s Wl SL0E 2 3K 75 BT LRI A ) A7 SR BEAT A Al e v 2 P ZE 1 4, I
W A BRI 53 BT

B R L “Tool” = “Results Browser” A&, WK 5.5 s

[ Results Browser : E 1

File Settings Tools Help

= 1 G <D L= |Default v ||dB20  ~| Replace |

Location |f homefireworks/wangyk/ simulatio Mag spenre;sche]ﬂ
Phase

Jhome fireworks jwangyikfsimul Y O/PLUS  wphase

Jac-ac APLPLUS  peg)
} w2z iPLUS

CJ deop-dc Avour Imag

1 decoplinfo-info neto12 dB1D

Cd rmodelPararmeter—info net7 dE2D

] element-info [l
3 outputParameter-info i

] designPararmy'als-info
T wariables

o Filter @ [ |
[cadence

B 5.5 liRGR2HT

fER 5.5 P MR, o2 Mo Ut

“Mag”: M B4 0 i it 2k

“Phase” & “WPhase”: {7 ik, WHANFZALET “Phase” &M 360° FFih
YEB, 1 “WPhase” JEM 0° JFUATER. Wi 5.6 Fir.

“Real”, “Imag”: M THs{E42s BT DL exp MFaE0E KR, FrLinl A
“dB10”, “dB207: {EyHE & s ARy Pl o e i 2 DR . “dB10”, “dB20”
TR EE A LL 10logA Fl 20logA T 45 5. W52 HRIRAECR A “dB107, Wi
DR TR “dB20”. —MIGHL T, fEBREEIT “dB20” HoME . K
5.3 MBI th 2 & 5.7 o

Xt “AC Analysis” "' “State File Parameter”, “Output Parameter” %% =2 i% & (Option) 1 I
“tran analysis” /4.
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SAHEE

File Edit Graph Axis Trace Marker Zoom Tools Help

F &

[+]Label | |

AC Analysis “ac: freq = (10 mHz -»> 10 MHZ) m

380

(]
(o}
(=]

el
I
(=]

L
=
Ll

W
(=1}
al
=
=320
=)
@
=
o

rJ
ua]
L=

rJ
-

Sm

f=Y=1

(=]

1
)
=]
=]

1
@
=
=1

WPhase(w) (degs)
i

1
|

@
i
5 2
=

= OUT) Y OUT(L)

102 1071 10 10l 102 102 10 105 105 107
freq (Hz)
> graph selected: double-click to bring up attribute dialog. |(a dE nce

&

5.6 “phase” 5 “wphase”43¥7 &

File Edit Graph Axis Trace Marker Zoom Tools Help

-40.0

-G0.0

&0 [Ft = [~]Label | |
AC Analysis “ac’ frag = (10 mHz -> 10 MHz) 0
BV ouT
-20.0

L]
2 _80.0
™l
[uu}
ral
-100
-120
-140
1072 107l 100 10l 102 10° 1wt 17 10° 107
freq (Hz)
«[> graph0 selected: double-click to bring up attribute dialog. |(a dence

B 5.7 “Vout” 5HZERXR
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%6 FE FERETHT (Pole & Zero Analysis)

6.1 ERS 5 (Pole & Zero Analysis)fE 7

TR T WTZe PRI AN U BRAT R AL A RO 3%, 7T LU BBl L B g vt i A
Bb, XTI DU T8 Bt IR M e AEF AT, W2 P A i R BCRA 1, 0 TAE
TR ARG, A4 e BT AR R

a@ §m+a ?m_l+ +a
H[S):%:U r - - m
(S) bOS"+bIS"_ +...+b"
6.1
ALY, At R Bt v AR IR «
N(S) ay (S +Zl)[S +2‘2) [S+Zl.) [S+Zm)
HES) = 55 = b S+P|S+P,) [S+P) [StP)
6.2
EH, VOB (WEE Z) B WE 1) 2. DS)BIFTA AR (W2, P o 1)

Woxts o SEORMARENR . HERIIAT AP TP, B S Pifl, LRI AL E
AR AR LR PR SRR o B

2.
H(S) = i§-2)-(S+1)

6.3

KL ST LME 7 (S)IE 0, B S=25 5= -1 e 7)) EESS, e s =
0,

BT AR AT U SIS, AR S5 R T XY PRI A0 fEREIE LT, B A K R e
(o P& 6. 1 Ui 2 FeE FeEt AT N o

A
e
Y

6.1 AT 6.2 Bt Pl
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WERA BB 2 A0, B ARGE R, K 6. 2 FoR R X AR AT .
RED RS REE , 5 ZEER A DT AT B s AT S R S e W SRAT A R R AT IE RS, A
ORI, AATRERUE -

1 Spectre )i ELA4% P B8 AR AT,

1. E Virtuoso® Analog Design Environment (ADE)fJ32 5 rhi% 4% “ Analyses” = “Choose” «
“Choosing Analyses” — “3EFHZEM” SHEHELIL, WE 6.3 s,

2. TEFE “pz” o CEBESHTIRAL” XPUEHERET WoR AR, SR H AR AU AT IR A5 R 0

Choosing Analyses — Virtuoso® Analog Desig

B 6.3 “PZ” &
3. FERPIEHE R “Output™ 150 & Hi th o o AEWTE] 6. 4 Fro iy N R i n] UL+ “Voltage”
B “Probe” KA. Fi55E M H W T VAW R
a. {E“output™ |73 FL ik $E“voltage”

B 6.4 “PZ” Z¥rkOisE
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4.

b. piii“Positive Output Node” —#=ff] “Select” %4, X5 1E ML EH mids—A ™
AE T I I . AR5 i “Negative Output Node” 421 “Select” %41,
SR T LI S — A Y 2 A Ay i S 1) 7

BRE AW
a. fF “output” FHEIAERE “probe” , HILWIE 6.5 FrRE I,

&l 6.5 fi5E LRI H
b. {E “Output Probe Instance” —#= iy “Select” J7E B EHEFE— a8 (F
iy 1 LA AE Ay ) 5% 728 )

MR EFILE P 2, 76 CIW fn AT i D & o — AN, $EORIERE A28
BUAXF . BRI “Spectre” ZefH A% N[¥) “analogLib” H.7C, WIER 6.1 iR,

6.1 #nfEA 55X “analogLib” LG

s SN H analoglLib BT

HHL ind, pinductor

s Y5 vdc, vpulse, vpwl, vpwlf, vsin, vexp, vsource

PAPS spltswitch, sp2tswitch, sp3tswitch, sp4tswitch

ik tline

A5 W R IR VCVS, CCVS, SCCVS, SVCVS, ZCCVS, ZVCVS, PVCVS, pVCVS2, pVevs3,
pcevs

CEN R SUIE iprobe

ML FEI AT “tline” (IR, 75 “IEFEI TR JHEHEF 1 “Output” F R s 2

“porti” £o IXANSECVFIRIEE — A E i AU st o DD BT A 1R 0
S, UL A R AT T o) — e R, “tline” ge R mE——A
2T 2 i st

HHIL7E “Input Source” Rz kS “voltage” B “current” F5 e fir A\ & HE B IR
U, WEFIHWE 6.6 s, JrikE b
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5.

E 6.6 “input Source” )% &

WA BRI AR BB ST A Gk, 1 ASHCkEH . W LUERNSEEE
BIAHE “Frequency” (%) , “Design Variable” (%178 H) |, “Temperature” (i
), “Component Parameter” (#3424 Fl  “Model Parameter” (FEHISHD , &
EH K 6.7 k.

B 6.7 HfRBEE

WA E T H A M SR, SIERESR A 6. 8 B .
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Choosing Analyses — Virtuoso® Analog Desig

& 6.8 EEHAMSHENED

¥E: Add Specific Points (7RI E ) #0HAEJH T Add Specific Points (78 IR E A5 %411
A 23 R

6. WIHRIEFM L “Design Variable” , “Temperature” , “Component Parameter” ¥, “Model
Parameter” , 7 “Sweep Range” P48 IS HIVERIFIZEAL, WK 6.10 Fix.
B N ARG ) E R RR

&l 6. 10 FH4 I KIH E

AR LE TR 20 N2 Spectre AR AMIIKILEIN, AP B MR8
LRI
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e Linear + Step Size = step

e Linear + Total Points = lin

e Logarithmic + Points Per Decade = dec
e Logarithmic + Total Points = log

e Add Specific Points = values=|...]

MR IR E IR,  “Sweep Range” HHEVEHEIEINAE AL IR,

7. pith “Options” 3%, 7T IO IEHE o TX A0 U AE A ()P4 B E WL —
o
i “Apply” (NHD
Rith ADE FIZE A [ “Results” = “Print” = “Pole Zero Summary” ¥ [ HH 4% L5114 .
W AT LLE RS ADE SEHi [f)“Results”>“Direct Plot” = “Main Form”. Z4E “0CEAN®” Hfiz

il 2R s M e E L, LA A4 “pzplot” Al “pzSummery” .

6.2 ERRATHIRRIER

6.2.1 FRADFTAR

T I I LU T A L R S A, SRR A N R G, X R % (1 4% A R £
BEAT 3 M, VS PTAT  iAA R R BT 2 A, DA 7 S i S R A\ s 5 )
AV EM A WRAEARM RIS (RAURAEAF PR T AC SERRRANA] (214, 1
U4 B AT 1L AR AL AL R 81D “ Spectre®™” HUEST ELAK R 1Hz 1 BB A AR S
PEAE LB PZ o3 AT BUAE R A2 T SRR (K 50k S 2 S s FRORS A L - DRI /N RS sy R
FErfig (21 1000 DMTRE) PGB B ITERE .

“Spectre”” 1] LAYE AN SHUE TG F B A0 3 o XA SHL T LU,
WIS, BMSH, s MRS MRS ZHGEM T DC TAE A, R 10 TAR Rl
FHOFESL. T RUE gy B I S EA R (temp) MRS (FERABE dev M
mod ZHIHITE F)o EDMTEKZ G, B EIRI B JsOR IAE .

RO R (MR ZEMERED AN T @A, RO AR AR . 1%
AT LU “absdiff” 5 XARLERTEIEY, BUH AT “reldiff” 5 SGXAN AN AR A R 48X I
Eeil. “Spectre™” A FHX B AME H LLAR I — MBI I E 42
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Pole—Zero Options

B 6. 11 % 201 BT e SRk T

TR SH
[1.] iprobe: ML ea ZU A% 5
[2.] oprobe: FRIAL ek K ) % 5

o 0S4
[3.] portv: FHEIERIL, “oprobe” it I b HL AT 4 0 A HY
[4.] porti: HLUAE, Wik “oprobe” Ui I HLMAE DM . 4 “oprobe” & H Y5 E# i
PR R 2t I A RS

HHERRESH -
[5.] start=0: HHi TR
[6.] stop: 4 FR.
[7.]center: FIfli L
[8.]span = 0: ML
[9.] step : ZMERIPHR
[10.] 1in=b0 : iR EPEL, &V
[11.]dec: % 10 512050
[12.] Log=50: i P H, X&)
[13.]values=[...] /X A4k,
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EREBI=e 2
[14.]dev: ZE0FE ZERAAR A4S 41 5
[15.)mod: FEZEHRISET)E N T 2R,
[16.] param: A#EZH 4,
[17.) freq (Hz): FIFMAb s thm TAEMR .

RE&H S5
[18.]readns: &4 DC ML RS

WS4

[19.] oppoint = no: EETEE TAEM, WARFTE, N Y FIR 2 . o] 58 19 HUE
1% no, screen, logfile, & rawfile.

[20.] zeroonly = no WIHBEE TR, HALE 0. WHLMEAHS no B yes.

[21.] fmax (Hz): e KAZAR A EBR SR JE R s ol % i XA S HUE R psf H % Tt 3E
i th B

[22.] docancel=yes: REEIATEN DI E . If set, pole-zero cancellation is requested. AJ
AefE A yes X no. .

[23.] absdiff=1e—6 Hz: ZAR s HKIH (4ot 22 (0 R

[24.] reldiff=le—4: A R AR LR TR

N

WS HE:

[25.] prevoppoint = no: AFH b—kp AT TAER, A EEEIIEEE yes F no

[26.]restart = yes: WA, B EFEFIE DC TIEA; WIRIE no, TH]
WK DC TAE S . AIREIEIELES yes Fl no

FRES:
[27.] stats = no: HTHIGETE, FTREE A yes Al no
[28.] annotate = sweep: AriEI, PIHE(EA no, title, sweep, status, 5 steps.
[29] title: ZpHr4

Examples:
1. mypz pz
- HSATH S #2344k mypz
2. mypz2 (nl n2) pz iprobe=VIN
- BATER AT, AR VIN, H 2 nl, n2 BE(E.
- TR IR
3. mypz3 (nl n2) pz iprobe=I1
- WA 11, HaHi oy nl R n2 2R
- W IR
4. mypz4 pz iprobe=VIN oprobe=IP1 porti=1
- BN VIN, frich IPL BRgraiR, b IP1 &2 —A iprobe.
- R IR
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5. mypzb pz iprobe=VIN oprobe=V3 porti=1
- By VIN, i s YR V3 R A
- IR IR
6. mypz6 pz iprobe=VIN oprobe=R3 portv=1
- BN VIN, b o s pH R3 B R
- R IR
7. mypz7 (nl n2) pz iprobe=I1 param=temp start=25 stop=100 step=25
- RO L, YOy 257100°C, At 25°C
8. parameters rval=2.0

R2 3 4 resistor r=rval

sweepl sweep param=rval start=1 stop=10 step=1 {
mypz8 (nl n2) iprobe=VIN
}
- WM B E rval, TEH 1710, BN 1.
9. mypz9 (nl n2) pz iprobe=VIN docancel=no
- AT AR

TER “porti” SLVFFH /e P8 AN KR E “oprobe” i A F I LI o AHIR AN B R ZILL e (15 £
R 2 AR B o DR T 3 S TRVE  ““porti™ 24 JT 1 L I Ul HL AL I 8, By L A i s
5E I SLHE o

Wl A&
“output.log” SCAFHALE LUME A
o PR A

o RTIEFR
o TR

o TIREQ, WTRLE XN
\05

o imye
Ofactor = rsrgn]ﬂ.ﬁ[[r—eJ + LJ

HAdn R E# real<0 M sign=1; HE real>0 M sign=—1; WFE real=0, M sign=0; LIF
a2 BLP AL S S A T AP A, T R I — AN ANBR e IO FL B o B2 A 5 T2 I _EsskRHP 725
AN

skeskskrskskskerskskersksksksksk

PZ Analysis ’mypz’

skeksesiskskskskskeskeskekeiskskoksk
Poles (Hertz)
Real Imaginary Qfactor
1 4.5694e+10 0 **RHP -0.5
2 4.2613e+10 0 **RHP -0.5
3 1. 4969e+10 0 **RHP -0.5
4 1. 4925e+10 0 **RHP -0.5
5 1.0167e+10 0 **RHP -0.5
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© o0 N O

10

1.0165e+10
7.3469e+09
7.3469e+09
—-1.0061e+09
—-1.0061e+09
—-1. 0235e+09

SO O O O O O
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B E BENREST

7.1 ThEEREARNZ

W 75 RS LS AE FLR LA R BHE e i, VS s R e P B o A SR Bt AR T
FLB R A S, S A 0 B AT ATH A% R ORI AN S B W 75 o T30k, RS 5 AN TR AT TG
(4, AR AT DLV SFA 550 M 7 AR 00 M 7 0T A2 10 i 4 i PR A P 7 PR AN LA r A B g W 75
B CL AR AR GBI P o PR P F AW P 00T e 75 1) DR BB 2 TR I B R

W 75 0 M AT A G AW 75 0 BT AT R S (105 7 234

7.2 RGEMRESTRSELE

FIFF “Noise Analysis” & H 0] LUF RIJEA R ERLLT “AC Analysis”, WKl 7.1 i, (EhE
AT RIRE AT DI “Frequency”. “Design Variable”. “ Temperature”. “Component Parameter”.
“Model Parameter” S5 844 . RSN BERN “AC Analysis” A w2 —F. 18
“Output Noise” H1 “Input Noise” L5554y HH W 7515 mURT A R0 N e A5 o 7 SC A% R vl 450 AU e )t
Sy i S A, PR H i M A B DG 5 5 R AR T A AU AN

Moise Analysis
Sweep Variahle

% Frequency
Design VYariable
Temperature
Component Parameter
Model Parameter

Sweep Range

# Start-Stop

Start |0.01 Stop 1
Center- Span

sSweep Type
Automatic

fuld Specific Points

Output Moise

probe Output Probe Instance | /R Select

Input Noise
port Input Port Source [/PORTD Select
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B 7.1 “Noise Analysis” ¥ & 0

“Output Noise”: WIFTHTIA, PiEA&TFE RS B SE . Bk, SR Es
WE X4 A (Node) BRBCE i ARET #5F (Probe component). 4%+ “voltage”
Jr A sy, Rl “Select” JEofih LS, s (net) BPAT o & 4w sle WR
@2 i, “Positive Output Node” FlI “Positive Output Node” ¢ & A 7= 77 4 i
Uity AT o T 201 SR HL % O PR RS “ Positive Output Node ” ¥ & A % Hi Bty , 1717 “ Negative
Output Node” ¥ E gk, Wikt &2— A kE, ol LUEF— A HF (resistor)
B — AN 1 Cport ) VE Ay HE R o 1 21 SR A HY R FEL U o, TE R vsource ”ER A2 iprobe ”
VEA SRS . MR B8 T O LU AR 1] 7.2 iR

HR: XEM “port”, “vsource”, “iprobe” HBIELEILIFE “analogLib” HikEFE, Wil

7.3 FioRe

Output Moise .
Positive Output Mode | /VOUT Select
voltage
Negative Output Hode | /3nd!] Select
Output Hoise
probe Output Probe Instance | /R Select

B 7.2 “Output Noise” ¥ 0¥ E

~ T.v.z e ; PORTE
1 :

e AN
\‘k A N ,'ﬁ' /’ ‘E)
N ——

] G

Kl 7.3 JofFEE “analogLib” [

®  “Input Noise”: MFRZIMHHASHEFR, M) FHEEIL “Input Port Source” fif &
R ANME YR, Ok, HAHEYE (vsource), HLUMYE Cisource) B A& iy
[T Cport) AEfE FHIRAMEE M AR PR o VERD, XX LK H i M 75 S5 20 3 A i AU 1Y)
P b, MHEAVRA S R TR . 988, H P ] DO B M B2 A M, L
—Aui I (port), S AMEFS ARG T H AR AR S IR A R4 (F 803 NF). #i4fls IEEE
X R A S, A ANEREE N S SR B RIS S (no excess noise) I HL & S R
PR EE 16.85C (290KD . EIXHL, 45 HiA7 OCME A (TS A =K
IRN = sqrt(No*/G?)
F = (No’-NI*)/Ns?
XHL, No= g/
Ns = B NAF 5 U5 16 3 fi o (14 e P
NI = S8 i o 1 e P
IRN = i NS H
G= ik
F= W RS
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NF = 1010g10F

® Bl e A Rt A X AT LA BRSO A A, e 7.4 s

Yaoul

B 7.4 FRURGBOK B B LBl

FEWE I “Noise Analysis” i S HUq, iE4 ] LLlEIL “Result Browser” W %%
e R, HlfE “Frequency” FAHES, AT LLEIE P IE 7 205 BT R ik & B ik, &
v n] DOl g SCA T SAE ] “Noise Summary” SKIREUAT ST NS WS, F KM S 234
S5 E. st “Analog Design Enviroment” = “Results” > “Noise Summary” £ H U1K
7.5 ot 77 B

( Noise' Summary 1
oK ‘ Can-::el‘ Apply | Help‘

Data is from noise analysis

Type 4 spotnoise . integrated noise noise unit V2 =

Frequency Spot (Hz) I 1K

FILTER

Include All Types b33
resistor
Include Honhe

include instances | Select Clear
exclude instances | Select Clear

TRUMCATE & SORT

TRTIEENE by number = | top |3

sort by W noise contibutors _ | composite noise | device name

B 7.5 B 7 ke

B SR AT
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®  “Type”: il5ME:RA7
B “spotnoise”: £ A AR R o X SEPR R D) FR A
B “integrated noise”: FAEL P I AT BCE (R4 fG 45 M A RS o XSS
HH Y PN RS DR A . A R R A SRS A Y
B “noise unit”: MR (RN LR R A V7 BUR IR A V7,
®  “Frequency Spot (Hz)”: TFHME A AR N, BRAME LUE 1KHz. A4 HiX
R ) D 2R 2
B “From (Hz)”, “To (Hz)”: SR MHEH .
B “weighting”: JT 15 75 20T R LM KRR O3 it 1A
& “flat”: {EIEANBHT NI ARY
€ “from weight file”: A A )8 SORHAIUHT A ()M A R O3
®  “Filter”: /" n] LLEFENEMILS A d A e AR RS o AEZIR i T ikt 4%
s
B “include All Types”: HaEREFIRFMITAH
B “include None”: J %13 i 47 i H MR o
B “include instances”: 1t AUFE AR A A AR
& “Select”: LPrEF
& “Clear”: fHERa1F
B “exclude instances”: ¥t AR R A4
®  “Truncate & Sort”:
B “truncate”: FRHEBEASAAF I RN, BRAIFEME S 41 o SN2
& “none”: JTAaFHEAIH
€ “by number”: MRS AFOTERM A O/ NFES,  BREIS RS2
€ “Dy relative threshold”: 1 vk B i 8 i i e 7 e 71 20 L s AR 2 o
€  “Dy absolute threshold”: K i ik B 75 i ixh JEAN 28 0 £ 1 #8441 o
B “Sortby”: BE M DTHERME S R/ N BT 23 44 BRI 7 BRI 2535 S 7R 1)
Y o
i R il 7.4 s

Resulis Display Window

Window Expressions Info Help | 21
Device Param Moise Contribution % 0f Total —
AH0 id 4 02501e-19 Q5. 81 J
FH1 id 1. 28404e-20 3.09

FR0 rrn 4 36eTEe-20 011

Spot Woise Summary (in V2/Hz) at 1K Hz Sorted By Nolse Contributors
Total Output HNoise = 4. 15T78e-10

Totzal Input Referred Noise = 3. 20197e-14

The shove noise summary info 1s for noise data

&l 7.4 WEFE TR SIAS R
AT PLYE “Results-Direct Plot-Main Form” W& GG EH LS, WE 7.5 s, HATAT LLAE

“Function” "i%EF¢ “Output Noise” 5i# “Input Noise” KA G i b = AN S H e m, 1)
7.6 .
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K 7.6 LR

7.3 ERAERIRE SR SHIRE

79

AU [ e 7 2 A7 S LA F “ Pnoise analysis”, Bl “Periodic Noise Analysis
FUL GRS 7 2R, R e S T AR AR BN o Fr L, F e R WA S . 1K
P A DR LA B Aty — 46 ] SO ) el BB (R e AT R ARAT o R AR R, R, B R e
(R AR e P IS AR A H

{EHEAT “Pnoise analysis” {752 |, G “PSS analysis” I{/j3L. “PSS analysis” &1E
—ANRE R A TS L 1 S PR AR A e N, 1T ELAJT LI T 5 e e PR IS ) 3 #0E Ok . “PSS
analysis” P8 T HLEE I R IAYE TAE &L, XA 4 “PAC”, “PSP”, “PXF” Fll “Pnoise” XLt

107

x|
oK Cancel Help
Plotting Mode Replace
Analysis
# noise
Function
# Output Moise Input MNoise
Moise Figure Moise Factor
Transfer Function
Signal Lewvel Afsqri(Hz) 4 A2 f Hz
Modifier
4 Magnitude dBZ0
Add To Outputs Flot
= Press plot button on this form...
(=] )
Bl 7.5 M7 A
Moise Response
output noise; A%*2 f Hz
125
10,0+
& 75
—
L
o j
=504
2.5+
Nelololy — e e e et
104 104 104 107
freq (Hz)

Pnoise analysis”



i EARAE TS 55 . “PSS analysis” 75 H ¥ BRI EE FBOR S A #0mT LT AR,

SR, “Pnoise analysis” PLLEZ R “PSS analysis” & 21 0 TAE k47 getbAk, miiE
STt TR ZMEAL 5 (00 VLR 1 B S P Bl I ) AR A0 A 7= 2 T R (AR 4 o b ok, g v &Moot T
AT SR S B BT ) A T A PR e S A L S AR N

TXFE, Ao R Ayt oty FA) E ) - 38 M 7 gl LU PR T ST SRR B, [RINF, 7R 4R R 1 i
IR DA — S 42 s — AN R e T A — NI A IR S 2 AT A B BB “PSS analysis” A
“Pnoise analysis” [ HARAH .

FIFF “PSS analysis” % 1, WLUERMIE 7.7 Pros i) e Ho

Choosing Analyses —- Yirtuoso?Analog Design Environmn |
Ok | Cancel | Defaults P.pply| Help
o &I .- SENS -~ dcmatch . - sth =
Pz o Sp -envip 4 pss
. pac . pnoise . pxf - bsp
s P33 . fpac - gpnoise . -gpxf
~ psp

Periodic Steady State Analysis

Fundamental Tones

# Name Expr Yalue Signal SrcId

Ff e

Clear/Add | Delete | Update From Schematic |

Beat Frequenc
* q Y 100k Auto Calculate |

-~ Beat Period

Qutput hammonics

Humber of hanmonics | 4

Accuracy Defaults {errpreset)
_ | conservative [ll moderate | liberal

Additional Time for Stabilization {tstab)

Save Initial Transient Results (saveinit) |no | yes

Oscillator W Oscillator node | /net0118 Select
Reference node Select

Sweep |

Enabled M Options... | |




B 7.7 “PSS Analysis” ¥

® {f “Fundamental Tones” £ % “Beat Frequency” ¥ “Beat Period”, ¥ H. 15
BRAR, XA “Beat Frequency” W% A HEIT IR 17 HLIM IR 32 900K

® /£ “Output harmonics” H 4 PU /M%) “Number of harmonics”, “Select from range”, “ Array
of coefficients”, F “Array of indices”. £+ “Number of harmonics”, 4R J57E55 1 A~
AN — GG AT

® 7f “Accuracy Defaults” Fi%EF “moderate”,

® EFE “Oscillator”, FKAFANMTEAK &N iEmas Hi% . 7E “Oscillator node” 1 fiili

“Select”, 71 HLE Bt B bk £ 7% 3% FRUE IS H 9 o “ Reference node” RJ LAANIEHE,

FBRIAR) “gnd” i

XK, “PSS analysis” BB EHIEH T - FIIXS “Pnoise analysis” #AT¥E, W&l 7.8 Al
7.9 Fhos.

® {f “Sweep type” TILEFF “Relative”, XJ5FA14H “Relative Harmonic” HHEA A& 1)
7, e AR AHRE T RS Il 2 Y

® /£ “Frequency Sweep Range” Hik#¥ “Start-Stop”, AL LHFIZE 1L FIATR

® 7f “Sweep Type” HitFf “Logarithmic”, 7EHATINES “Points Per Decade”, HAH
T

® {f “Sidebands” HiE#t “Maximum sideband”, HAGIEIECE, EHBAET A 7.

® 7t “Output” HIEFE “voltage”, {EATIUMN “Positive Output Node” LI H ri i “Select”,
7 HA [ i B PR R PR R 5 LS 4 i . “ Negative Output Node” JEI ] IANESE, #*
NERAY “gnd “iii.

® £ “Input Source” "iE#H “none”.

IXFE, “Pnoise analysis” F & HL5E I T » 7E5ER T X “PSS analysis” F1 “ Pnoise analysis”
MEEZ G, Hnl LT i e T . WAREAGJERNEER, 7L “Results-> Direct
Plot->Main Form” #ATH& & .

7E “Analysis” FIEF “pss”, 7E “Function” HiEFF “Harmonic Frequency”, Hin] LTS
FIE 7.10 7 175 i T B3 R = U AT o

WA 7.11 Frosi“ Analysis” £ $“ pnoise 7, 7F “Function” H1% $% “ Phase Noise”,
s “Plot”, 5t AT LA 258 3 s (O AH A e A5 it 2, nf&] 7.12.
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Fundamental Tones

# Name Expr Value Signal Srcld

o

Clear/Add Delete Update From Schematic
Beal Frequenc z
% e ook Auto Calculate
Beat Period
Output harmonics
Humber of harmonics 5

K 7.8 “Pnoise analysis” ¥ &][1]

Accuracy Defaults (enpreset)
conservative M moderate liberal

Additional Time for Stabilization (istab)

Save Initial Transient Results {saveinit) | no yes

Oscillator B ogcillator node | /net11€ Select

Reference node Select

K 7.9 “Pnoise analysis” ¥ &[2]

Function
Voltage Current
Power Voltage Gain
Current Gain Power Gain
Transconductance Transimpedance
Compression Point IPN Curves Harmonic Frequency
Power Contours Reflection Contours E IDQD
E
4 Harmonic Frequency Power Added ETT. o 018K
Power Gain Vs Pout Comp. Vs Pout 3 32TE
4 436 1K
Hode Complex Imp. C £ac 1R

B 7.10 FEBAE S FKEBEHE
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Direct Plot Form x|

OK. | Cancel Help

Fotting Mode Replace
Analysis

pss 4 pnoise

Function
Qutput Moise Input Hoise
Moise Figure Moise Factor
MFdsh Fdsh
NFieee Fieee
# Phase Moise Transfer Function
Add To Outputs Plot

» Press plot hutton on this form...

Bl 7.10 g I B e

Phase hoise; dBcfHz, Eelative Harmanic = 1

750

rJ i
LA L]
T... T

T

1
-
v
(I:'

~-50.0

dBcfHz ) (dBcfHz)

-75.04

— 1004 . . . . .
107 10l 102 102 10 107 107 107
relative frequency (HZ)

B 7.2 BEEERE

7.4 BRREMGTRERE

BATIERT L] “PSS analysis” KA 5 HL % 1) “ Harmonic Distortion”, B K E . 1X I, “PSS
analysis” [FITEE X ) T35 BRI CE, PROMIXI S MAG S10. RATLLE 7.13 Fim4
P43 I8 TR A 5 W A ArT KA LA R L
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=\
eE
'
B
¥ [ T N
T Wiom
Wl L 7
Hfie—ba Wi on u é".‘!"““ I .
= Bo=dgop_v
. m = el
13
L ="
Nfm—n—a W e 3 oA
z .
¥ """“1 Vop
-\
=§

K 7.13 HTFBRREGENSESHE

R ZE L R I T 2SI 5, BTLAZEST JT “PSS analysis” (IR 4114 7.14, 7¢ “Fundamental
Tones” H1 & HIL T AV E LGS, RIGEANTTLLEE “Auto Calculate” Kk E “Beat
Frequency”»

Fundamental Tones

# Hame Expr Value Signal SrcId

1 1 1M Large vl

|| Large

Clearfadd Delete Update From Schematic

# Beat Frequency

i Suto Calculate
Beat Feriod

Bl 7.14 B ARENTERIERE
SRIG, Wk 7.15, {E “Output harmonics” HiEF “Number of harmonics” K15 & R 53 1

Hoim, SRJGAE “Accuracy Defaults” Hik£f “moderate”. TJIXHY, “Oscillator” IX— A 75 22
T, BN ST EE S e M. BJa, e,
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Output harmonics

Humber of harmonics 10

Accuracy Defaults (errpreset)
conservative Ml moderate liheral

Additional Time for Stabilization (tstab)

Save Initial Transient Results (saveinit) | no Yes

Oscillator

Bl 7.15 RRIER KSR E

BATEZ 5, [FFEH “Results” = “Direct Plot” > “Main Form” Ki#4T7 B 45 REE .
wE 7.16, EFAHE I “Function” JEIH LS “Voltage”, AT LR B & 77 BIEFAIH 1
IhEe. SRIGHE “Select” LI, 7351 “Net”. “Differential Nets” F1 “”7 = AL, KA
T BB 22 s HIBORAS, LAk $¢ “Differential Nets”o

Function
4 Voltage Current
Powrer Violtage Gain
Current Gain Powrer Gain
Transconductance Transimpedance
Compression Point IPH Curves
Powrer Contours Reflection Contours

Harmonic Freguency Powvser Added ETT.
Power Gain Vs Pout Comp. ¥s Pout
Mode Complex Imp.

aelect Differential Hets

Bl 7.16 RS REHHBOE 1]
WG, W 7.17 £F “Sweep” HirhiE£E “Spectrum”, “Signal Level” #%Ff “peak”, “Modifier”

VeFE “dB20”, BRI ST, W] DALE FLEK DR 3 ] b B i S A B I e L 45 R W
K 7.18 Frx.
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Sweep

& spectrum time

Signal Level # peak ms

Modifier
Magnitude Phase & dB70
Real Imaginary

B 7.17 iR RE% 2]

Feriodic Steady State Eesponse m

vifMvop Sony, pss dB2 00

25.0

0_

-25.0

-50.0

Y0 (o)

=75.0

=100

-125+ T T
0 2.5 5.0 7.5 10.0
freq (MHz)

Kl 7.18 B RE

A FEONIE SR A% v] LA o B A8 VR, (E NS SR L i, 45k e 20
9. & 7.19 &1 THINE SR M IMD1OMD 15M Ji5, iU o B BL.45

Periodic Steady State Response |I|

v ifYap Mon), pss dBZ0QVY < w (Nop Mang; pes dBEZ00 = v (fVop Son); pss dEZO0V

25.0

1] 25.0 50.0 75.0 100 125 150
freq {MHz)

B 7.19 WA SHREZUGIERRENRR
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H8E WHEIHHESE (Waveform Calculator) HJ{¥ H

8.1 “Waveform Calculator” @4}

“Waveform Calculator” /& —MRHA1HE A, A B 2% (RPN, Reverse Polish Notation)
Pt AR, it Caleulator AT LASZHLLL R Bhfg:

[1.] WJLAYE “Calculator” A& F1ERAIT =455 07 B4 H Edl (1 3Rk 1

[2.] FERAT AL R o VR HR AR AL B, WA, Wl A

[3.] A A BORAE ARt 2, I n] DUE AR AR A7 B B B AN B A7

[4.] $EAEAE A )N BORAE RN SR, 0] DB SO R A2 ) N A BT A BIAE i b .

TN EY, s T ARARE B B2 A v A TRV o G SN ST el £ X P
Mt AR AR, ESH RIS H T .
“Calculator” 1 [ T BRECER A % WAS SKILL 4, BAK AN 1] LLZ2“OCEAN Reference”.

8.1.1 “Calculator” FRENH

Kl 8.1 $ilH T “Calculator” FLTH 8> DX I A 2048 1) T BE

e AT M HLES P gk ML R " e
R BB kR FHGR AT PRAL PRHCL B

Caleculator

Wlpﬂl_mr_ __nnls Memofies Const Options Help
IR AL ——F no data set .
R ("wan | |
— B TFamily v/ Select Modely) vt O it |
7 A I | E
_ I X | |

W T o7 7 — d 1 1/x average | dB10 ¢
BBy A ¥l ww | 10%*x bir dB20 ft
A R - Clear | undo || Eval | |Rn bandwicth dBm g
abs clip delay a

| @ || eex | cist || Enter| lacos compression deriv g

acosh compressionyRI dft g

| 0 O T b convohe dftbb g

[ = || 4 || 5 || 6 | [zsinh tos exp i)

gg@ g5 | atan cash eveDiagram q

- Lx L2 [ 2 L3 | l|aann cross flip g

[ Qo == e | 0|

Filter = [An ! -
> [cadence]

K 8.1 “Calculator” 5t1H X IhEE
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8.1.2 RETHE IS I =T H B

“Calculator” EARKLTH A A% B0 o 2= VS AR AR, F 6 DY RL 2 1 S AR s VR R
“Calculator” & FTIFIS, BRINE e 220 PR R ()46 J57%: 78 “Options” ik
i “Set RPN”, JUJHEANIS U 2, & 8.2 Fizm. Ak “Set RPN” MIJEALHiL.

Calculator E]E]

Window Tools Memories Const Help
no data set ¥ Set RPM |
tran
Family ¥l Select Mode[¥] vt Ciit ‘
|v
| 1fx average del0 f
| LI hd M . 10%*x% blf Bz i
| clear | undo | Eval | [rn bandwidth dBm g
ahs clip clelay a
| @ || gax || Clst || Enter | |acos Compression deriv g
acosh comprassionykl cift ]
| + ” i ” 8 ” 9 | asin COMD e dftbhb g
| - || 4 || 5 || 6 | [asinh oS Bxp q
atan cash eveliagram ad
| x || 1 || 2 || 3 | l|atann Cross flip q
L Lo || . [+ ] |4 : I
Filter AN v
> [cadence

B 8.2 iyt =R A HER T

8.1.3 My NHEE

AR “Const” FHHIRL, T BLAE TSR I0HH IABIZEAE T, WP 83 P,
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Calculator

Window Tools Memories Cunst|0pliuns Help

no data set boltzmann
charge ["dc | swept_ac [ info | noise |f |
) degPerRad ‘
Family ¥l Select Mode [« epp0d
pi |v
twoPi
l— 2 average delo fi
‘—IA“"E"" vl w2 b1f dB20 fi
| Clear | Undo | Eval | |rn banchwidth dBm g
ahs clip delay o]
| @ | eex | cist || Enter| |acos compression deriv g
acosh compressionyEl ft o]
| + ” 7 || 8 ” 9 | asin COnwnlye dfthb g
| - || 9 || 5 || 6 | [asinh s exp g
atan cash eveliagram o]
| X || 1 || 2 || 3 | atanh cross flip q
N | TN I
Filter b= Al |

> [cadence
& 8.3 M NHEBMEE

TR L H L4 -

botzmann: /K 2% 2 AL
charge: HL07 HELfif
degPerRad: ff B3N L
epp0: FLZEAHLH AL

pi: [FJZ

twopi: PR JE #
sqrt2: 5 2

XTI, FESRAF AN B AR I BLAE ORI 5o X T3 2, W R 2R
HOPSENHER T, T E R AR “ Clear” 4 4 BT 2247 AN BH

HE: Calculator H HFRIAR T EH M IERKEENEAN . HIIIZE Calculator RIERXH, “2k”
A “2p” FTARFIE “2Kkilo” (20000 F1 “2 pico” (2 e-12). WMRFXEXRBAE “2 /% p”
W, WEREERZERTIE—TRHFRBAN “2%p”. WEE “2p” EHEHER M ELHFEH
FREE, Bl “2pfsfeg”, MARXNRERBIUNBIAE “2p”7, MASIRIBLAE R, (B
ERRBZTBPEFETE. Hlin “2psdfs23vsdf”, 4 Calculator R —ANEEEE IR
BRIt 76 {3 F 160 ) 2R 85 40 “ pil” B INHIR 75 BURR MR 0“4 £5 1R A 3R 7 R RN A “4*pi”,
T “4pi” BIAE “4p”, Bf 4 e-12.

8.1.4 W ERIER

] PUE I PA R 77, 4 Calculator i 8 P .
4 Command Interactive Window (CIW) % HHEEN
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hiSetBindKey( “encap” “<Key>x" “calCalculatorFormCB()”)

HITRT T B i B AR L AR “x 7

8.1.5 FFJ8 Calculator

A LA UYFh 770 LAFT FF Calculator
® /I “Waveform” & 18 “Simulation” & A IEFE “Tools” > “Calculator”, WK 8.4

GIOT

: Har 2 14:32:57 2007 [5]

Cadance Optimizer schematic

File Edit Graph Axis Trace Marker Zoom Tools| Help
S [F & [{ Browser... |
Calculator...
Expres s m

Egain

Y0 (clB)

10° 10° 107

[cadence

109 10l 10° 10° 10
fred iHz)

[

& 8.4 M “Tools” HFTFF “Calculator”
® £ CIW & HHIEF “Tools” = “Analog Environment” = “Calculator”, W& 8.5 Fir,

JFJE “Caculator”.
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icfh — Log: fhome.fireworks/wangy/CDS. log EJE|E|

File Tools | Options Help | 1

Conversion Tool Box...

"
ziﬁﬁl Library Manager...

readi Library Path Editor...
Verilog Integration
VHDL Tool Box...
Synopsys Integration...
Router
Constraint Manager...
Mixed Signal Enviromment

Analog Environment simulation...

ViR Calculator...
Technology File Manager...

Display Resource Manager...

Results Browser...

Wavefor...
CDF
AMS
Camera
SKILL Development...
... successful |
mouse Lo schSingleSelectPt() M: schHiMousePopUp () R: (sewvStartSession)

= Select nets for the VT expression...

& 8.5 M “Tools” > “Analog Environment” - “Calculator” /3 “Caculator”

® 7 “Analog Design Environment” % I1Hi%$¢ “Tools” = “Calculator”, 41K 8.6 flizx

Yirtuozo?Analog De=zign Environment (1) [’__][E|§|
Status: Ready T=27 C Simulator: spectre 3
session Setup Analyses Varables Outputs Simulation Results Tools Help
. Parametric Analysis ...
Design fnalyses
Comers ...
# A 8o o oo ne oo
Library Cadance Type ORI Monte CaHo ...
Optimization ...
Cell DP timizer 1 ac 1 10H Auto.
RF
View  schematic Calculator ...
i i Results Browser ...
Design Yariables Outputs
Waveform ...
#  Hame Value #  NWame/Signal/Expr W#alue  F Results Display ...
1 : Job Monitor ...
Cap 1n 1 gain wave v
2 WHN 1u
3 VG a ﬁ
4  VID 5
5 res 1K
E LN 1u

Plotting mode: Replace l
= Results in fhome.fireworkswangy fsimulationfOptimizerfspectrefschematic

& 8.6 M “Analog Design Environment” - “Tools” Ff/8 “Calculator”
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8.1.6 %A Calculator

&P “window” > “close”, HIT[,

8.2 IEFERUE

1t Calculator 54 PUF 4 A Zk 1177 10

® mnhEEA, %M SKILL 5 Hlvu AL g A7 hi AR I8

® ik A PR A B, R PR L PR IR ORI AT SR AR DG 5
® )\ “Waveform” & H 1 RAFEH

® {{i/f] “Results Browser” M7 545 B4t SO kA Bodls o

8.2.1 %8 SKILL & S M HBEEZFHIMARIAR

AN ZS W, Cadence SCRYH ¥ SKILL #5535 o 1% B AT X A7 5.

8.2.2 (i AL B B ARIA A H R, oy R B BT S R 1 AT
RIGAH B

HL B P T s B, T DG I A PR T b ety AR B, IR A AT WA R IR SR A7 v A
K. B 8.7 o TH A “Caleulator” Hh# Y AR i s B RAA 2B . 38 8.1 AN R
B AL BRI i 2

FE: XERROC2RRBHERUHTT L. FIMEST THRSHRE (tran) 5, FEMNBE
B IR S R R B, MIZE R B RE LR M “tran” WE (WA 8.7 P15
) BiEFE “vt”?, RIGTEFREREPIERANGT R, MRS . mRERE T I W P R,
Bl “ac” Iy “vi”, HHERAHATZR(ac)FE, 2 “Calculator” KiReE, HLERE
Bodfe o DHBLAE (8 oL R BRI I, B AT LR AL IR I i+ E 2
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tran

vt Ot

aC

vf OVOf

dc
v vde ) idc

swept_dc
ivs (s

info

i op 3 opt O var O mp

noise

rvn

& 8.7 H I “Calculator” T i) i B B Rk e bt

2% 8.1 A r I PR A AL SR ) B 8 Y

vt M A LT R s iv Mok A )7 v 1 LA
v AT R s if ALY 1 L IAL

vdc HATAF R SR fide FLU A R H
Vs JER/ESE RPN Vi is JENEREHE RN
op B TAE A opt WA TAE R

var WA mp W 240

vn I 75 P s

W PN O78, R r it Pl ek e B A v i ] SR A 7 X A

1) frR¥F “Select Mode” AbTFiEHUIRZS;

2) EREEER BRI b, JF R, AR R TR

3) AEHEET, RGP HER.
WA TIERE bR RIB A2 AN BIEN S, A — NS A &S SEN &
B, R PR R EN S

4y SEMBAESATLE, FEr K EE D ORFFEOE RS T, s “Ese” B, B A SRR
2o

8.2.2.1 TEHEEEEFERRHSHK

LN RESMEH “op”, “opt”, “mp”, “vn” B “var” KIREEE, IF HAESRIE
ZHTLIREAT — O AR
1) FEsid “op”, “opt”, “mp”, “vn” BiFE “var” HEIFRIE AP TE G, “Select
an instance” % 9L, il 8.8 Fir.



Select an instance

OK | Cancel Help
I st o I

&l 8.8 “Select an instance” &

2)  {EHLER BT ERE RIS, Bln—A A “MO” 1 MOS 4, midiizdstlia, K 8.8
P AR “ OP parameter for MO” (IR FE S — 2D HIE R IE “op” $25E), Wik 8.9
7R

OF parameterz for KO

Kl 8.9 &#FE M0 FEHED

3) fE “List” FH g o T GEMEES40 Wik 8.10 . fEi% R Rk
BHIZH, Bl MOS B S “gm”
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List chh

ids ron
=4 id
Ixa0 is
vijs ibulk
vids x5
vhs 1z6
vth pwsr
Iv9 gmoverid
vidsat w36
IvZb w37
Ivi0 w36
gm Ix18
gds 1x19
gmhbs I=20
hetaeff [Ix21
cjd 122
cjs 1223
%12 %26
Ix14 Ix29
%16 %32
=24 %33
%26 =34
coyg 17
cod =8
cgs =9
cgh il
cdy i3
cid i4
cds Ix10
cdhb Ix11
csiy =1
csd =2
CSS 1%3
csh region
chy reversed
chd type
chs

K 8.10 S-S HEFH

4) K 8.9 HHHI “OK” J&, %SHWE “Calculator” 3KHL, FEEZAFH B, WK
8.11 iz
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Calculator

Window Tools Memories Const Options Help
Shomefireworks /wangy / simulation/ Optimizer/ spectre/ schematic, psf
[tran ["ac | dc [ swept.dc [ info [ noise [if |
Family [/ Select Mode [¥] ™ op O opt O var O mp |
OPC/MO™,"gm™ | -
| 1/x% average dEL0 f
| ATTENG hd o B 10%*x hif dB20 f
| Clear | undo || Eval | |Rn banchwidth dBm g
ahs clip delay q
| @ | eex || cist | Enter| |acos compression deriv g
acnosh compressionykl dft q
| + || 7 ” 8 || 9 | asin Comwn e dfthk g
| _ || 4 || 5 || 6 | [asinh cos exp g
atan cosh eveDiagram q
x atanh Cross flip o
| [ =T
e o J . -] HIE 3: >
- -
nm%&|m |
> cadence

A 8.11 M0 B/ “gm” SEAFIHAE “Caculator” F

8.2.2.2 HEFFHE KB IR

AL BLT U5 VA A H s P s R R B . DA AN, sl 8.12 B
® RGN RIHL s AR RS RIE L
® A IR s R B 1, AT SR AR I s R L

s A BT IR Mk TR —
%Dﬁ%%ﬁ%ﬁ-——j F——ﬁ%ﬁ%ﬁ%%ﬁ
JUREA R 1 AT R L s
f ANE R A
TFATRIEL

Bl 8.12 UK s SR R

8.2.3 £ “Waveform” & Oi%+F% 2k

LR “Select Mode ” &b T-1& H R A5, 7F “Waveform” % P 3E £ 0T 75 B0 il 26 . £F “ Calculator”
A RIE T “Waveform” % H USRI ZG bR SRR 20, anfs] 8.13 & FEGHRIR
AFHEIRE “graph-1.trace():gain”.
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Cadance Optimizer schematic : Mar 5§ 09:40:25 2007 [9]

File Edit Graph Axis Trace Marker Zoom Tools Help

S (i i) v |
Expressions m
Elgain
200

=400

=00

Y1) (dB)

=S50,

=10

-120
107 101 102 102 104 107 10° 107
frag (Hz)

> graph-1.traced:gain |cadence
K 8.13 MO &) “gm” KIS AL #h Lk

HIE, PRI RIE A — NIRRT AR, AHERE “Calculator” ftfl, KL RS HshE
7 SKILL Rk LRk rh I . & “Calculator” $3HFRIE X WK 8.14 s,

Calculator E@E

Window Tools MkMemories Const Options Help
fhome.fireworks /wangy/simulation/ Optimizer/ spectre;/ schematic/ psf
rtran rac rdc rswem_dc rinfu rnuise it |
Family v Select Mode[v] vl ®if ‘
|wa\fe_130 |'|
l— 1y average delo fi
Append hd ket 10%*y bi1f dBZ20 fr
| Clear | Undo | Eval | |rn banchwidth dBm g
ahs clip delay o]
| @ | eex | cist || Enter| |acos compression deriv g
acosh compressionyEl ft o]
| + ” 7 || 8 ” 9 | asin Conalye dfthb g
| - || 9 || 5 || 6 | [asinh s exp g
atan cash eveliagram o]
| x || 1 || 2 || 3 | latank Cross flip q
[N N P TN I
Filter i;i Al |
= [cadence

Kl 8.14 “Calculator” FREBHIFTIE
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® (AW IER—ARBEIE MZE

MIATME ] “Corner Analysis” B{# “Parametric Analysis” B, 7E ADE & 1+ 52 S H
LB EXTR T4 thgk o A M SR LEMABE R AR EEH XN FlnEA1ET T
—{R “Parametric Analysis”, MRIGEAFFIHEIAE (res) K1 T —4lihzk, W&l 8.15 Prr.

Cadance Optimizer schematic : Mar £ 15:01:24 2007 [9] E@E

File Edit Graph Axis Trace Marker Zoom Tools Help
SHEE FHH [+|Label | |
Expressions m

Elres="100"gain EMres="225".gain EAres="550";gain EE@res="775".gain
Eres="1K" gain

¥ (dB)

100 10! 102 102 104 10° 10° 107
freq (Hz)

F |cadence|
Kl 8.15 ZEAN[H] s BEAE T 75 2 1 2 2%

AT L Tk, R — A R — A i 3R 2] “ Caleulator” .
1) {E “Calculator” FHLH “Family” I, @Il 8.16 fiw.
2)  fREF “Select Mode” #EH, £ “Waveform” % 1 IEFETHE A ML, “Calculator” ffi3k
M2k )5 i 8.16 Frow.
Calculator g@@

Window Tools Memories Const Options Help
fhome.fireworks, wangy/ simulation/ Optimizer/spectre, schematic/ psf

tran | ac | dc | swept_dc rinfu rnuise if |

Family [ Select Mode [v] O vf @ if

wave_150

[=]

,7 1jx average de1o f
Avpend = e Loy blf de20 f
| clear | undo || Eval | |Rn handwidth dEm g
abs clip delay g

| @ || eex || cist || Enter| |acos cornpression deriv g
acosh compressiony Rl cift g

| i3 || 7 || il “ 9 | asin comvohe dftbb g
_ asinh cos EXp g

| ” 3 ” 2 “ 6 | atan cash eyvaDiagram g
Lox [ 2 [ 2 | 3 | l|aan cross flip g
| o | [ETERRREL C

Filter [an

|> [cadence
K 8.16 & 8.15 HHI—& MLk HHIRE] “Calculator” H

ol
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8.2.4 f#iFH “Results Browser” M5 E 45 5550 S04 h 3R E 53R

HARNZE W 4 T “Result Browser” I .

8.3 LHIBRER

“Calculator” Z2A7 P L AAE, v DMEH — AN BL AR SR AR AR, DA B 214 1)
TE R oK o 12 AR B2 0 R BRI LW B T e K. B, A EARsAT T — IRl
H, FHINSGE R, FfEEE “1~100k Hz”, H#GPHEE “1 Hz”, 2 EIE R AL bRl ek
BRI G5B LL “Hz” VEN AL, JalEDE “1~100k Hz”, PR/NARER f B g5 T IR TRIR A “1
Hz”.,

“Calculator” ANEEEHKAF it 2% T IR W o, 75 ZORF X Lok 0 M AF it 45 Hh 32 L
BN A R R R IR P AN B 73 0 2 B G2 A7 1R il sCH BRI RSO I TE AR

B, ik IR LA ) 7 3 s
KRR AR 1 R R

8.3.1 £ilzRIA

PEL NG PRI AT, 5 TR R T 3o AR BRI LB 5 A TR, HIK
PRI BOE A D7 3 MR 8.17 Prax. NS A AN RN ThRE, WAk 8.2 PR,

Calculator |Zl |E| b__q

Window Tools Memories Const Options Help

fhome.fireworks  wangy / simulation/ Optimizer/spectre/ schematic/ psf

[‘wan [ ac [ de [ sweptdc [ info [ noise [ |

Family [ Select Mode[v] i wf Cif ‘

AIsDir " homefireworks  wangy, simulation/ Optimizer/ spectre/ schematic/ psf fresult "ac- ac")| -

Replace  v| | = ‘ 1/% awverage dBlo fi

— 10 % b1f Bz fi

[Append o | Eval Rn banduwidth dBm g

|Replace ahs clip clelay g

(NEWSUhWiH ( )] acos COM@ression derjy g

N ew Win H—— acosh compressionyrl ft 0

( S | [ .. | 9 | asin conwolve dfthb g

| _ || 4 || 5 || 6 | asinh cos BHp q

atan cash eveliagram o]

| x || 1 || 2 || 3 | l|atann cross flip a

0 . [+ I >
- v

Filter Al -

> [cadence|
K 8.17 “calculator” Wik ELHIRIERK FHSEHE
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F 8.2 “calculator” i sE LR HIRIER K T H A B IR RE
Append TE SR B 25 T o8 s E .

Replace T B JFOR I & R s, BB O .

New SubWin |[{E ORI E 1, JAZ T8 1, HIR B8 RIBIE .
New Win BB O SR T

LER PR B 0 73R, it <A b B T 2 7 o i et s 2 D W B 1o

INe B, FEIBAT AT EIE CRARREREVE WLER 5 55), Won— N ILIER SO 88 AR R
1) fF “Calculator” LK EIZRIAXIZEE P IERE “ac” TUH R “vi7,
2)  SRJETERE 5.3 rh Sl YR AR SO S I i o
3) {E “Calculator” MIZAFH3RAFIZTT M FIHLRFRIA “VF(VOUT)”, Wik 8.18 in.

Calculator |Z| |E| El

Window Tools Memories Const Options Help
fhome.fireworks, wangy/ simulation; Optimizer/ spectre/ schematic/ psf
Ctran | ac [ de | sweptdc [ info | noise | if |
Family [ Select Mode[w] @ vf O if ‘
VECTVOUT) |~
,-7 ‘ 1% average dBlo i
‘ Wew Win hd el = L1o**y b1f dB20 fl
| clear || undo | Eval | [Rn bandwicith dBm g
abs clip delay g
| @ || eex || Cist || Enter| acas compression deriv 0
acazh campressiony Rl cift d
| s || 7 || 8 H 9| asin comwalve dftht g
| - || 4 || 5 || 6 | |[asinh cos exXp g
atan cosh evelDiagram d
Lx 1 [ 2 || 3] laam cross flip g
e o g w-] B : IC
Filter V|

> |cadence|

K 8.18 7E “Calculator” HIEZHFHIREE 5.3 T ICYHB KIS M4 H 7 A KB ERIER
“VF(/VOUT)

4)  EPIGE OO R R RS “New Win”, ik <7 sbb)5, /B
H, BRI GBOR ds O SRR . T 8.19 P
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raph Window |6 e imiffr o]

File Edit Graph Axis Trace Marker Zoom Tools Help

& o] # [Fi & [ |Label | |
AC Analysis “ac’ freq = (10 mHz -> 10 MHZz) m
= ouT
—20.0

-40.0

-60.0

-100

-120

-140
1072 107t 1% 10l 10?2 107 10 100 10° 107
freq (Hz)
s[> graph selected. double—click ta bring up atiribute dialog. |[cadence|

Kl 8.19 JLyEHUORE: (B5.3) M7 A 25 S R i

8.3.2 LIStAmEERMHE “Calculator” ZfEHRIERFME

s “EL Jikl, Al “Caleulator” ZEA7 P A LA R I U

sy “ELY S, “Display Results” % LR, 1l 8.20 FizR. siddi “OK” JE& e
“Display Results” & I FH R, EREPERKE  “Calculator” 2247 R IA X ME LAY 2R 1B X HE
“Results Display Window” & i, il 8.21 izn. R UK LML S it 7251 &

W,

Display Eesults

Data ® Yalue ! Point i Ran.

| Ok || Apply || Cancel ‘

K 8.20 “Display Results” P& % M

® ii{t “Data” L “Value”, WIFIR¥ “Calculator” 227 i a&IA AL x-y ALFRHN I Py
AIEAR W . St g R an &l 8.21 Pow.
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Rezults Display ¥Window g@

Window Expressions Info Help ‘ 23
freq (Hez) YE (" /0UT") (W) —
1 T3, 231967 0n
1.3803842 T3. 2306620n
1. 9054607 T3. 2281754n
2. 6302679 73.2234381m
3. 6307805 T3.2144138n
5.0118723 T3, 197227 6m
£. 9183097 T3. 164513Em
0.5429258 73.1022092n
13. 1825673 T2.9841903n
18, 1870085 T2, Te07142n
25. 1188643 72.340511m
34, 6736850 T1. 553584 Tn
47 8630092 70.1330162m
BE. DEA3448 £7. B511649m
91. 2010839 £3. BEZR0259m
125 8925411 57.4682066m
173.7800828 49, 4997168m
239.8832919 40. 5274 346m —
331.1311214 31. 7614581m
457. 0881896 24.1119542m
£30. 3573444 17. 9356324n
870. 3635899 13.1824421m
1. 2022644K 0. B242157m
1. 6EAEBESK 7. 0003152
2. Z290B6T6K 5.0827632m
3. 1622TTEK 3. 6BE3ET0n
4. 3651583K 2. 67213940
. 1255058K 1. 9364065m
8. 317637TK 1.4030356m
11, 4815362K 1. 0164981n
15, 84893198 T36. 4214994y
21.BTTELEZEK 533.5030338u

& 8.21 “Calculator” A7 RENME x-y inhh LA KIEK BN

® N7E “Data” HIEFE “Point”, HB4 “Display Results” T 448 il & 8.22 I

Dizplay Eesults |Z”Elfg|

Data O Value ® Point O Ran..

X Intercept|1o

Start/End| | |

StepfScalel:I ] Log

| 0Ok H Apply || Cancel |

Bl 8.22 HEFF x R R EHI(EA

“X Intercept” FHEIHIE, “Calculator” H4 B RGA7HFRIA A XA TN B AR KR s _E 1
e H. Biltn, fEkl 8.22 HIEAMZ “107, Hith 45 Rl 8.23 s

Rezults Display ¥indow

Vindow Expressions Info Help | 23

iE

VE("/0UT") at 10 = 73.085628767151n
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& 8.23 x=10 {1 “VF” {&

HEE: MR “Xintercept” EHIEARMEAREHFEGEN, 2 “Calculator” W4 H M EH4H
EEW, BEEEREBERALN R ERRERE. Fl, AfEEER “1~100”7, £ “X
Intercept” F=HIEAN “110”7, W] “Calculator” #iHHI{ER “expr (100)”,

® i{F “Data” "iEFt “Range”,  “Display Results” % AR K 8.24 K. LLHS
“Start/End”. “Step/Scale” Fll “Log” % LG . 7 “Start/End” "IN ASFREH L 1F)
AR R R &5 A S, AT R i Y

Dasplay Eesults

Data ! Value i) Point ® Range

Start/End|10 ||1000 |

Step/Scale|1| [l Log

| Ok || Apply || Cancel |

K 8.24 I8 “Range” W/ “Display Results” &
B R “Log” #¥cAiEY, B4 “Step/Scale” HIANKIZ IR, “Calculator” Hf

AP E RO EEE, A “Start/End” TPRAE LA ROTES, RIKIEHE, B
PP AR i b HEIRIE] 8.24 FHIBCE, v AR WA 8.25 PR
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Results Display ¥Window E]E]

Vindow Expressions Info Help | 26
freq (Hz) VE (" /OUT") (V) jl
10 T3. 085625 Tm
11 T3. 0506495m
12 T3.0185151m
13 T2, 98922020
14 T2, 9429303m
15 T2, 89502 3%m
16 T2, 8499183m
17 T2 B0TEZT0m
18 T2, TEE15T4m
12 T2, TOSZ208m
20 T2, 63857 T0m
21 T2, 5T746740m
22 T2, 5135192m
23 T2 455119E5m
24 T2, 3994815m
25 T2 346611Tm
26 T2, 25844 71m
27 T2, 16TTEEEM
28 T2, 079693 0m
28 T1. 394247 8m
30 T1.911436Em
31 T1.8312681m
3z T1. 7E3TE14m
33 T1. 6TE8952m
34 T1. 60ETOTTm
35 T1. 5193531m
36 T1. 3976390m
3T T1.278311Em
38 T1.1613815%m
39 T1. 046862 Tm
40 TO. 334TEEEm
41 TO. 825101 7m

K 8.25 # A 8.24 ¥ & HIEHE
B U “Log” BB kT, A “Step/Scale” HHIEHEAE N “10” R EGTHE —
AMEAE A5 220, “Calculator” 5 M “Start/End” H#fE GG HFLR, DAS TR
M7 X H R, BRI AR S 1. 1 8.24 h “Log” #ikh G, &5 R

8.26 JIT71s.

Eesults Display ¥indow |T”E|[$_<|
Window Expressions Info Help | 27
freq (Hz) VE (" /OUT") (V) ]I
10 T3, 085628 Tm
100 61. 893698 Tm
1E 11. 7934 754m

Kl 8.26 % “Log” J5 %R H
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8.4 {EFFHTFiEsE (Memories)

“Caloulator” SE47 A AT BLAZ SIAE RS, 0T LIKE AR S0 B 2608 A I
I 8281 P A BT BLRAE SIS, JFMSCAP L SO EHSE “Memories” RIS
Booosz B . “ Memories 7 N fr o oMo B 827 T oam o

Calculator |Zl |E| gl

Window Tunls_ Const Options Help
fhome.fireworks| Table » mulation/Optimizer/spectre/schematic/ psf
Select »
[tran [ ac [ dec | sweptdc [ info | noise [rf |
Family [ Se| 3%~ 4 @wr Oif ‘
Save...
IshiftVF¢'f OUTY 93 |v
; ‘ amsg imag mag
‘ HEIT hd M - ap int ne_fred
| Clear || Undo | Eval | gpe_freg integ nc_gain
gpc_gain inn nf
| @ || eex | cist || Enter| aroupDelay iprvRl rifrmin
| | gt kf owershoot
+ | 7 || 8 ” 9 | quIm In phase
| - || 4 || 5 || 6 | harrmanic loglo phasetargin
harmonicFreg Ish phazeMoise
x| 2 |3 | iinteq Ishift psd
L o I . ffer | Led [»
Filter | Al |
= [cadence

K 8.27 ¥ “Memories” ¥ E

8.4.1 “Table” T3

“Memories” T[] “Table” T3 UNK] 8.28 Fi7x. {F “Table” F3Earf{u sy 5 DNSE s,
HIhgE— T
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Calculator |Z| |E| rz|

Window Tools Const Options Help
fhome.fireworks Edit kurefschematil:fpsf

SEICCL ) New Memories -\ egpggEn o moigen]

Family [ se| Load.. | Copy Ctrl-C |
Save.. Delete Ctrl-D
VFC/oUT) Undelete | =
~Memotries Editor
| Clear | undo || Eval | Mame | Expression
| VFC'/OUTY
| & || eex || Clst || Enter |
L+ 7 | 8 || 9 |
- e s || 6|
L x |2 || 2 | 3 |
[ o . s
| = || OK || Apply || Cancel || W |

= [cadence
K] 8.28 “Table” F3EHHZ

“Edit”: 4TJF “Memories Editor” % [, 41K 8.28 R, UIRAEIXZ A Al i
BHNE, [ “Edit” 3£HAEFH “New Memories” HIIfit. £F “Memories Editor” % 1
o, AT AR DA A I A AR AR A, Al “OK” B “Apply” 58U
“New Memories”: H#hPJ#t3] “Memories Editor” % I, #2457 “Calculator” 2z 47
(RZRIR AN —ASB LA I 2k X, BRI A I 4

HE: RVFWAMAEIA A R RIA, EARRA AR 2R,

“Copy”: ¥kt () CA FEAH IR AR X I BF P AAE T, FFZESRO B 2Rk
%o

“Delete”: MIBRAAEI. 78 M “OK” 5% “Apply”, WIAMIBRET, MR i A7 it AL
R RAIK, i 8.29 R, MBS A LGB “Undelete” 4 H KA

Calculator |Z| |E| fg|

Window Tools Memoties Const Options Help

fhome.fireworks/wangy, simulation/ Optimizer/spectre/schematic, psf

(wan [ ac ["ac [ swept_dc | info [ noise [rf |

Family | Select Mode [v] ® v O if |

YF( OUT™) |v
“W L | ~Memories Editor

| Clear || Undo || Eval | Marme | Expression

| @ || 38 || Clst || Emer| |

L+ [ 7 [ 8 ] 9|

L -4 5 | 6|

L x |2 Jf2 | 3|

L o . [ +r]

| /|| ok || appy | cancel || v |

I> [cadence
&1 8.29 “Delete” HIfFfH 51%kE
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8.4.2

“Undelete”: PR HMER I FFREIT. AULAEM BREA A BT 2%

“Select” FSEH

“Select” T RHA N E L CHAMGILFRNYIZR, WK 8.30 Frn. Ml it 7 4
R, AT DAz A I Rk 20 N B “ Caleulator” [FIZAFH .

Calculator

Family [_| Se

Window Tools
fhome.fireworks| Tahle »

Const Options Help

B=1ES

ulation/ Optimizer/ spectref schematic/ psf

Save..

dB20¢/FC"f OUT Y

i

~Memories Editor
‘NewWin - L= 5 ‘
| clear | Undo || Eval | Mame | Expression
Vout VEC, OUT™)
| @ | eex | cist || Enter| || qain dB20/FC/ OUTY
L+ |7 || s | 9 |
-+ | 5 |6 |
Lx J_2 [ 2 |3 |
L Jlo T o -]
|7 [ ok [ appy |[ cancer || = |

I

8.4.3

K 8.30 CA FEIMEZIKRNFIR

“Save...” TR

Save In: |IU paper

=

~| [=] (e8] [ (B8l e

1 BlAS
7 B1AS_D5

[ Cadance
3 Memories
1 NewFolder

[ 3.png

[y 4.png [y ade_wavescanlog |
D 3.png D cds.lib [
D 6.png D corner [
[y 7.pno [y corners0.log [
D 8.png D delta_v.png [
D 9.png D Fl.xa [

| »

File Name: [Teet1 |

Files of Type: | All

Files v|
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K 831 “save...” T

miili “Save...” T, “Save” T L5, 1k 831 fizr. 7E “SaveIn” FHZEHR, DL
NS P R RS E ARG 515 . F “File Name” FHHEANRAE LRI RR . SO N 4%
W SKILL 15 5 5 a2 o SN _ESCH g P N s . R X N AN -

armSetCalcMemory( "Vout™" "VF(\"/OUT\")" )
armSetCalcMemory( "gain” "dB20(VF(\"/OUT\"))" )

84.4 “Load...” T3H

il “Load...” T3¢, “Open” & L, WK 8.32 lin. R I HIEFIRATESCIE, A
i “Open” 58I

O
Look In: B paper b @ @ @ E

E‘| F31.png E‘| F9.png |__°‘| report_table_lLcsy
E‘| F41.png E‘| libManager.log |__°‘| Testl
|j| Fa.png |j| libManager.log.cdslck |j| tmpOpLlog
E‘| F3l.png E‘| mcor |__°‘| tmpOptlog.cdsick
E‘| Fol.png E‘| report_table_2.csv
|j| F¥l.png |j| report_table_3.csv
4] |
File Name: Testl |
Files of Type: |AII Files - |
| Open | | Cancel |
K 8.32 “Load...” F3RHBEHO
8.5 BRI

£ “Calculator” FATIRZ BE, PO B REA T REIOAL B, TR A TR 6.
SR PR BT AR R O], it mT LUK 24 i G A o 1R A AR N 1 R B A TR 51
HEEREH] “RPN” KLU “Caleulator”, /28485 IS s 2, M ST
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8.5.1 Taj K%Y

R 8.3 PINIX LR BOE 5 GeA7 P T — A RIS O

% 83 “Calculator” F %S ThEE

BRI % Ditig BRI % Ditig
mag IR AE exp e’
phase HBL I #4 10%%x 10"
real HY SIS x**2 X
imag YU 8 abs HY 2 06
In Y E AR 2L int Hy

logl0 PL 10 A JECHOR £ 1/x U
dB10 X Dy ek N dB 1 sqrt x'"?
dB20 X L s FL X dB

8.5.2 YERHPINRIEX I BB A BER ?

75 “RPN Biste, — 650 4ol 1 e 1) T G A R A B 0850 0 T
R IR, AR P IR AR e P RIS 250, Ak 84, /6% 84
L, ERR R RIS “stack” R, GAFRIIRIAR T “buffer” .

2 8.4 HARMEATHIRIERX

PRI Bl
yFEX stack™™
+ stack + buffer
stack - buffer
* stack * buffer
/ stack / buffer

8.5.3 =AKH

“Calculator” Ft5H =ff A% BF5 sin, asin, cos, acos, tan, atan, sinh, asinh, cosh,
acosh, tanh, atanh. IXHLANFHH 5 XL g BAE H o

8.5.4 FERR R

R IR R HON T MO A5 RA AR Bl o AEEREIC LA IR o BN, o BT 1 e o 1%
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HE, FEIF S Z R B 2RI E S, WilE 8.33 Fw. ARSI e B A 2247

Calculator |Z| |E| El

Window Tools Memories Const Options Help

ho data set
“uan [ ac e | sweptdc [ info | noise | 1t |
Family ¥  Select Mode v (® vf (0 if ‘

VEC/ OUTY |v

~bandwidth
[Append v | kdu |
| Clear || Undo || Eval | Signal|VF(",‘0LIT")| |
| @ || (104 || Clst || Enter| Dh|3 |
7 s o] | mwellw ]
- L4 s | 6 |
L x [ a2 |2 | 3 |
AN T RN

‘ < | Ok H Cancel || Apply || Defaults ” S ‘

[+ Buffer is ermpty. |( adence
& 8.33 ReERRBRE

B ik DL DB AT LR — AN H A $E N5 B A P

1) KA 8222 WAETHRERI L, KT A I IR R L A H#E 2] “Calculator” 2547
W

2)  FERREUE HH N “average” PREL

3) il “ED E R A

8.5.4.1 “average” %

“average” PR KIS BV NPT PIME . “average” 1€ XOEEJu I x X}
FiE ) HATRRY, RIGRLITER x. #ln, W% y=f(x), 4 average(y)h
T f (x)dx
rom o Hp “to” Al “from” & “ADE” " E M7 B R A A GE AR A . R Bk

to— from

FEAFRIRAPBMETE R, ATLARC & fEH] “clip” %L, TR 8.5.4.3.

8.5.4.2 “bandwidth” PR%

“bandwidth” PRETIST “Calculator” ZEA7HHRIAXFIF 6. FRE: FIARIEXDIE B
WV L AR, AL “dB20” AbH i 8E . AR B R .
1) SRH 8222 WHATYRARRI v, Kl -1 i R R IA U $2 21 “ Calculator” [RIZEAT
W
2)  TERREUE D i “ bandwidth ” BRI SR G pREET 105548 S an 1] 8.33 Fron ) “ bandwidth”
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XHHE -

Window Tools Memories Const Options Help

Calculator

no data set
(an | ac | de | swepldc info | noise | 1 |
Family ¥ Select Mode ¥l @ vf () if |
Ve N2 |'v
~bandwidth
‘Annend b L= |
| clear | undo | Eval | signal[F( /N2 |
| = || eex || Clst || Enter | Dh|3 |
=+ 7 J s | 3] Teeftow =
-l a1 s | s |
Lx 2 2 || 3 |
I R
£<< | Ok ” Cancel || Apply || Defaults || S |
2 [cadence
&l 8.33 “bandwidth” [KI3HEi&E
3) {f “bandwidth” XfiEHES:

4)
5)

®  “Signal” FHIEAMRRTH LI B EREA, Wi BIRTE, SR ERE
M “Caleulator” FIZZAEHH3RAF . ] LLIZ M SKILL THERTEHm A& 15 Rl
®  “Db” PN R LI EREE R, kA “dB” fxl.
®  “Type” FHIEA, FHUIF=AEI,
B “low”: AR HH B
B “high”: R BB R,
B “band”: VAL AR
i “OK”, 5Ex) “bandwidth” BRELTI % & .
sl “EE g AR A .

8.5.4.3 “clip” ER%L

“clip” BREUHKRIF#iE “Calculator” 247 HRIEX MM HVER . HAKBRIEDERAT .

1)

2)

KH 8.2.2.2 HETYRAI Tk, WP B R IE U #E 2] “Caleulator” [HZ247
W
FERRELE DA s “clip” BRIER. ARG BRECE T8 il 8.34 ITir] “clip” X EHAE
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Calculator

Window Tools MkMemories Const Options Help
fhome.fireworks /wangy/simulation/ Optimizer/ spectre;/ schematic/ psf

tran [ ac [ de | sweptdc [ info [ noise [if |

Family (vl Select Mode[v] ® vf (0 if ‘

VF(/ OUT) |~
~clip
‘ Append i = ‘
| Clear || LUndo || Eval | Signal|\-’F{";OUT"} |
Frnm|0 |
| = || BEx || Clst || Enter|
Tu| |
_+ JC7 |Ts "9 |
- e "5 T e |
I T
2 TN
| ey ‘ 0Ok || Cancel H Apply || Defaults || = |

[> Buffer iz empty. I( adence
K 8.34 “clip” WIEEHND

3) £ “From” Fil “To” RLrRHLH A% H TEH
HE: BUHPEERXTHEEE, BAESHPEERN, B4 “Calculator” ¥
HEAMEEN, BEILZEERAR S ERREXFME. B, S FRER f(x), h
HAMEELZ “10~100”, T “clip” HiEKFHRTEELE “1~200”. FAE “1~107
FRI 75 B P BRAE R £(10), 7E “100~2007 (5 P4 ERIME R £(100).

4)  miii “OK” SERON “clip” BRELIRE .

5y sl ke gk SR

8.5.4.4 “convolve” PER¥
“convolve” BREH RSN RIA A IER, HAEEDEWT:

1) {ERREE Db i “convolve” BREL. AR5 R DR AR A Kl 8.35 () “convolve”
XA 5
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Calculator

Window Tools Memories Const Options Help

Shomefireworks /wangy / simulation/ Optimizer/ spectre/ schematic, psf

‘wan [ ac [dc | sweptdc [ info | noise [t |

Family [v Select Mode ¥ & vf (Jif |

VECIND) -
-convolve
|Annend i L |
| Clear || IIndo || Eval | Slgna|1|VF(',fN2|) |
| @ || [T || Clst || Enter| 5ignal2|‘\-‘F(",fN2"}l |
+ | 7 | 8 o | Fom |
- e s e | To|
PR | = ;
1} . +f-
E | Qk ” Cancel ” Apply ” Defaults H = ‘

[> Buffer is empry. |cadence
Kl 8.35 “convolve” K EEF O

2) {r “Signall” Hl “Signal2” £ HIAANFEIHEHERINANRIENX . KEBIAEIX A
I YT “Caleulator” ZE/7H AN RIIL TR EHL I SKILL 5 A VE I 7521
LR35

3) fE “From” Fl “To” WHIHANLRIEH;

4y “type” HIEFEM RS IHTT, A “linear” F1 “log” PYFHIEIT;

5) il “OK” 5EE) “convolve” BRELHI W E ;

6) ik “E WS BUS

to
BRI N: [ F1(s) f2(t—s)ds . Hrhr fI()M f2(t - 57 5 {2 “Signal 17 1 “Signal 2”
from

RPN RIE I

HER: “convolve” BRETEIERI /MUK, TFIREFERKHITHER .

8.5.4.5 “cross” A%

“cross” PELTT AL T AIES n g Ry € S NBOB LT BN ) x AR AR . BACD PR AT

k.

1) KM 822 hTkd 7k, K prie B FRIA A #E 2] “ Calculator” HIZEAFH .
2) TERREUE O iy “cross” PR, AR5 RREUE FURKEAR K P 8.36 FanH “cross” X i
HE
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Calculator

Window Tools Memories Const Options Help

Shomefireworks /wangy / simulation/ Optimizer/ spectre/ schematic, psf

‘wan [ ac [dc | sweptdc [ info | noise [t |

Family [v Select Mode ¥ & vf (Jif |

VE( N2 |v
| Append - e 1 ~Threshold Crossing
| crear | undo | mal | signal VF('/N2") |
& | eex | Cst [Emer] | TSRO Value 2.5 |
[+ | 7 || 8 || 9 | EdgeNumher‘l |
- e s 6| Edgewpe“either =
L= |2 | 2 || 3|
| o | - ]+

- | Ok ” Cancel ” Apply ” Defaults H =l ‘

[> Buffer is empry. |cadence

K 8.36 “cross” RETIHE R ER N

3) fE “cross” XFUFHE:
®  “Signal” FHIEAMETFEACEEM B ERE A W BRITE, SR A
FEN “Calculator” [ZEAFH 3R 0 n] DUIZ B SKILL wE ARG H AL & 17y s
®  “Threshold Value” #%H A F) 2 BIMH
®  “Edge Number” #=HIE AR 770 i T BB 105 IR
®  “Edge Type” T4 LLF LI
[ “rising”: _EFHAT.
B “falling”: FP&EUS.
B “cither”: TFEUF W
4) i “OK”. SERKT “cross” BRI E
5) by <EE S IR T .

8.5.4.6 “delay” PR%L

ik 8.37 o, “delay” PAAUCHI “cross” PR, VI AN RIE 30 ) 2 i iy 5 RN (149 I 1)
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Woltage
Threshold

value for WE] ——#={-cccceaacaaafonnn.

Threshold
value for WF2 —=

-—
Frequency

-
®oross XCMoss2

delay = xcross2 - xcrossi

&l 8.37 THEPIANFIAK 2 T s e I B I T 2=

HAARA D BRATY

1) ERREUE D fih “delay” BREL. ARG BREE TR N Wk 8.38 AR “delay” X i
HE
Calculator |Z| |E| E|
Window Tools Memories Const Options Help
Shomefireworks /wangy / simulation/ Optimizer/ spectre/ schematic, psf
(wan | ac | ac | sweptde | info | naise [ 1 |
Family [¥/ Select Mode ] @& vf (I if |
VF(' N2 -
~delay
| Append - L) |
| Clear || Undo || Eval |
Signall [vF(' /N2") |
| @ || BEX || Clst || Enter| .
SlgnaI2|VF(",fN2") |
L+ |7 |8 || 9 |
| _ || 4 ” 5 || 6 | Threshold Value 1|2.5 |
[ x || 2 || 2 | 3 | Edge Number 1|1 |
| || 0 ” || +/- | Edge Type 1|either v|
Threshold Value 2[2.5 |
Edge Number 2|1 |
Edge Type 2| either - |
| < | Ok ” Cancel ” Apply ” Defaults H = ‘
[> Buffer is empry. |(a dence

K| 8.38 “delay” REHIKE
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2) {r “Signall” Hl “Signal2” #HIAANFEIHEHERINANRIENX . KAEBIAEIX A
I T “Calculator” ZBA7H FRIEA . LR Z4% I SKILL TR 2 HIVE N 75 21
P RIL

3) %M 8.4.5.5 UL, SERUEN RPN KIEI “cross” MR E

4) i “OK”, SERT “delay” BREUMIBE .

5) iy “ED E e

8.5.4.7 “deriv” BR¥X

“deriv” PRELH KX “Calculator” ZEA7H FIRIAA KM . 7ERREE M IEFE “deriv” BR
¥, RO A <MD f o R A S .

8.4.5.8 “gainBwProd” BF¥\

“gainBwProd” A FERB MM H AR, EEK “Caleulator” FE4 AR
SRR, FE LU 205 KRB . B0 I B 0 F 9 A5

gainBwProd (gain) = A * {2,

Horp Ag RS, 2 2 h Ny 1YY B N

8.4.5.9 “gainMargin” BR#(

“gainMargin” BREZA HH “ Calculator” Z2A7H IR I Y R IR X AHFE Ay 180 J& I (13 2 K/
(dB fi)»

8.4.5.10 “iinteg” PR

“iinteg” PRECH “Calculator” ZEA7H PRI AN X fll LA B TAN ERR 47 & T

PIAE “Waveform” & O H B IR,

8.4.5.11 “integ” PR#(

“integ” BREON “Caleulator” A7 IRIEAN x i B REHATER . R85 A2
T 2 e M Yo FL A x BT Rye . BB B r .
1) SKH 822 TRk, ¥ H ERIEX S “Calculator” LA .
2)  AERRAUE NP A “integ” PR, SRS B VKA A& 8.39 PRI “integ” X iE
HE
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Calculator |Z| |E| [5__<|

Window Tools Memories Const Options Help

fhome.fireworks /wangy / simulation/ Optimizer/spectre/ schematic/ psf

[wan [ac ["de | sweptdc ['info [ noise [rf |

Family [¥l Select Mode [¥] @ vt it ‘

VEC OUT?) |v
—Definite Integral

‘Annend - L) |
| Clear || Undo || Eval | )

Signal [V T{ /OUT") |
. @ || eex || Cist | Enter | Initial Value |0 |
L+ L7z | 8 || 9 | Final Value 1 |
- |4 | s |[ 6 |
x| 2 |8 |
e te T e

| = ‘ Ok || Cancel H Apply H Defaults || e

> Buffer is empty.

8.39 “integ” PREUIINEE

3) {F “Initial Value” FI “Final Value” "IN &R 20 (TG A1 45 Al
WE: RIRWAMELAE RN E X, sSEAE L %A B E B a R, “integ”
BRECRE B BPRE AR o3 YE TE v E  FEANE TE FL

4) Ry “OK”, 5EMk “integ” PRELINE .

5) s D RN,

8.4.5.12 “Ishift” F¥k
“Ishift” PRECH “Calculator” ZEA7H KAV G ] “Waveform” & OH, P E

7E “Ishift” XuGE ) “Delta X” &, WK 8.40 P, WEEER RN AR, {EXRN
VAR
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Calculator |Z| |E| [zl

Window Tools Memories Const Options Help

Shomefireworks/ wangy,/ simulation/ Optimizer/ spectre/ schematic,/ psf

ran

Family [¥| Select Mode [¥] ® vt it |

VFC/OUTY -
~Left Shift
[Aopena v 2@ |
| Clear || Undo || Eval | i
Signal|[vT('/OUT" |
| @ | eex | cist || Enter | Delta X0 |
[+ "7 s e |
= "= ] s | & |
N T T
L o . e |
| < | Ok || Cancel || Apply ” Defaults ” =

[= Buffer is empty.

K 8.40 “Ishift” PRZELIKIEE

8.4.5.13 B AE. B/MEEE

“Calculator” HA7 SR fg KAE A e IME I R 20 B0 XOBAT Y b L i) Kot , XS8R 800 -

“xmax”, “ xmin”, “ ymax”, “ymin”,

8.4.5.14 “overshoot” PR

“overshoot” PRHCHSTHEE “ Calculator” Z247 Hh K AIE AL piELAI T B A 1 el . fBctan
FIEAMEEN M, BERRIIRMEA T, BARLTAREN F, WA 8.41 Pizs. B4 “overshoot” bRk
R SSE

& 8.41 “overshoot” 15
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(M —F)*100
F-1

SRS B F

D) SR 822 BTN, RO AR ] “ Calculator” (927

2) EBBCA LIl “integ” BBC AR B A M 842 BRI “integ” AT
fi.

overshoot =

Calculator |Z| |E| b__q

Window Tools Memories Const Options Help

fhome.fireworks /wangy / simulation/ Optimizer/spectre/ schematic/ psf

[wan [ac ["de | sweptdc ['info [ noise [rf |

Family [¥l Select Mode [¥] @ vt it ‘

VEC OUT |"'
—overshoot

‘Annend - L) |

| Clear || Undo || Eval | Signal|\-’TfC'I0UT"}I |

L@ | eex | CIst|Enter| o) vatue Type|y |

e 7 s e A |

| = || 2 || = || . | nitial Value

| x || 1 || 5 || 3 | Final\-’alueTy,r|:u!|)(ill‘1r "|

| o o =] Final Value| |
| = ‘ Ok || Cancel H Apply H Defaults || =

[ Buffer is empty:
Kl 8.42 “integ” BRELMIBE

3) Wik “Initial/Final Value Type” FUEFERZE “y”, WHELALE “Initial/Final Value” HIHA
IR AT 5 IME
Wi “Initial/Final Value Type” HIEFEIE “x aty”, WEBAE “Initial/Final Value”
NN X RARPRE, R bR Bk B 575 (I TR . R4 B SR X Rl et
S AT y {H

4) g “OK” 52 “overshoot” BRELMIRE .

5) i <EEY, g R,

8.5.4.15 “phaseMargin” BR#{

“phaseMargin” pE{R] LAITHSE “Calculator” Z247H (RIE AN (H 2 ZORERIE A
ALY o
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%9 & ZESHT (Parametric Analysis)

9.1 “Parametric Analysis” K= XF/EH

“Parametric Analysis” 7F FLIE B U FEG UE I A2 & — MRS T R o & Seirs ik 3 5 244
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Cmd: Sel: 0

Tools Design Window Edit Add Check Sheet Options

A& 1

0l
5]

DK | E L

LS

~

nouse L schSingleSelectPt() M: schHiMousePopUp() E: schfZoonFit(l 0 0.9}

M ¢ |\E

K 9.1 “Parametric Analysis” £

FTJF “Analog Design Environment (ADE)” % 1. $%ME | TURl M 7k, W8 aF B S,
MHLER B 3R AE B 44 RIS — AN IR E . 07 R B BLHERE “de”, SRS IEFOR B R A
Mo IXFET AR 23 T S A AN A A T AR B I I iz, 2 A BLR LA 55, X5 T MOS
B, BASES. BARERSER. BOYERR “dc” firpm e, B ARSI E—IX,
IR IMEMEER] MOS B B HUR BRI 2R (P s th 4 . FIERA TR S5 01, K3k
3 MOS 4 B i F s IR EE T 26 ADE B W] 9.2 Fios . A T IRUIESZ & 73 B IR 217,
BWESZRONZE, K#TKGE, RIESMREREIEHT.

121



Yirtuoso?&nalog Design Enwvironment (3}
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Parametric Analysiz — spectre(2?): Cadance Parametric schematic
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Help | il
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Parametric Analysiz — spectre(?): Cadance Parametric schematic |Z||E|El
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Parametric Analysiz — spectre(?): Cadance Parametric schematic
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Tool Sweep Setup Analysis Help | 4
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Parametric Analysis — spectre(D): Cadance Parametric schematic
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Parametric Analysiz — spectrei{l): Cadance Parametric schematic
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Parametric Analysis — spectre(D): Cadance Parametric schematic
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Parametric Analysis — spectre(l): Cadance Parametric schematic
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Parametric Analysis — spectre(0): Cadance Parametric schematic |Z||E|E|
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& 9.30 “-20~20” H43HE Bl AN BR JE B SR TH
TR IRATTE$E “ Setup-Delete All Range Specification”, TS T A5 15 & 314890 Bl B0 K 4 A 4

o JHEr— /R FATELEAE “Setup” FHZEHAIESE “Delete Range”, “Parametric Analysis
Delete Variable” & FURE 3, FofiT7E LR SFEZEM BR 042 &, B4 “temp”, a1l 9.31 .
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Parametric Analysis Delete ¥ariabl... E]

OK | Cancel Help

B 9.31 MERFIHSE I =

mi “OK” Ja, MERATAIE X AE R “temp” MW EHMER T, [FR “L N7 (38
%37 “Sweepl” WIALT, Gk 9.32 Frox.

Parametric Analysis — spectre(l): Cadance Parametric schematic |T||E|r5_(|
Tool Sweep Setup Analysis Help ‘ 4
Sweep 1 Variahle Name ;Md Specification .

S il e 1] Span% | 100
- - Select |
Step Control  L08AMIC — | ens |9

K 9.32 MBRF#HZE “temp” J5 IR
9.10 Z/NMZTE K FNIR{E- “Parametric Set”

X T A5, AT LUK 2 R S HOB A R EA T R D IRBOR P AT AR AR R
Pt MARRZ T LR, IR — MR KLy, M0 HIATA] R T (LR 4L A PEBURO
DR L Al 1 b 2 22 4% 1) S VR 98 DK PR 0 L I TR R U S B8 o T FRAT I A 8 S0 AR IR — Fb 5,
ATLLSEI 2 AN AR R 2 A S, AMTASEXFALA T s P RE . Bl IRA 1238145 MOS 4%
(R R AE U ER 9.1 T i) 4 /il JE A R 445 o F

9.1 LL “temp” A “L_N” Sy (DY R

temp LN
Casel -15.1 4u
Case 2 23.5 3.2u
Case 3 12.8 1.8u
Case 4 66.5 0.6u

1EP] 9.33 fE “Sweep” ZHH, 1EFE “Parametric Set”. iXHf “Parametric Analysis” 5t
K D)4 21 1 9.34 BT /s I S il
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Parametric Analysis — spectre(0): Cadance Parametric schematic |Z||E|E|

Tool Sweep Setup Analysis Help | 4

Swept Variable
_____ Parametric Set

Sweep 1 Variable Mame F_h[ Add Specification —

RangeType  COMeMSpn o | o, 1y To |10F
Step Control  LOBAAMIC | s [

Select W

& 9.33 AR E R IRAE[1]

Parametric Analysis — spectre(0): Cadance Parametric schematic |Z||E|E|

Tool Sweep Setup Analysis Help | 4

Sweep 1 Variable Hame [

Value List Select |

K 9.34 /N ERFRRAE 2]

XET AR EIH . “Variable Name” F1 “Value List”

Horp “Variable Name” [ 7 7ER1 9.4 v—FE, 7E “Setup-Pick Name For Variable-Sweepl”
hIERE “temp”. 7E “Value” HAKIKIAN “-15.17, “23.57, “12.8”7, “66.5”7, FHLLFHIEIT .

AR 9.9 HITTERIN—AHIAR S “L N7 EXT NI “Value List” HHIEA “4u”, “3.2u7,
“1.8u”, “0.6u”, W ZLIEMERIT, G2 9.35 Pros st .

Parametric Analysis — spectre(0): Cadance Parametric schematic |:||E|rz|

Tool Sweep Setup Analysis Help ‘ 11

Sweep 1 Variable Hame | “"&

-15.1 23.5 12. 8 66.E Select |

Value List

Sweep 2 Variable Hame | *-%

|4u 3.8n 1. 80 0.6u | Select |

Value List

K 9.35 “temp” 1 “L_N” iS5 K% E

ERPEA, REIE 9.36 (5,
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Parametric Analy=iz Show A11 [11]

& 9.36 fHiE A HER

ATLVE R, “temp” F1 “L N” {l, C&ENTEPEAEE—ET .

WHRAE “Parametric Set” #z T, FATE “SweepN” [¥] “Variable Name” #r7n A “VarN”,
“Value List” H % M AMEFRR A “SnVm”, HSATE “Parametric Set” H 458 & fAh AT 1{E 1S
A MR 9.2 Fisid &

2% 9.2 “Variable Name” #r7~8 “VarN”7, “Value List” THIEE M MEFRH “SnvVm” B

45
Varl Var2 e VarN
Casel S1V1 S2Vi1 SnV1
Case2 S1Vv2 S2v2 SnV2
Case3 S1V3 s2vy SnV3
CaseM S1Vm S2Vm SnVm

FHit, ZE%E “Parametric Set” I, TEFERS “Varialbe” #H HFRNEAIBRIE,

9.11 {R4F “Parametric Analysis” K% &

Parametric Analysis — spectref{0): Cadance Parametric schematic E@
M Sweep Setup Analysis Help ‘ 13
 Close ...

Checkpoint

Revert ... Variable Hame fuld Specification —
Save ...

Recall ... From/To 17 '7
Save 3cript ... From To

Select |

Step Control TR Steps [

K 9.39 {RFF “Parametric Analysis” )% E

“Parametric Analysis” )% & A PRI ORAF A5

[1.] B RAE. 1 9.39 Bz, “Parametric Analysis” FJB BRI “Tool” 72 HLH 1)
“Checkpoint” TLRAFBIZA-T, SRJFHEIE “Tool” TFHZEH A “Revert” Il H
IXPPLRAE 7 AT L P BB R B AR RN SR 44, (H 2 “ Parametric Analysis” 7 1%
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WG, ZINERFI R E s k.
[2.] IKAARAT o 7E “Tool” Rz, EFE “Save” T, ¥ 3 “Parametric Analysis Save”
w I, ik 9.39 Fis.

Parametric Analysis Save r$_<|
0K ‘ Cancel |Defaults‘ Bpply | Help
Directory Jhome. firewarks wangy/simulation/Parametrid |I

File |para.mSave. il

&l 9.39 JK ALRAF “Parametric Analysis” F]1% &

7t “Directory” IANSCAFEELE, 5 “File” N4, AWM EEE “.i”7 fiil “OK”
g “Apply” B E RAF B SO . ARG “Tool” FHIZEHLHIR) “Recall” >k M ICAHH 3RHL
“Parametric Analysis” [ & .
{#47 OCEAN Script. 7E “Tool” FHi B %+ “ Save Script” i, K224 ocean script
SCAFRAT B P IR R SO . FR4IME B L Cadance XY “/doc/anasimhelp/chap9.html”
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%10 & T2 AR 21 (Corner Analysis)

T ES AT T —Fh o B e R RE (0 7 AR 7V, nT BA— kv ] — 21 i T 2 A B A 22
ZHORATE . R Virtuoso B4 T 2 /40T (Virtuoso™ Analog Corners Analysis), 1] DL %F
T 2w 22 S 3T 45 R 5 T2 (RE R EA T LU o ml AR S WL % o1 o8 i ] g tH IR o K
W MR BB s, RUEITA S8 A DU .

AFEPHFAE T2 BT IR DT, LR s i LA R E B, AR AR

® [T TARMIEA T

® RN

®  FEEAT LMo BT 1S 7~

® il &, Wil FBIA S

® L E U AT L2 M I sl s s

BAN, AT BARERE T SAOM BT 5, A ERERIF B LK WTITIT Virtuoso®
BT Mo M.

10. 1 TEMAA P T/E

FESE BRI T 2B, T2 R AT LU RIS, RS A 1 T 228l T Rt
H L NOiES R 2, Esehbrmflig L2, T2 HRRRIEARIE A ZZ A, HL
oA BARMEL BT B8l UL, IR 22 S BEALZ U AR A 15 7 v] 3 BB M 4R AN E

TZAA T RVE R 24 2 2 S S B BRI (FR A "Cormer”, s TAEA), &l H
JAE S RO BINBRIN R R BRPERE . A 1 IX L5 RAETT LUl e 4E T 22 He b 220, S22
A BB IR 22 AL 57 3 0R BRI PE BE REAS REME AL IURS 2K

T2l UZAEER]: (LI T Z i St 260 T EMBEE RSt A
Ja L R TR 4

10. 1. 1. FTHMRATZ A HTE N
BT LMo, w2
[1.] MRS vt S 8E, I LA E
[2.] 7 Virtuoso® ADE (Analog Design Environment) & I HF AR 4 40 #7870 ¥ B — AN AT 5%
[3.] PRUEHLEE A o AR A s T WA
[4.] £ “ADE” % NH &S “Tools” = “Corners” Il
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Yirtuoso?Analog Design Environment (1)

Status: Ready T=27 C Simulator: spectre 3
Session Setup Analyses Variables Outputs Simulation Results Tools Help
) Parametric Analysis ...
Design Analyses
Comers ...
# A ts.o ..o
Library Test Type rquments Monte Caro ...
Optimization ...
Cell cornerl 1 de i
b tran 1] Em RF
View  schematic Calculator ...
) ) Results Browser ...
Design Variables Outputs
Waveform ...
#  Name Walue #  Name/Signal/Expr Value  E Results Display ...
1 vddl g D (1]
|
Plotting mode:  Replace | | 1
>

& 10. 1T MK A T EM A E D

R O e LT Bl AR eI, LA E Dt . BoeH L2 Ao
M, Mi%FEE File” > “Close”

10.2 THRITEAMNED

WK 102 7R, Virtuoso™ T2 17 BLAMKT 5 1140 A JUANX IR, ISR BEE T 204 2T (%
Ho

Yirtuoso (R} Analog Corners Analysis: Lib/Cell/¥iew: Testfcorner1/schematic

s ) File Edit Setup Simulation Tools Help
TE PR ————>| Process: | ~| Base Directory: A

o }
EH* Corner Definitions
S g L b 5 Comners p
LM E TR Vﬂ"gﬂ“
Add Corner add Variable || Copy Corner || Delete || Disable | Run
Perf ce Me ts
MR » Measurement | Expression | Target | Lower | Upper | Plot | Print|
Add Measurement | Delete Measurement Calculator.. Get Expression Plot/ Print

K 10.2 TEMALhEND

10.2.1 K8
SRS AR BT MR T Z M as R th g, e & 10.3 Pros, 3£ 10.1
FEAR IR A 2 o
File Edit Setup Simulation Tools Help

K 10.3 TEZAahE O3k ®a
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F10.1 TEZASVMEOREAR

SREZETR

For More Information

“File”

”Load”

K B SN PCF 1 DCF it & A

”Save Setup”

K BB ORAFAE IR I C B SCAT

“Save Setup As” A E S A

“Save Script” {R4F OCEAN®HI A

“Close” KA Lo et
“Edit”

“Corner Whn—A L/ n—%1

Definitions—>
Add Corner”

“Corner SHIFES T ZMA
Definitions—>

Copy Corner”

“Corner R T E /A
Definitions—>

Enable Corner”

“Corner BHEANTEMA
Definitions—>

Disable Corner”

“Corner Bon—AAr g/ 8n—A17

Definitions—>
Add Variable”

“Corner
Definitions—>
Delete Selected”

MR —AS TS/ MR — 51

“Performance
Measurements—>
Add Measurement”

Fahm N A 53 H Calculator B N4

“Performance
Measurements—>
Delete
Measurement”

M ERRIE

”Setup”

”Add Process”

AT EMabEnEn— T 2E

”Add/Update Model

M2 MBS — D T ERBRAE &

Info”
“Simulation”
“Run” AT T
"Stop” 15 14047
"Tools”
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“Calculator” Calculator

“Get Expression” ¥4 Calculator H R IK 2 45358 A R 46 HH
“Plot or Print 2o ifil 1 51 R B TE

Outputs”
"Help”
“Contents” WIRICRE, AL AR A A AT I T B AE R
10.2.2 BL B A F H R XI5

T 2B (Process) T iy Bt o (1) 72 T 20 20 A G B (R 44 7, B A0 0 A SCIC AL 1R I
i % 73 "None” o i1 1% N fre 5] LY AN [F] R0 E . 1K T 200 E 4 7A@ M 0 T2
A, R T XA 5UrT PLe i 44 FRIBE AT DAHT & SO A mT AAE B St P ik £ “ Setup”
- “Add Process or Setup” = “Add/Update Model Info.” %' .

% H 3% (Base Directory) X 35 I 75~ (19 42 >4 i i 22 A58 H ISR 2 T 2 I B 4%

F H & H H “corAddProcess ” iy 2 1E 1. 20 HI 3 (PCF) He o thn] BAIE I+ “ Setup”
> “Add Process or Setup” = “Add/Update Model Info.” & X H, 11 10.4 i,

Process: |Processl v| Base Directory: [libs/2p3ma0c/ spice

& 10.1

WA SO TR, TS A TS 14 “File” > “Load”, “File” > “Close”,
“Setup” > “Add Process” A LAEHE, DMEERN T2ME S TahE TR E.

10.2.3 TZ /A% X (Corner Definition) FIH
T2 XA T T EM AT D F2EEE, Bonie ure X T EMnEE, WK
10.5 Firs.

Corner Definitions

K 10.5 TEAENX (Corner Definition)

XA G A B B N T2 S (PCF) ST M e vk L B S A (DCF) ST e o R
H.cdsinit SCAFHE I, TRAIE RS LA 1 %,

SOE XBE BT T2, Al DAL LN ik oAt ErAE R

® K HHIR AT ES, MRS BT KL ] BLERE 4

o hn LI HESH N HES) 4 Ly i HIAZ h 81

®  GUbRTRENR RIS LI AU, A b REr 22tk Rl DU AE b el i Has)
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RS o

® ZXJ T2 f1(Disable fZH)/E K o K, AHRE T 2 (Enable) b BA B, ik
BN PRI T AR “Disable” 22 s B, kel T EM
(R I F K 2 Wl oA RS “Enable”s

® Hi—ATA LIRS T 2 MIJRET R —F: (a) MR, BTN RN AR AR B,
W ToA% B W 25T ADE g AR SeE s (b)EloR — /MR SO R T2 M4

(Group/Variant) 54174F & (Group Variable), iX/MER AR T4 H R H o IXIAT

[ERTZNINPY . Rt & = i v S B SN (P S e T RIS R S I < 8

® FIH—FF, tn L@ AT, BOE ST .

® (R TS n] AR I s oo T 5, ARG I B0 W o K 5
M PCF " N B AN e g s A F3 A BGH )\ DCF U N IAT B 514 fig
i o

® ARSI H Wi N PCF SCAF RN B s K G 530, WA Fa A8
M DCF SCAFH AL 74 R,

ER: BE (temp) REAKZE, BOMEA 27 BIKE. M 5141 BOT4, XA
SIEHER.

T E e XA i Dhae R 10.2 s
F 102 TZ2AEXAHEFZETE

7Szl NBRIHE

Add Corner AN L EMNA LRI 4miE 5.

Add Variable AR R (T TIAAREIIER .

Copy Corner SR LEM B BlEfEil

Delete MBREEM LEM (B B
R M PCF A MATECE SIA TN, SRS DCF SO h AT 541
AT LA BR

Disable/ WorE AR AR ) T2 AW ig 2o R “Disable” —4HIEe I L 2M (FD o midh

Enable MIEEH B L2 M8 KT GRS L2 A0 BRI RHRA S . D
WP L R I T2, M A ffife (Enable) o miihijd k@
L2,

Run/ WA HIEAT AR BoR AZE1T (Run) , S i i WA 22 L2 A7 40T

Stop SNTBAT R SR L B s s 1k (Stop) » Adi S IEIELEBATHI 4T .

10.2.4 “Performance Measurement” —%jH 51
g A T L Z AT E DR, BoniE S E e ek AR, W&l 10.6 FiR.
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Performance Measurements
Measurement Expression Target | Lower | Upper | Plot| Print|
DCgain i (R 00 F (v cut ™)) 80 ¥ | I
banchaicith bandwidth(WF({"/vout") 3 "low") W | O
galn dB200YF("ivout™) W | 1

Add Measurement | Delete Measurement | Calculaor.. | GetExpression | PloPrint

K 10.2 “Performance Measurement” %y A

XA S AE S B2 M edsinit SCHFEH ] loadDef iy 2 8 S B2 8 ) S0 (Design
Customization Files, DCF) HU¥. F4b, 7E28—IRFTIF L2 M0 DI %, ADE HE X
M ER 2 A8 T ABZ SR A Calculator thA] LA#3 31—/ Mg i Rk K.

HE: s “Add Measurement” ﬁé‘»ﬂﬂiﬁutﬂi‘ﬁ%ﬂTu{ﬁf]D*/\iﬁutﬂ
QR ZE R 7 2, T DA G eSO S ) A ARSI dE e e A S SR T e AT AT —
HIHER AT LA HE I A A1 Rt

R B W R A SR A AR T LA, o] LA R e AT TR s A T S e
B HE ST R ) 2% H R S REFIE 1R 10,3

2 10.3 b S A AR 4% 0 H K 2h g

TiH ThRERER

Measurement 7] sk e “Measurement” FME MU AN H 4 F . 14 A H T
ik HH S bm B i R 51

Expression ML E Y “Expression” &M H RIAT.

Target ) sk e “Target” BT Lz (AR . X/ MERAAERE ST
(residual plot) [P gE

Lower %l raE e “Target” ZUn] LUZHTHI R IR . XAMERABEREST
(residual plot) HIHik T2

Upper %1 mE e “Target” FITTLLZHIHE T LR . XMERAGAERE ST
(residual plot) M {EFEE

Plot HEiLHE TEPEZ B AE ) DA B T A = T AEAT

Print SZiEAHE TEPEZ B AE W DA ST AR S T AEAT

Add Measurement ZH] | 74 A1 d 5 HE 0 — B K AT G 4 (14T

Delete Measurement #% | &% & W4T

Calculator. .. $%4l FTITF S 24T JT R Calculator & H
Get Expression %4 A FRIA X (Expression) W2 5, MG, midi3RE

Calculator H[KFIERGAT HAT MBI FRIE I
HE: I RIEA I (1 SCA K 4

10.2.5 R EI&
XAy BIGAE T 2 e SCR A 2 18], R3Sk T R A B K.
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10.2.6 RAE

RSB IRAF BB 2 LR JUR () —

ARG I EPSE

R TG B

Kt IEHEAR RS

T MAmir RN WSEE RSN L EADIT log 3L “corners0.log”. L& HT L
HLIR log SCAFREAEIRAE “Cadence™” BAFIEAEH T .

10.2.7 B4 AR GER
2 10.4 SRR I A PREE S L5 ThBE Rl ik

REEGR Thkefig

Tab PIHOChRITAEIR B TChs , PR NER A, IBAT RS T 47171
Shift-Tab DI CHRITTEI BTk, PRI Tab B8 1E 1 AH S

7 1) HWOT PIBOChRTER, BT (B BAHAT (B

F2 T/ R L& S R hseip

Page Down 2 RA T VRS 4 W )RR T

Page Up Dy RAT T VR E) 4 ) ) R TT

Home DI —4

End DI s — 5

10. 3 RARERE L ZHA 0N L6
T T30 S AN SRR s R ST T A M AN
10.3.1 HEF “ADE” HHE

BB B IFAE “ADE” RS E B AIET . B, BAEFWE 107 B
THIEAE CSMC A 0.5um CMOS 1R &5 5 T8 T T2 M1 5.
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A B L
- S w=du
BT 1)

K 10.3 “Corner Analysis” M %

LLAC {2 M {5, 76 “ADE” % M98 10.8 WH .

Virtuoso?Analog Design Environment (1) ENEE——
Status: Ready T-27 C Simulator: spectre 3
Session Setup Analyses Variables Outputs Simulation Results Tools Help
Design Analyses _i;
" # Type Brouments. ... Enable | |
Library TEST i
- 0C
Cell SingleStage 1 de 2 ¥e3
2  ac 100m  100M  Avto.. Stac. . yes _|r | .'[.
View  schematic Yy
Design Variables Outputs [Ej
# Name Value #  Name/Signal /Expr Walue Plot Save March )\/
1 WVout WAVE yes
2  PM YES
Plotting mode: Replace l
» Results in homel fgongwc/simulation/Single Stagesspectrefschematic

Bl 10. 4 XF1& 10. 7 P EEERREAT AC (IR TRE

PR L2 B 10.9 FToR.
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TEST SingleStage schematic : Mar 28 17:13:43 2007 [19]
file Edit Graph Axis Trace Marker Zoom Tools Help

FREHED [v/[Label | |

Expressions .

—~ Y out

50

40

30

YO (dB)
r~J
o
1

T T T T T T T T
1001 10% 10l 102 102 10t 10° 10° 107 108
freq (Hz)

[ [cadence
K 10.5 ACIHELR

10.3.2 WETLEANT
FIIT T2 H 6 DR 10.10 s es i D, se e S 405k T2 5
W Fah &

Virtuoso (R) Analog Corners Analysis: Lib/CellfView: TEST/SingleStagefschematic

File Edit Setup Simulation Tools Help

Process: w | BEase Directory:

Corner Definitions

Variales e P
w

| Add Corner || Add Yariable || Copy Corner || Delete || Disable || Run |

Performance Measurements

Measurement | Expression | Target | Lower | Upper | Plot | Print]
Yout |HEZOgvFe v oury) | [ [ [ [ O]
P |phaseMargingyFe' /Y outsy) | | | [ [ 1T
| Add Measurement | | Delete Measurement | | Calculator... | | Get Expression | | Plot, Print |

[=

& 10.6 TEADITHIHRE

[1.] 7ESCHrf k£ “Setup” = “Add Process...”

" Add Process [l

Process |

Process Name  |CSMC |

Muodel Style Single Model Library v

Base Directory \jlibs;2p3m50c}spice_22l |

Model File [s05mixddst02v22 1. sce| |

Process Variables | |

| oK || Cancel H Apply

152



B 10.7 “Add Process” HIATE

a) {E”Process Name Wi II A HT L E M4 7
b) EFH LEPER AL GOX i Single Model Library)
c) AN T ESCAREE R T M BRSCAR Y B sk 44

%5 OK, HiAsin 7 —A CSMC LA, W& 10.12.

Virtuoso (R) Analog Corners Analysis: Lib/Cell/¥iew: TEST/SingleStage/schematic
File Edit Setup Simulation Tools Help

Process: |CSMC v| Base Directory: [libs/2p3m50c/spice_221

Corner Definitions

Vagiabler——Comiers b
w

temp

| Add Corner || Add Variable H Copy Corner || Delete || Disable || Run ‘

Performance Measurements

Measurement | Expression | Target | Lower | Upper | Plat | Print |
Yout |dBZ 00w FC v our | | | | [ O
PM |phaseMargingyF' /v out's) | | | [ vl [T
| Add Measurement | | Delete Measurement | | Calculator... ‘ | Get Expression | ‘ Plot/Print |

Kl 10.8 #sinT CSMC I L2

[2.] ISIJLAL T &M . BARREIH AT T MOS &1 1 41 T8, HIXREHERNSRNMZ4 T8
o
a) {EHEEE Setup>Add/Update Model Info..., XSt H LT FRIA AL % %
HE, oAy 2 AN o SH— N HRIE ST 2B E, FINIA s I L 2R G HE
ZEAZ, WK 10.13 iR,

Update Process/Model Info
Process Name testl hd

Model Style |Sing|e Model Library

Ease Directory |j|ibs;2p3m50c;spice |

Muodel File |505mixddsto2\f20.scs |

Process Variables | |

| 0K || Cancel || Apply |

& 10.9 TE®E

b)  GHEEHEH ) Group/Variants 32 5K U T8 T & f 4.

Update Process/Model nfo

| Groups/Variants

Group Names | |

Variants [ |

| 0K || Cancel || Apply |
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K 10.10 TEMAAREM
IS INLH ARG IR 7900 R

® 7f Group Name —#*$5 2 A4 7

® (T Variant £ §5 2 41 5 L I

® IL¥ Apply;

® HN L3 WRAERRINZ A T EM;
® gk il Cancel iR H .

%1, 7E Group Name £~%i A\ MOS; 7E Variants £~ 55 tt ss st ff fs, Wi 5 4
TEHAMAFR, TR TE: Al Apply 8, X—41 T2 MEnne 7T 1L2M
(o AT S

# Group Name #1404 RES; 7E Variants £~ % A restypical resfast resslow; #&J5 15,
o Apply, X RES [ T E MG INE] 7 Fm

miili Cancel 1B HNIAWIXEHE, FHH 2 T 247, 25l3R 2 41T 2 M Bk,
ZFE,  HEnT LOSAS[H] 1 MOS & FHL BRI T & A AT 07 Heo

Corner Definitions

T et
w

M5
FES
temp

Add Corner Add Va

e T T2, PiERE FEG RN T 2M, FEAU T
c) HNHM T EM, LBUE:
® R HLIERE “Edit” > “Corner Definition” - “ Add Corner”, 5k # pi 4l “ Add
Corner”;
®  {EHH FXTRAE A N T2 A AT
® PRGN AR AT i B
d) EHPHEMCAEM L2Mm, PBRIT:
® LitE— L2
® M HIES “Edit” = “Corner Definition” = “Copy Corner” B¢ i i 144l
“Copy Corners”;
®  {EHH B EAE A AN L2 A AT
® IR FRAERAE O HA A BEA T G
HE: 1 “IC 5.1.417 L2 ha—4 bug, LML TFARENHE T,
3 AT B OB R
e) fERELZM, PBUTF:
® NI EM;
® It Edit”-> Corner Definition”-> Enable Corner” &% Enable 1% 4]l
0 AT ZM:

Bz ¥
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g)

h)

® ERE—NECH AR T 20,

® ¥ Edit”> Corner Definition”->Disable Corner” &% ’Disable” %4l »

¥E: PCF AW T EMAREEH

IIANFT T2 1

AR A, TR AR ST AN “H T EMaiE g

M ZEE R —Y . XA AR S s i v As i .

W

® EFEEdit”>Corner Definition”—>”AddVariable”, & # Hid7”Add Variable”4%41;

® i ANAR A I E .

MERAT (B

WU

® LE T EMERHIAT();

® SR J5 fF 3 B vh % $& Edit”>CornerDefinition”>Delete Selected” B, # 11
i Delete™ %, € AT F)it 2 G 2K .

H: PCF ENATEN)ZAREMIBRIT

MIBR Bk (1)

W

® LE T EMIBR:

® {F Rk $E Edit” > CornerDefinition”>Delete Selected” 5% # 14 ifi "Delete”
F, A i ST B 2k

¥E: PCF HE N T2 AR 5 A REMIBR I

FEPT T EMAR R S8 Jm A~ -

Corner Definitions

Variabley—o0mers 1l fs1 51 1 551
w

MOS it - | rs - || st - || | ss -
RES rastypi.. ¥ | restypi.. ¥ | restypi.. | reswpi.. ¥ || reswypi. ¥ |
termp

A 10. 12

2. BV BEE S EINAT LUR LR R AT

a)

b)

T H B N — N

W

® i)t 5 "Edit”’>”Performance Measurements”>”Add Measuments” 5% 5. 5 Add
Measurement” %4l ;

® TR T 0 A4 I R E

7E”Expression”—3 1 A= i A\ 75 B4 R IA K

o  (nik) WRFIAA M4 A 2 hn e,  H 7 20k 45 R o i 8] (Residual
Plot) 2, 1By N\ "Target”— H #fi+ “Lower”— F R A" Upper— I 1%
Y =

H Calculator 3787 i) i

W

® It 5 "Edit”’>”Performance Measurements”>”Add Measuments” 5% 5. 5 Add
Measurement” %4l ;

® N UEAE T 0 A4 I R E
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% 58 S Tools” > Calculator” 83 1t Calculator*#% 41l »

FIH] Calculator #3775 E KL, 7 W Calculator (1) 75

TETAE S5 BT 6 VR AN GhR 08 76 75 2208 XU i H 1Y) Expression”™

sl "Get Expression” $% 4l 8 3% 1% £ 3¢ 51 v [ " Tools”>”Get Expression”,
Calculator H ) 218 AU fh 25 B DG >k

o  (nik) WURFIAAMH 45 5 2 hn i,  H 7 20k 45 S o i 8] (Residual
Plot) 2, 1By N\ "Target”— H b fl~ “Lower”— F R A" Upper”— I 1%

=
c) MER%H
AR
® ULE i

® EFSEHA”Edit’> " Performance Measurement”>’Delete Measurement” 2{#
#4451 Delete Measurement”
K Ea 5%, @1 2 M, Watig Vout, RKIEXN dB20(VF(“/Vout™));
T PM, RoRHLIM L, RIAACH phaseMargin(VF(“/Vout™))
Performance Measurements

Measurement | Expression
W oLt clB2 a0 F M out™)
Fha phasemargindy FC S out™)

& 10. 13

BT 2 Mot iistr
TEIBAT T2 07, A LA X e e 1.
o FRAMIZITIN L ZM;
®  EPEEEAN R R SO T E i o R LA Plot” 17 Print” 52 EHEFR il o
®  AfiE s, R Run B # K §Simulation” > " Run” iz 1T 40 4T 5
® ik RErh, &R LL L Stop” B # 2 PR Simulation” = Stop {5 1143 4T ;
R “Run” 17 Stop {24 4% 8 & 5 A 1 Bz AT B 8 V) k.
T2 AT A
5 TLRC ) i 5 AR 2 e R 2 T PR aE T 2 R Bl i H S 5 R
DR e SO R A, v DU S HR 1R 3Rk X8R /5 16 $% " Tools” > "Plot or Print
Output”a# Plot or Print”, #RIAX G SHrH .
a) AR TEA W
® LR SCARE (e AN bR, G T A AR R, s T Bl
W H R BoR i — AN, BT R AN T2
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" Results Display Window

Window Expressions Info Help ‘ 21
Corner EM —
ffl 43 2445
fsl 41,3575
sfl 43 2153
s3l 41, 5334 =
ttl 42, 1801
- |

& 10. 14

o T AUBIHIH, AN LTI L TR

Results Display Window

Window Expressions Info Help | 22
freq Youk —
C 55l ttl fsl sfl ££1
100m 444983 443706 44 4521 44 316 443050
151 356m 444933 443706 44 4521 44316 443059
229 08Tm 444933 44 3706 44 4521 44 316 443059
346 73Tm 44.4983 44,3706 44 4521 44,316 44,3059
524 807m 444983 443706 44 4521 44,316 443059
T4 328m 44 4933 44 3706 44 4521 44 316 44 3059
1. 20226 44,4933 443708 44,4521 44316 44 3059
1.8197 444983 443706 44 4521 44 316 443050
2. 75423 444933 443706 44 4521 44316 443059
4. 16868 44,4933 443706 444521 44316 443059
. 30057 444983 443706 44 4521 44 316 443050
9.54993 444933 443706 44 4521 44316 443059
14 4544 444933 44 3706 44 4521 44 316 443059
21.8776 44.4983 44,3706 44 4521 44,316 44,3059
331131 444983 443706 44 4521 44,316 443059
501187 44 4933 44 3706 44 4521 44 316 44 3059
T5.BETE 44,4933 443708 44,4521 44316 443059
114 815 444983 443706 44 4521 44,316 443059
17378 444933 443706 44 4521 44316 443059
263,027 44,4933 443708 44,4521 44316 443059 |
lqnq 107 444097 A4 ATAR A4 4501 44 A5 laa anga |
& 10. 15

S H W R BT B A X RIARER, S TR —AA MR E T2
LEE S AET
b) 1042 EEHH
ARRED R T, —MR R R, — R R B
® BRI AR EIE A, v LS MG AT I LA 4 A
B2 Z W
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Graph Window [23]

File Edit Graph Axis Trace Marker Zoom Tools Help
S0l #E [ [F [ALabel | |
Residual Plot - PM l
C="g51",PM C="tt1"PM  — C="fe1";PM C="sf1";PM C="f{1";PM
435
43.254
target
43 .0
42754
= 425
f=d
=
42.254
42,0
41.75H
41.54
41.25 T T T T T
@ 1 2 xé 5 # nwar honne &
o[> |cadence|

& 10. 16 X ER
PR s 2 DL target AE A D AOFRIR . GR B BEE target, W2 Hr K
LB LL 0 A e AR
o iz igen Won iU th B L T K

" Graph Window [24] o ol )
File Edit Graph Axis Trace Marker Zoom Tools Help
SL#E B [Atave | ]
Expressions 1 .
—~ C="sz1"Yout ~ C="tt1l"%out —- C="fs1"Wout - C="sf1""out
— C="fT1" Wout
50
404
30
= 201
=
o
= 10
o]
_10]
20 T T T T T T T T
1071 10® 10l 102 102 10 105 w05 107 108
freg (Hz)
ol [cadence|
A 10. 17
o = NI . T s
AR SR — N T L.

TRAF
T2MscE S TN Dby DLRCE I — P05 B, ARG T2 A Ak i 145 L
a) R
WIRMC & & A\ PCF 50 DCF SCIFEZEUN,  7E3g Hrp ik ££7°File” > ”Save Setup” n] Kt i
5 8] JEUR A SO
WHRECE E TSR, X NEIA T .
AR WSRO 2 A EC B SO 25 5 [0 B g s — NS G SO s B 5 1 S
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PR IEREER R RO Ak, an SRR E SO e, S a RS B .
b) W EFIHEAN T E M NE SR 55 TR E S, v LA File”>Save
Setup As.”— S AFHCE . XA Corner Analysis [/ Iz aft vl LA FH LLRT I AC & T

" Save As p—
Save In: ‘ﬁ MNoiseTest " @ @ @ @E
3 addr4.runl s I top.runl [
I CSKY I MoiseTest Jtop_runi [
3 dci.runl 3 NoiseTest.runl T verilog_test [
3 DV3_test.runl CJtest.runl C xbres [
3 ERC 3 test_runl [ ade_wavescan.log ||
[ grey_testrunl (] testbench.runl D cds.lib [

[ »

File Name: | |

Files of Type: |AII Files v|

| Save || Cancel |

&l 10. 18

W, XA RS windows ) SCFE BEES, HIAZNEHT .
¢) TR M OCEAN®MHIA

OCEAN® & — N SCAF I 1)y AT FL 11, g e il LAE Unix shell 8(7# /& Cadence
R 24T ST (CIW) B E 384T FI 40T 05 B 1) i th 258« i n] BUIE IS OCEAN® A
217 OCEAN®I T AT Thiig.
AT DAAE T2 A 43 B o 1 0 1 10 B 0 5 2 R 0 A, B 8 B R AT OCEAN®JEIA
A EE ] LA OCEAN® H 4217, 0] DLgwHIX AL, 285 F A OCEAN®H!
WH
KT OCEAN®H 41 11115 B A OCEAN® 1 .
B HLF) " File” > Save Script”, X J5 5 U FIl windows FOARAF T 1 AR ARABLIR) SC 45
PRAS, i A I B8 A A S04

10.4 {FAITZE. & iTFEE ST

TESEBR A, 200 FE ZE T 2R A I AR S B0 B B4k, LA T fil T 250 B
P B SO AR AT (1)
— A 3 R LA AT IR E SR
® [ ZHEE XM PCF, X T.&. TEMAL. AETMEN T EMM RN E. PCF —K
ST B B T AV I TR
® WilEHISCft DCF, fWErRwil T E, ©fE PCF F5EAL FiEm&AN . —#m

R BT B 2 S
® BRI E SR T2 0 A IR 5% A F B2 S BB S SO i ol T2 T RE I B
FAL) .

— A T2 A T AN K A& 20 PCF A DCF SCPE, {H G S 75 2400 5 48 X S i & S04
A LM S
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10.4.1 #37. DCF 1 PCF /%

PCF 1 DCF H16% Cadence SKILL i 75 M4, X&em 4@ X T oM e A m T4
AT N A RS A X ey & T ﬁﬁgaﬁu%

SKILL %5 A1 PI {1143 v 7E PCF Fl DCF H# el LGB . (H—fe X T2, TEMAMT
AR R A A — URE PCF . B B AR . S iy & — BCHR4E DCF .,

PCF HH {% Fl#r 4

corAddProcess

corSetModelFile

corAddCorner
corAddGroupAndVariantChoices
corAddModelFileAndSectionChoices
corSetCornerModelFileSection
corAddProcessVar
corSetProcessVarVal
corSetCornerGroupVariant
corSetCornerNomTempVal

F&: corSetModelFile iy R

F2MEE, Afhmais,
78R PCF A1 DCF 3¢, o]

DCF H % Hfrd EH R4

corAddDesignVar corSetCornerVarVal
corSetDesignVarVal corCopyCorner
corSetCornerRunTempVal

corAddMeas

corSetMeasExpression

corSetMeasLower

corSetMeasUpper

corSetMeasTarget

corSetMeasGraphicalOn

corSetMeasTextualOn

ﬁ‘éf PR AR S AR
Z [ Virtuoso® Analog Design Environment SKILL 5 % B
LA Al OCEAN, [H2) OCEAN [¥iffith L se e, bl

W2 A A I S o SO B AE -
Cadence ‘%% H % /tools/dfTl/samples/artist/corners

Bl: Heg—ANTEREXH PCF

PCF ¥ In—/MHii T ER T2t BB S, JFE X4 T2 M. Bt 41K PCF N
AN T =40 P50u I 125, il TR AN singleModelLib, I H.g X T =412 i : slowslow,

nominal, fastfast,

; Example PCF file for the process P50u.
corAddProcess( ""P50u" ""~/processes”™ "singleModelLib )
corSetModelFile(""'P50u" "P50uModelFile.scs™)

; Prepare to add a process variable to each corner.

corAddProcessVar( ""P50u™

"EdgeEffect"” )

; Now add the corners, specifying the values and choices for each.
corAddCorner( "P50u" "fastfast™ )

corSetCornerVarVal ( "P50u™

"fastfast” "EdgeEffect” "1.18" )

corAddCorner( "P50u’ "slowslow™ )

corSetCornerVarVal ( "P50u"

corAddCorner( "P50u’ "‘nom

corSetCornerVarVal ( "P50u”

"slowslow" "EdgeEffect" "1.12" )

inal™ )
"nominal™ "EdgeEffect™ "1.15" )

fastest typical. Fl slow T2 A AT S50 i 2 ANTE PCF e X, T2 AR SO e X
i, P5Ou T 1 PCF L& LA 51 B SCAT P5S0uModelFile.scs 7 LA B«

-LIB slowest
-model npn2 npn tf=120n

-model nmosR nmos tox=120n

-.ENDL slowest

-LIB typical
-model npn2 npn tf=100n
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.model nmosR nmos tox=100n
.ENDL typical

.LIB fastest

-model npn2 npn tf=80n
.model nmosR nmos tox=80n
.ENDL fastest

BWANEA P50u T ZM PCF 3CIF, 7 A (B BAE S L o OR R

Process:

PS0u w | Base Directory: ~/processes

Corner Definitions

Bl: #eEF—A IR ES DCF

DCF & X2 Bt A A iy, it R DCF SCERARIN T Bt AR 3E 1

S BT IR I HLAS N 1 4 i

corAddDesignVar( 'vss" )

corSetDesignVarVal( "vss

corSetCornerVarVal( "P50u" "fastfast" "vss"

70" )

corSetCornerVarVal ( "P50u" "slowslow'" "vss' "50" )
corSetCornerVarVal( "P50u™ "nominal™ "vss™ "60" )

corSetCornerRunTempVal (""P50u™ "slowslow" -35)

; You must add the measurement before you define it.
corAddMeas( "bandwidth" )

corSetMeasExpression( "bandwidth” "bandwidth(VF("/vout®™) 3 "low™)" )

corSetMeasLower (*'bandwidth™ *8Mhz'™)
corSetMeasUpper ('bandwidth™ "12Mhz')
corSetMeasTarget(*'bandwidth™ *10Mhz')

FERT M7 rhoE S P50u T 23 3N DCF SCIF, T2 A€ SCH miA 5 i 73 %)

BRI

Process. |PS0Ou w

Base Directory: --/processes

Correr Definitions

temp

EdgeEffect

LA

slows|ow nominal

K 10.19
Performance Measure ments
Measurement Expression |Target Lwerl Upper
bandwidth  |bandwidth(vF{/vout’) 3 Tow') 10M  BM 12M

& 10. 20
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10.4.2 H.cdsinit 32443\ PCF 1 DCF 314

— M I PCF 1 DCF SCA 8 75 72 2 S i & edsinit SCPF, AT DGR AR J7 A :

HEFA . cdsinit SMFRAFH PCF #HA DCF, 1 DCF X8 EER AR PCF XH:
M DCF X f4

PRI cdsinit SCHFRN T 75 2K | 7 .cdsinit SCAEH R 2 75 10 DCF SCF, 1 DCF SO
PCF #! DCF 3. T PCF 30k

Bilhn: 7E.cdsinit XAFFIIAN—F | la: 7E.cdsinit ST IIA

[1EA) 3 N PCF f1 DCF {4, | loadDcf("'/mnt4/radhikak/tools/dfl1/src/corners/m

loadPcf "processl.pcf"” yanalog35u.dcf'")

loadPcf "process2.pcf" 1t DCF XCAFF In A CL R IRiEA]
loadDcf "cellPhone23.dcf ; This is the myanalog35u.dcf
loadDcf "opamp47.dcf loadPcf("'mypath/analog35u.pcf")

AN KR T 2, AZRUES I ) DCF H 5| ) T2 8 & SGd ), — eRon i 353k
A PCF A Fi# N\ DCF LA

10.4.3 ZEFRAFE K

TEMAHTSES 5 AR RFE, 2. B (Single Model Library), Z#
B SCAF(Multiple Model), HLM %% (Single Numeric), % fM(%5(Multiple Numeric), % 5 %{(Multiple
Parametric) FL AR .

MICS. 141 fRITER T E MR 7 — ey, a2 iR BOA R O TARIEE —
77 OASIS T Z AR, (RIS RF AR SO AR A s . B A e LT 2 A T2 E i,
T BN EE M T B R E ST PCF 30

Cadence B 1 H HRAR TR SRR S Bl 3 22 AR TR SRR IZ 4T Cadence® Spceetre® FEL I 1 FLAR -
X} T SpectreS f/j H.#4%, Cadence FUATH 2 M2 10 44 F I 2 B MR 2 2508 24 /)
CAEH e TR INEE RS 43X LA PCF SC ) SCAE S5 R R -

10.4.4 BRI SRR,

Cadence £ AL XA ] S 1K 7 A F T2 20 b SRHATXM 7 2UnT LU

® CKPTH IR T A I L E AR RATAE — MR SO

® LA T A H

® AR
Al LAPE T2 A g NSO 2 8l I corSetModelFile iy 2 iff i A7 SO 1) 3¢
(=

IR AS R T BRI PR et Oy 2 AR T I, el D L LIB R VE AR Y

CAF. LIB 54t hspice MR YTEE, 1ZIBVEAE spectre HH S0 FF,

1 BRI
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Path Filename File Contents

. /CORNERS/fab6/ mylibfile. scs library processA
section slowslow
model npn2 npn tf=120n
model npn9 npn tf=320n
model nmosR nmos tox=120n
model nmos8 nmos tox=320n
endsection

section nom

model npn2 npn tf=100n
model npn9 npn tf=300n
model nmosR nmos tox=100n
model nmos8 nmos tox=300n
endsection

section fastfast

model npn2 npn tf=80n
model npn9 npn tf=380n
model nmosR nmos tox=80n
model nmos8 nmos tox=380n
endsection

endlibrary

N AR R R S RELE PCF g I LUR R AL 45
corAddProcess("'fab6™ './CORNERS/fab6/* "singleModelLib)
corSetModelFile("fab6" "mylibfile.scs'™)
corAddProcessVar (**fab6" *‘vdc')
corAddCorner(*'fab6" "slowslow"

?runTemp 20

?nomTemp 27

?vars “( ('vdc" 2) )

PCF X3R5 Virtuoso® T &4 2087 5 11 0 K]

Process: |fab6 w | Base Directory: JCORNERS/fab6/

Corner Definitions

Voriables T slowslow[

temp 20
vdc 2
K 10. 21

TR U BRI R R R L HT I T 2 A AR T -

MIC 5.1.41 WCATTAR, AT LAFE SRR SO AN ] (0 T 254 i o A R S rh oA ) ) 5
i (Section), XL KK IXFEAEH corSetCornerGroup Variant() bR % :

corSetCornerGroup Variant( <. 244> <T. 21 4> < 44> <4 ik 1> )

Hrp
T24:
T2 (LA HE O, i, fabé
T &M%
T EMMAT, BRI SCAE )15 (Section) [ 44 -
44
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TZMANAT, RN TH AL
5
TEMAREIN . R LIRS A ) — 4 T

T AR s PR AR A SRR SR Y PCF SR BB 2 A T 20 AL B
corAddProcess("'singleModelLib" *_/CORNERS/singleModelLib"™ “singleModelLib)
corSetModelFile("'singleModelLib™ "singleModelLib.scs™)
corAddModelFileAndSectionChoices('singleModelLib™ 'groupname'™ =“( "slowslow
"slowfast" "typtyp" "fastslow"™ "fastfast'™) )
corAddProcessVar(*'singleModelLib™ *'vdd™)

corAddProcessVar(*'singleModelLib" "vss'™)

corAddDesignVar( ""Cload" )

corAddCorner( "singleModelLib"™ "corl" )

corSetCornerNomTempVal ( “'singleModelLib™ *‘corl™ 27 )
corSetCornerRunTempVal ( "'singleModelLib™ "corl" 125 )

corSetCornerVarVal ( "singleModelLib"™ *‘corl™ *"Cload"™ "260f" )
corSetCornerVarVal ( "singleModelLib" "corl' '"vss'™ "-2.7" )
corSetCornerVarVal ( "singleModelLib'™ *‘corl™ *vdd™ "2.7" )
corSetCornerGroupVariant( "singleModelLib™ "corl™ "groupname' "slowslow™ )
corAddCorner( "singleModelLib"™ "cor2" )

corSetCornerNomTempVal ( ""'singleModelLib™ "cor2"™ 27" )
corSetCornerRunTempVal ( "singleModelLib"™ "cor2" 27 )

corSetCornerVarVal ( "singleModelLib" "cor2"™ "Cload" "200f" )
corSetCornerVarVal ( "singleModelLib"™ "cor2"™ "vss™ "-3" )
corSetCornerVarVal ( "singleModelLib" "cor2'™ "vdd" "3" )
corSetCornerGroupVariant( "'singleModelLib™ *cor2" *groupname" "slowslow" )
corAddCorner( "singleModelLib"™ "cor3" )

corSetCornerNomTempVal ( “singleModelLib" '"'cor3" 27 )
corSetCornerRunTempVal ( “'singleModelLib" '‘cor3" 27 )

corSetCornerVarVal ( "singleModelLib" "cor3" "Cload" "200f" )
corSetCornerVarVal ( "singleModelLib"™ "cor3" "vss™ "-3" )
corSetCornerVarVal ( "singleModelLib" "'cor3" "vdd" "3" )
corSetCornerGroupVariant( ‘'singleModelLib™ *cor3"™ 'groupname' "fastfast" )
corAddCorner( "singleModelLib"™ "cor4d" )

corSetCornerNomTempVal ( “'singleModelLib™ "cor4"™ 27" )
corSetCornerRunTempVal ( "singleModelLib" '"'cor4" 27 )

corSetCornerVarVal ( "singleModelLib"™ "‘cor4'™ *"Cload"™ "200f" )
corSetCornerVarVal ( "singleModelLib"™ "cor4" "vss"™ '"-3" )
corSetCornerVarVal( "singleModelLib"™ "cor4™ *vdd"™ "3" )
corSetCornerGroupVariant( '"'singleModelLib™ "cor4™ 'groupname' "fastfast" )
corAddCorner( "singleModelLib"™ "cor5" )

corSetCornerNomTempVal ( "singleModelLib" '"‘cor5" 27 )
corSetCornerRunTempVal ( "singleModelLib"™ "cor5" -55 )

corSetCornerVarVal ( "singleModelLib" "cor5" "Cload" "160f" )
corSetCornerVarVal( "singleModelLib™ "cor5"™ "vss"™ "-3.3" )
corSetCornerVarVal ( "singleModelLib" "cor5" "'vdd"™ "3.3" )
corSetCornerGroupVariant( "singleModelLib™ "cor5" "groupname" "slowslow™ )
corAddCorner( "singleModelLib"™ "cor6" )

corSetCornerNomTempVal ( "'singleModelLib"™ "cor6" 27 )
corSetCornerRunTempVal ( "singleModelLib" "cor6"™ -55 )

corSetCornerVarVal ( "singleModelLib" "cor6" "Cload" "190f" )
corSetCornerVarVal ( "singleModelLib' "cor6'™ "vss™ "-3.0" )
corSetCornerVarVal ( "singleModelLib" "'cor6" "vdd"™ "3.0" )
corSetCornerGroupVariant( "'singleModelLib™ *cor6"™ 'groupname' "slowfast" )
corAddMeas( "'DCgain™ )

corSetMeasExpression( ""DCgain’ "ymax(db20(VF("/vout©)))" )
corSetMeasTarget( "DCgain'™ 60 )

corSetMeasEnabled( "'DCgain™ t )

corSetMeasGraphicalOn( "DCgain™ t )

corSetMeasTextualOn( "DCgain™ nil )

corAddMeas( "'bandwidth™ )

corSetMeasExpression( "bandwidth™ "bandwidth(VF(*/vout®) 3 “low")" )
corSetMeasEnabled( "bandwidth™ t )

corSetMeasGraphicalOn( "bandwidth™ t )

corSetMeasTextualOn( "bandwidth™ nil )
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corAddMeas( ‘‘gain' )

corSetMeasExpression( "'gain' "dB20(VF("/vout™))" )
corSetMeasEnabled( "‘gain™ t )

corSetMeasGraphicalOn( "gain™ t )
corSetMeasTextualOn( "gain™ nil )

corAddMeas( "‘phase" )

corSetMeasExpression( '‘phase" "‘phase(VF("/vout®))" )
corSetMeasEnabled( "'phase" t )
corSetMeasGraphicalOn( "phase™ t )
corSetMeasTextualOn( "phase' nil )

BN PCF SUMFZJa T2 M i dd 1 Bostn b

Process: | singleModelLib v| Base Directory: /JCORNERS/singleModelLib

Comer Definitions
. Comers p
Vanables cort cor2 cord cord cors cos
v
groupname slowslow  |slowslow  fastfast fastfast slowslow  slowfast
temp 125 27 27 27 -55 -55
vkl 2.7 3 3 3 3.3 3
WSS 2.7 -3 -3 -3 -3.3 -3
Cload 2607 2007 2000 2007 1600 1907
10. 22

2. RS
X R OREL M T 2 E S, A fF PCF Ml DCF X H fE H
corAddModelFilesAndSectionChoices 1 corAddCorner 7% . AL 5, IXFPARE R FlIAE B A

RIS 22 lan, BT DA AE R 1 B SC
-/CORNERS/fab6/pathl/npn.scs
./CORNERS/fab6/path3/nmos.scs

TR ERPEZ RSB R U 7 e BR T .SCS BRSO, ] DU LIB AR S A
2R SR
Path Filename File Contents

. /CORNERS/fab6/pathl/ npn. scs library npn
section slow

model npn2 bjt tf=120n
model npn8 bjt tf=80n
endsection

section nom
model npn2 bjt tf=100n
model npn8 bjt tf=60n
endsection

section fast

model npn2 bjt tf=80n
model npn8 bjt tf=50n
endsection

endlibrary

. /CORNERS/fab6/path3/ | nmos. scs library nmos
section slow
model nmosR mos3 tox=120n
model nmos2 mos3 tox=140n
endsection

section nom
model nmosR mos3 tox=100n
model nmos2 mos3 tox=115n
endsection
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3.

section fast

model nmosR mos3 tox=80n
model nmos2 mos3 tox=90n

endsection
endlibrary

AR T T 7E PCF Al ) 2 B SR

corAddProcess("'fab6" " ./CORNERS/fab6/" "multipleModellLib)
corAddModelFileAndSectionChoices(*"fab6™ *pathl/npn.scs"

*( "slow" "nom'" "fast') )

corAddModelFileAndSectionChoices("fab6" *path3/nmos.scs"

“( "slow" "nom'" "fast') )
corAddProcessVar (*'fab6" "vdc')
corAddCorner(*'fab6" *slowslow"

?sections "( ("pathl/npn.scs" "'slow')
('path3/nmos.scs™ "'slow') )

?runTemp 20

?nomTemp =27

?vars "( ('vdc" 2) )

corAddCorner(*'fab6" "‘nomnom"
?sections " ( ("pathl/npn.scs' "nom™)
('path3/nmos.scs™ "nom™) )
?runTemp 30
?nomTemp 27
?vars "( ("'vdc" 3) )

)
corAddCorner (*'fab6" "fastfast"
?sections "( ("pathl/npn.scs" "fast')
(""path3/nmos.scs™ "fast™) )
?runTemp 40
?nomTemp -27
?vars "( ('vdc" 4) )

corAddCorner (*'fab6" "fastslow"
?sections "( ("pathl/npn.scs" "fast')
('path3/nmos.scs™ "'slow') )
?runTemp 50
?nomTemp =27
?vars "( ("'vdc" 4) )
)

BN PCF A2 Jn T2 i h

Process: |fab6 w || Base Directory: JCORNERSXah6!

Carner Definitions

Voo PP oo ‘ noMNOM fastfast fastslow
v
path1/npn.scs slow nom fast fast
path3/nmos.scs Slow nom fast slow
ternp 20 30 40 A0
wdc 2 3 4 4
K 10. 23

Mz AR (Single Numeric Style)

KA XA T H 2N T IHRRA R SCFF . QR AR 200 20 i 10 5 A4 A

Spectre® {jj E#F, Cadence U # 2 — A LF A (Style).

® JHRXMEL, BT ZMARAALPIRAIBRA . WERA 5 AT ZM, M 5

AR P AR RSO R EEAT AR R ) SR A4

® EMRIMSCIHRAFAE 2 HRI L Z/4 Ha b o Bl — AT 2 allfast, %

A MRS RAAE 2 HoRfallfast HXF .
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® XA HIMBIA SR v AT R A
B QR AL Spectre®ffj LA, EHEE R Setup”>"Model Library”, fEA M1 E
X UEAE A AL 44 7
B R O E S, 8 Setup” > Environment” ] FF— AN T HER AL
IR A 44
NIRRT — NS0 3 A L2 MAMECE SO, AT 12 SR,

LN e 5

Path Filename | File Contents

. /CORNERS/fab6/allslow/ models .model npn2 npn tf=120n
.model npn9 npn tf=320n
.model nmosR nmos tox=120n
.model nmos8 nmos tox=320n

. /CORNERS/fab6/allnom/ models .model npn2 npn tf=100n
.model npn9 npn tf=300n
.model nmosR nmos tox=100n
.model nmos8 nmos tox=300n

. /CORNERS/fab6/allfast/ models .model npn2 npn tf=80n

.model npn9 npn tf=380n
.model nmosR nmos tox=80n
.model nmos8 nmos tox=380n

PCF S XA s X SR T 24 -
corAddProcess(""fab6" " ./CORNERS/fab6" "singleNumeric)
corAddCorner(**fab6™ "allslow"

?runTemp -55

corAddCorner(*'fab6" "allnom"
?runTemp -27

)
corAddCorner(*'fab6™ "allfast"
?runTemp 55

)
WoRUnR

Process: |fabﬁ v‘ Base Directory: .JCORNERSTaht

Corner Definitions

Vatiabler S R P Gigiow ‘ allnom allfast |
-
termnp -55 -27 55
& 10. 24

EZVE SN

AR AR AL A T S AH0F LR RROAS SCRF 1y ¢ &L 1

a)  AEXFMBAR, MBI W] B SO e BT B ) S EER )

b) BB SCHRRATAE ARSI AEE B R i, iy — AR g a5 7
npn 41, {EAIEIN fast, W2 /DTA—ANBSCAIRAEE 22 H#Inpnffast SRR

c) RSO SO 44 HAE ADE W <dmfi ) 4 JE P (Edit Object Properties) HHiIA

E2LE LSV
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Path Filename

File Contents

. /CORNERS/fab6/npn/slow/ npn2. scs

model npn2 bjt tf=120n

npn9. scs model npn9 bjt tf=320n
. /CORNERS/fab6/npn/nom/ npn2. scs model npn2 bjt tf=100n
npn9. scs model npn9 bjt tf=300n

. /CORNERS/fab6/npn/fast/ npn2. scs

model npn2 bjt tf=80n

npn9. scs

model npn9 bjt tf=380n

. /CORNERS/fab6/nmos/slow/ nmosR. scs

model nmosR mos3 tox=120

nmos8. scs

model nmos8 mos3 tox=320n

. /CORNERS/fab6/nmos/nom/ nmosR. scs

model nmosR mos3 tox=100n

nmos8. scs

model nmos8 mos3 tox=300n

. /CORNERS/fab6/nmos/fast/ nmosR. scs

model nmosR mos3 tox=80n

nmos8. scs

model nmos8 mos3 tox=380n

MRS TSR PCF I BEE

corAddProcess("'fab6" ' ./CORNERS/fab6"™ “multipleNumeric)
corAddGroupAndVariantChoices(*'fab6"™ "npn"

*("slow” "nom” "fast")

corAddGroupAndVariantChoices("'fab6"™ "nmos"

I(IISIOWII Ilnomll Ilfastll)
corAddCorner(*'fab6" "slowslow"
?variants "(

(Ilnpnll IISIOWII)

('nmos™ "'slow™)

)
?nomTemp -55
?vars "( (“"Cload" 260f) )

corAddCorner(**fab6™ "slowfast"
?variants "(
C'npn™ "slow'™)
(llnmosll Ilfastll)
)
?nomTemp -55
?vars "( ('Cload™ 200f) )

)
T TE R st

Process: | fahé

w | Base Directory: JCORNERSTah6

Corner Definitions




A E PR FHEH Spectre® (7B 78

MAEZ BRI T2 MM A Spectre®1) EL a8 B, {RUELE.cdsenv A2 LT

includeStyle 4% .
5. ZZHHEAIRIA

FEIX PRI A FA N T X IHRAR IO SCRE, B W Rk

® CRTIXFPEL, REAMBAERLE — AN SO A . A L E A — AR SO
.

® MR FHRAE BT Gl WG — A T2 4] npn, WX LEHL
RUSCHRAFAE T 2 HoRinpn HER

®  WNSECUIHRAEAE EHR A G AL R filln: Wi npn TEMATH—
AR fast, W2 /DH —NSEORAAAE = HRIHE I .

®  BE AR S A () S 4 v LLAE Virtuoso® ADE HP I« 4 48 % % J8 7 ”(Edit Object
Properties) HHIA

NRBUR AL ] 2 S B0 R 1R E SO S5

AR U
Path Filename File Contents
. /CORNERS/fab6/npn npn2. scs include “npn2.param”

model npn2 bjt tf=TF2

npn9. scs include “npn9. param”
model npn9 bjt tf=TF9

. /CORNERS/fab6,/npn/slow/ npn2. param parameter TF2=120n

npn9. param parameter TF9=320n
. /CORNERS/fab6,/npn/nom/ npn2. param parameter TF2=100n
npn9. param parameter TF9=300n

. /CORNERS/fab6/npn/fast/ npn2. param parameter TF2=80n

npn9. param parameter TF9=380n
. /CORNERS/fab6/nmos nmosR. scs model npn2 mos3 tf=TOXR
nmos8. scs model npn9 mos3 tf=T0OX8

. /CORNERS/fab6/nmos/slow/ nmosR. param parameter TOXR=120
nmos8. param parameter TOX8=320n

. /CORNERS/fab6,/nmos/nom/ nmosR. param parameter TOXR=100n
nmos8. param parameter TOX8=300n

. /CORNERS/fab6/nmos/fast/ nmosR. param parameter TOXR=80n

nmos8. param parameter TOX8=380n

NI PCF B A SR T8 2 28 i 75 1%
corAddProcess("'fab6" ' ./CORNERS/fab6™ “multipleParametric)
corAddGroupAndVariantChoices('"fab6" ''npn2"

“('slow™ "nominal™ "fast™)
)
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corAddGroupAndVariantChoices(*"fab6"™ ""'nmos8"
"("slow" "nominal™ "fast'™)

)
corAddGroupAndVariantChoices(""fab6" ""npn9"
"('slow™ "nominal™ "fast™)

corAddGroupAndVariantChoices(*"fab6™ *"‘nmosR"
"("slow" "nominal™ "fast')

corAddCorner(*'fab6" "slowslow"
?variants "(
("'npn2" “'slow')
('nmos8™ *slow'™)
("'npn9" “'slow')
("'nmosR™ "'slow™)

)

?nomTemp -55

corAddCorner(*'fab6"™ "slowfast"
?variants "(
("'npn2" “'slow')
("'nmos8™" "fast')
("'npn9™ “'slow')
('nmosR™ "fast')
)

?nomTemp -55

Virtuoso® . &M M1 & D EFH N T Lk PCF XXME2 G Wt -

Process: [fabﬁ - | Base Directory: ..CORMNERSfTaht

Carner Definitions

Variables P g ovsiow slovifast
R 4
npn2 [slow slowy
nmosk slow fast
npnd slow slow
nmoss Slow fast
ternp 27 27
& 10. 26

JH Spectre® (7 E #4455 5 Z S5 HEAH) T Z A 787
IX IS RIELE .cdsenv SCAFEF 4 7€ X includeStyle A5 & .
S B A O 07 B B(Socket Simulator) £ 2~ 242 T Z A 547
X ZEHE — 440 update.s IS HOCHE. #iln: update.s W] LA A U1 A

use npn2.s
use npn9.s
use nmosR.s
use nmos8.s

WA AR 0 T EMIE X, W LALE init.s HH ] use iy 2 1A S 4E update.s SO
D0 T2 0 W AE 73 s B I init.s A B s A 5e 40, Fr BAAT LA init.s FE4 update.s SCAF A
MR E

R L2Mse AT psf XA et L runObjFile. [ATfij, result browser A~ fig 7t
EIAIH>. BEEEFARIHR, ATLUER] Create ROF .

XBIAKTE (Note:  Corners is designed such that it does not create a runObjFile in each psf
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directory it creates. Therefore, the results browser cannot be used to browse through the directories. In
order to browse individual directories, you can use the Create ROF feature.)

10.5 EFAREXHEITIZ A5 HTRILH)

TR R A e B SR AN s TR T2 20 b TR SR LR R o 1K A
T T AE—ASEBR T B LIRS B0 B R R 2 HE G B RS T Tl 4 ) 5
RS ORAFAE

Cadence %%% H 3%/tools/dfTl/samples/artist/corners/artistExample

BIRSE R 6T, IR H & FIigAT iems. HA T H 1. cdsinit SO IRAFAEIZBE IR o

10.5.1 $r2ILYR LM e Bk

FHL I T R
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& 10. 27

% L L 2 PMOS R NMOS 152491, 54~ PMOS %"*ﬁﬁi%*ﬁlﬂﬁﬁ [{ FE, £ NMOS
WAHTR . (H3ERR L, SRS R BRI« 22X Mo, T8 T2 05 E5aT DL 45
H 2R 20 PR A S

10.5.2 % & Virtuoso® ADE %

TIN5, H G EXT ADE BEAT B E -

1.

£ CIW—m 24T L HF K HTools” > Analog Environment”->”Simulation”, Virtuoso®
ADE & HH 3L,

1% % 3¢ H.Setup” > Design” ik £ ZLHEAT U E I ML B . fE Bk RF_Lib o Ak
foldedCascode, £ OK.

7F ADE % I k6 2% 1" Session”> " Load State”; FAGE & & & DS HIL; AE A
%444 Corners [RREE, E# OK;

EFESZ H°Output”>"To Be Plotted”—>”Select On Schematic”; E# H 1) HL % & 11 R ik
# vout 19 i,

7E PCF SRR ] Ll S, {H T ADE 18 < B sheE T2 0 TR S s
R FAB T Z M TR, B LUE AN H kAR s

BESE I ADE % QA
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Virtuoso?Analog Design Environment (1) e ——

Status: Ready T=27 C Simulator: spectre 3
Session Setup Analyses Variables Outputs Simulation Results Tools Help
Design fAnalyses _%
# Ar [ P Enabl
Library RF lib e grments © :?rfnu
cell foldedCascode 1 ac 1 16 Anto.. Star.. yes -oe
2  tram 1] S cons. . no 19 .i.
View  schematic ; e
Design Variables Outputs [E:
#  Name Value #  Name/Signal/Expr Value Plot Save March )‘}/
1 idc 20n 1 vout yes allv no
2 wss -3
3 vdd 3 E
4 wppsrr 0
5 wmpssr 0
6  cmrr 1]
7 acIn 1 Plotting mode: Replace
. A%
[ 10. 28
H= AN
i FE

XA Al F 2 2 B S A5 . PMOS T NMOS 1) 22 73 il A 25 RS2 ST o,
i A77E T H 3% multipleModelLib T

NMOS & Z R A7 AE

CORNERS/multipleModelLib/nmosLib.scs

Hx'F, WAL

library nmosLib

section nom
include "../nmos/typ/nmos.scs"
endsection

section fast
include "../nmos/fast/nmos.scs"
endsection

section slow
include "../nmos/slow/nmos.scs
endsection

endlibrary

WRFFEL, AT LR AR S B HRA X N SO b s ABAERX M7 24, T2 1 SEBr
B BBAE T AR SO, Tl il — AN RSO AT 5

../nmos/typ/nmos.scs & nom — 11 PG FRARISCIE, B T &) NMOS B S 4. 1%
AFNFE

simulator lang=spice

* VTI Level=2 slowN/slowP model
-.model nmos nmos level=2

+ vto = 0.9

+ tox = 430e-10

+ nsub = 1.0e+16
+ xj = 0.15U

*+ Id = 0.20U

+ Id = 0.075U

+ u0 = 620

+ ucrit = 0.62e5
+ uexp = 0.125

+ vmax = 5.1le4
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+ neff = 4.0

+ delta = 1.4

+ rsh = 38

+ cgso = 2.10e-10
+ cgdo = 2.10e-10
+ cj = 215U

+ cjsw = 540P

+ mj = 0.76

+ mjsw = 0.30

+ pb = 0.8

FHN 2 A TSI A BB ATZ A ESR L

10.5.3 T2 EEXH (PCF)

XA U A DCF, Frf MR &M — 4 PCF X X, X4 2
multipleModelLib.pcf. %0 & CAFN 200 :

corAddProcess( "multipleModelLib"™ "./CORNERS/multipleModelLib"
"multipleModellLib )

corAddProcessVar( "multipleModelLib™ "vdd" )

corAddProcessVar( "multipleModelLib™ "vss™ )

corAddDesignVar( "Cload" )

corAddGroupAndVariantChoices( "multipleModelLib"™ "pmosLib.scs"
"("slow" "nom"™ "fast'™) )

corAddGroupAndVariantChoices( "multipleModelLib"™ "nmosLib.scs"
"("slow" "nom"™ "fast'™) )

corAddCorner( "multipleModelLib™ *"slowslow" )

corSetCornerGroupVariant( "multipleModelLib" "slowslow"
nmosLib.scs”™ "slow" )

corSetCornerGroupVariant( "multipleModelLib" "slowslow"
"pmosLib.scs™ "slow" )

corSetCornerNomTempVal ( "multipleModelLib™ "'slowslow"™ 27 )

corSetCornerRunTempVal ( "multipleModelLib™ "slowslow"™ 125 )

corSetCornerVarVal( "multipleModelLib™ "slowslow"™ "Cload" '260f" )

corSetCornerVarVal( "multipleModelLib™ "slowslow" "vss" "-2.7" )

corSetCornerVarVal( "multipleModelLib"™ "slowslow" "vdd" "2.7" )

corAddCorner( "multipleModelLib™ "fastslow" )

corSetCornerGroupVariant( "multipleModelLib" "fastslow"
"nmosLib.scs”™ "slow" )

corSetCornerGroupVariant( "multipleModelLib" "fastslow"
"pmosLib.scs"™ "fast" )

corSetCornerNomTempVal ( "multipleModelLib" "fastslow"™ '27" )

corSetCornerRunTempVal ( "multipleModelLib™ "fastslow" 27 )

corSetCornerVarVal( "multipleModelLib™ "fastslow™ "Cload™ '200f" )

corSetCornerVarVal( "multipleModelLib™ "fastslow" "vss'" "-3" )

corSetCornerVarVal( "multipleModelLib™ "fastslow" "vdd" "3" )

corAddCorner( "multipleModelLib™ "typtyp" )

corSetCornerGroupVariant( "multipleModelLib™ "typtyp"™ "nmosLib.scs"

“nom™ )
corSetCornerGroupVariant( "multipleModelLib™ "typtyp"™ *"pmosLib.scs"
“nom™ )

corSetCornerNomTempVal ( "multipleModelLib™ "typtyp"” 27 )
corSetCornerRunTempVal ( "multipleModelLib™ "typtyp" 27 )
corSetCornerVarVal( "multipleModelLib™ "typtyp' "‘Cload"™ "200f" )
corSetCornerVarVal( "multipleModelLib™ "typtyp" "vss" "-3" )
corSetCornerVarVal( "multipleModelLib™ "typtyp" "vdd" "3" )
corAddCorner( "multipleModelLib" "slowfast" )
corSetCornerGroupVariant( "multipleModelLib"™ "slowfast"
"nmosLib.scs" "fast" )
corSetCornerGroupVariant( "multipleModelLib"™ "slowfast"
"pmosLib.scs" "slow" )
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corSetCornerNomTempVal ( "multipleModelLib™ *"slowfast™ 27" )

corSetCornerRunTempVal ( "multipleModelLib™ "slowfast™ 27 )

corSetCornerVarVal( "multipleModelLib™ "slowfast™ "Cload"™ '"200f" )

corSetCornerVarVal( "multipleModelLib™ "slowfast" "vss'" "-3" )

corSetCornerVarVal( "multipleModelLib”™ "slowfast™ "vdd" "3" )

corAddCorner( "multipleModelLib" "fastfast" )

corSetCornerGroupVariant( "multipleModelLib" "fastfast"
"nmosLib.scs" "fast" )

corSetCornerGroupVariant( "multipleModelLib"™ "fastfast"
"pmosLib.scs™ "fast" )

corSetCornerNomTempVal ( "multipleModelLib™ *"fastfast" 27 )

corSetCornerRunTempVal ( "multipleModelLib" "fastfast" -55 )

corSetCornerVarVal( "multipleModelLib™ "fastfast” "Cload™ "160f" )

corSetCornerVarVal( "multipleModelLib" "fastfast" "vss" "-3.3" )

corSetCornerVarVal( "multipleModelLib"™ "fastfast" "vdd" "3.3" )

corAddMeas( "'DCgain™ )

corSetMeasExpression( "DCgain" "ymax(db20(VF("/vout™)))" )

corSetMeasTarget( "DCgain™ 60 )

corSetMeasEnabled( "DCgain™ t )

corSetMeasGraphicalOn( ""DCgain™ t )

corSetMeasTextualOn( "DCgain™ nil )

corAddMeas( "‘bandwidth™ )

corSetMeasExpression( "bandwidth” "bandwidth(VF("/vout®™) 3 "low")" )

corSetMeasEnabled( "bandwidth™ t )

corSetMeasGraphicalOn( "bandwidth™ t )

corSetMeasTextualOn( "bandwidth™ nil )

corAddMeas( ''gain' )

corSetMeasExpression( '‘gain' "dB20(VF(*/vout®))" )

corSetMeasEnabled( "'gain" t )

corSetMeasGraphicalOn( "gain™ t )

corSetMeasTextualOn( "gain" nil )

corAddMeas( "‘phase’ )

corSetMeasExpression( ''phase" "phase(VF("/vout®))" )

corSetMeasEnabled( "phase™ t )

corSetMeasGraphicalOn( "phase"™ t )

corSetMeasTextualOn( "phase" nil )

T 7E.cdsint XHFRCE T HBEA
loadPcf( "~/multipleModelLib.pcf" )
TER B T EM g, XA~ PCF 3Xff<s AhEN, i T L2 M0 5P,

10.5.4 HEFEFHEZE A PCF il DCF XX 44

LR AT LU BB S 2 PDF #1 DCF 3 A
1. #EF’File”>”Load”
W CELE TAEM T E T1ES, & HIL “Save Changes” — {47 B UM HE

Save Changes?

Save changes before Load?

| Save || Save As.. || Don't Save || Cancel Load |

& 10. 29
2. fidirSavemi#FSave As”IRAEHCE K H M, W R AL, HEEI N PCE Ml DCF, A
ili”’Don’t Save”; Aiili”Cancel Load UM e A, (R B AT HC &'
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—| Load |
Lookn: | (7 Artst MiCIEIEIE =
Narne [ size | Modified []
3 adsLib 5/19/03 6:26 PM -
T aptivia 7430103 3:20 PM
3 Controlled_source 8M8I03 652 FM
9 CORNERS 4129103 3:07 AM
] examples 7130/03 340 PM
7 exarmples_ride 5/19/03 6:17 PM ||
File Name: | |
Files of Type: | AllFiles v|
| Load | | Cancel |
[# 10. 30

LRI LA B 1 4% windows (SO BlLAS o RAF ARSI HLEA RN 4.
FEILH R E F5 ERATCA, ik “Load” BIWTEA; 0] LUl Cancel ™% HLHGH -

10.5.5 TZ A E O

1F ADE TiEFE3E B Tools”>Corners”, LMW E D E .
I T 2400018 T, multipleModelLib.pef X C4 BhE N, 78 L 200 i L ik
T H A& SR
® TR E temp MMEENINN 27, WURZLREHBIRE, TR SN, o 7Rl E S
f-H {5 H Ay 4> corSetCornerRunTemp Val
® Jiifift ADE " X # ey e A, [FNILA 2845 PCF g i .
3 P15 v B R (T
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Yirtuoso (R) Analog Corners Analysis: Lib/Cellf¥Wiew: RF_libffoldedCascode/schematic

File Edit Setup Simulation Tools Help

Process: | multipleModelLib v| Base Directory: ./ CORNERS, multipleModelLib

Corner Definitions

N slowes o fastslom Tyt | slowfast fastfast
pmaoslib.scs slow fast normn slowy fast
nmasLib. scs slow slow normn fast fast

temp 125 27 27 27 -55
wild 2.7 3 3 E S
WSS -2.7 =3 -3 -3 =3.3

Cload 2607 200f 200f 2007 160f

| Add Corner || Add Yariable || Copy Corner | Disable Run

Performance Measurements

Measurement | Expression | Target | Lower | Upper | Plat | Print|
phase phasey F* fvout) v |
Outputl Fvout v | O
DCgain ymax (db2 O(vF(' hvaut™)) 0 b | [
bandicith bandwicth (¢ vout 2 "low') v | [
gain dB2 O0/F( Avout™y) v | [

D

| Add Measurement Calculator... Plot/ Print

2

[# 10. 31

10.5.6 B EHHE

TR T T B AR IR 58 SCIF IR o AEIX AN Al L, 75 8R A5 S T B csoR g i — 2858
o, EAE A B I R BRA H BRI T

1. Hith4, DCgain Hil bandwidth PITUEARE, o EURHRERTEA LR, ®E:
DCgain: HAr=63,  FB=60,  L[¥=65
Bandwidth: H#5r=200k, FM=130k, _LFR=350k

2. BRT Outputl, RFAHHAGENE BT Outputl g

3. WA LZM. b O &N IEH R

4. S B Run #8535 5% 1 Simulation” = ”Run”

GHSEUE
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Expressions 1 m Expressions 2 E

- C="fastfast";gain - C="slowslow";gain - C="fastfast";phase - C="slowslow”";phase
—~ C="slowfast";gain — C="fastslow";gain — _="slowfast";phase - C="fastslow";phase
C="typtva"; gain C="typtyn";phase
80 [ 25.0 I
&0 7 T
= 40 9
= o
= 204 o S-TF5.0
2 0+ \\ g
_20_
—40 T T T T T T T T 1 —1?5 T T T T T T T T T L
109 101 102 102 10% 10% 10° 107 108 10% 109 101 102 102 10% 10% 10° 107 108 10
freq (Hz) freq (Hz)
Residual Plat - bandwicith Residual Plot - DiZgain H
— C="fastfast";bandwidth — C="fastfast";DCgain — C="slowslow";DCgain

— C="slowfast";DCgain  — C="fastslow";DCaain
C="typryn';DCgain

— C="slowslow”; bandwidth
— C="slowfast", bandwidth

325
I
659 ul und—

617 )ower bound
T T

0 1 2 3 4 5 &

[# 10. 32
Phase Al Gain iyt i 107 B4 RS 2, BT Dl O R th 2 i O T 3. i R Ay SR PR a0 56

=

NP, ATBAE Wavescan FISE L Eik$¢: “Graph”->”Layout”>"Card”, W|—&X A& BR—NF

B,y RLad s B B AR A R T R T 1
Expressions 1 I?I?EITI

—~ C="fastfast";gain - C="slowslow";gain — C="slowfast";gain -« C="fastslow";gain C="typtuyp";gain

80

60

40

20

—20

0 (dlE)
T

-4 T T T T T T T T
100 10l 102 102 104 10° 10° 107 108 108

freq (Hz)

[# 10. 33
AT EIA LA AR OARBARIZ R 4 DT RS A B LS
fastfast 715 MU B K IE 23 A1 585 slowslow W IEAR B2
PR PIMARZE, .
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Jal FHER

— C="fastfast";DCgain — C="slowslow";DCgain — C="slowfast";DCgain  — C="fastslow";DCgain
— C="nyptyp"; DiCgain

B

65

64

[y

[

)DWEI’ hound
T

&0 T T T

E 4 5 6
*0 0
A& 10. 34
MATRT LRSS HY: fastfast Fil slowfast ) DCgain $ibr O 288 T LR,
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%11 FE BB (Optimization)

11.1 LB E R FNE A TIE[RIE

Pl @& —mhidad B 2R &, IR BB R FR 10 A o SEBAX AN A 1 T R A
k4% (Optimizer). 0 F UL = H S5, ¥ — Dl Re 2R v 2Tk,
TS A2 BT 223K

AW TR HL R VU T8 AN BRI AL T I Ber AR o s SOBOR AR 1A AN, B L
WITITUREANE , £ —S0r e 5 FANREIE T TAE o 5 v DU I A28 1 2 B ff YU 26 )
W, AHJE AR Z B 5 S Bkt — ANt i), ARAEARAE . it oy DUR LA BE(E R, AT3RTS
B AR R T %

XA, TR — RIS IR E ARG, DU S Ak 88 15 5t
S UH B R TR R ) B AR B AT R 0 R RTA R s AR5 TR BT R E, AERIA A
A HAMESET; (ERFRSCE R RS G, #CK T R AT — IR 3G, SRR il S 2 15 i
SRR WAL, K R . BUT SRR A A% ) AR R

1) Ak el vt 22 B AR AT — OB B AR e xR R IA )

KT E -
2) Pepds e A TR AL . CUn SR P e )
® 1SQ (Least Square) BVEIG SR M) AWK BA LR B HEATIAL .
G, AR A0 SR R e e S, et — AN R DR A, XM R
JriEH .
® (CFSQP (C version Feasible Sequential Quadratic Programming) % F K& L4k In] @
IR, AR ARSKAT BT LR, R /MUK, DR B G
PRI LA S o ltun, vt —AMICHR A TBOR A% 75 BT fs oK 11 i A I /N )
RS, LA 45 BERIAHAIAR L, XA ARkt o id H
3) WA CFSQP &k, AT 5, KNX B & A E &S
WE BT IZR, WAL, AP o B B G0 1 AR A
4) AR o Gk A A AR R UKL . A T EBURRE, i — A
BT AR AT N AR, ARG FRIEAT — IR
5) FIHBURE T IE R, Peteds ot 2 sk 55—
6) PR b I F IS Bt AR i, AR R L AT
WA E G RAT bk, AR EE S 5 40,
WA R S5 AT B, IBALESE 5 0 TR B H SR M IR VR AT Aa M E N N — 41
e
7 WEARAAF LR HER A IR R, A T —RAEIR M 4 IS
PACKEAE T LA A R A I
® 7iiE SO B HORIEHE A A (AR, B AR
o Uil EME— AR BT IER

N AR AN IR AR OB T, R4 “ Optimizer” (K148
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11.2 “Optimization” BI{F5TEREIEE

“ Optimization ” ) {Jj BLER 55 . 45 FL AL ¥ & o] B 4 M “ Virtuoso® Analog Design
Environment” (ADE) 1§44,

HAE, BAEH— AR EEE, B — NMOS &, — A, — AR
Po BATEMASBIRIEPIRDN, NMOS & IMHC RN 58, FREAE DL A W o it AR &, 4y
W4 k. “VYDD”, “VG”, “W_N”, “L_N”, “res”, “cap”. W& 11.1 fiz~

Yirtuoso?Schematic Editing: Cadance Optimizer schematic — ¥irtuoso?Analog Design Environment (1) E]
Omd: Sel: 0 Status: Ready T=27 C Simulator: spectre 2

Tools Design Window Edit Add Check Sheet Options Help

D)2 % K]

DN TS

—

L
£ |

mouse L: schSingleSelectPt() M: schHiMousePopUp () E:sevAnnotateResults (' sevSessionl ‘de

2 [ ¢ \E

B 111 PR RO F

$TIF ADE G 1. 30055 | SRR B BRSO, I B b 3R A 4 R — M
{8 . BB % LA bR A S R 25 . TS 2 AR B “AC”, FFRHBRHEATH
Wi, FIHVEIE ) 1~10M Hzo A5G AT PRI BRI . BB RY “ADE” %10 112 F
A
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Yirtuo=zo?Analog Design Environment (1) E@g

Status: Ready T=27 C Simulator: spectre 3
Jession Setup Analyses Vanables Outputs Simulation HResults Tools Help
Design Analyses _%
. # Type Brguments. . ... ... L. Enable | .
Library Cadance St
call Optimizer 1 ac 1 10M Auto. . Star. . yes -oc
=
- Tl
View  schematic nEY
Design Variables Outputs D;Ej
#  Hame Value #  Name/Signal /Expr Value Plot Sawe March )-D/
1  cap 1n 1 gain WAVE yes
2 WN 1n
] 2 E
4 vOD 5
5 res 1E
E LN 1u
Fotting mode: Replace [
= 3elect on Schematic Qutputs to Be Plotted

B 11.2 ¥ “AC” TR B ENEE

K113 B e LRI R, PO e AR . AT DUR BB 88 25 /N T 1. £
JEIFI N2, A “Optimization”, ¥R 55 KT 20dB, 3dB ir %6 KT 100Hz [FILYR
Y N

Cadance Optimizer schematic : Feb 26 21:00:01 2007 [37]

File Edit Graph Axis Trace Marker Zoom Tools Help
= Rak: (i & [+~]Label | |

AL Response m

dB200 )

167 10l 1602 108 10 10° 1607 107
freq (Hz)

#[> graph-1 selected: double-click to bring up attribute dialog.
B 11.2 fFH “Optimization” FjH] AC FE& R

182



11.3 “Optimization” B9ENFIXEH

fE “ADE” W% “Tools=>Optimization”, Wi 11.4 7R

¥irtuoso?Analog Design Enwironment (1) |_||E|f$_(|
Status: Ready T=27 C Simulator: spectre 3
Session Setup Analyses Variables Outputs Simulation Results Tools Help
) Parametric Analysis ...
Design Analyses
Comers ...
* B s
Library Cadance Type ElgLhiEes Monte Caro ...
Optimization ...
Cell Optimizer 1 ac 1 1om Euto. RF I
View  schematic Calculator ...
) i Results Browser ...
Desigh Variables Outputs
Waveform ...
#  Name Walue #  Name/Signal/Expr Value  F Results Display ...
1 cap 1u 1 gain wave % 1D AT o
2 WHN 1u
3 Vo 2 ﬁ
4 ¥ID 5
5 res 1E
& LW 1u |

Plotting mode:  Replace | | k,\,{‘

= Select on Schematic Outputs to Be Plotted

B 11.4 “Optimizer” KJE3h777%

BB “ Virtuoso® Analog Circuit Optimizer ” 7 UK 230 H, @ 11.5 Frox. %%
“Session>Quit” KB HIZE .

¥irtuoso?Analogy Circuit Optimizer

Status: Ready A0

Session Goals Variables Optimizer Results
Goals

#  Name Direction Target Initial Prew Current Enabled
Variahles

#  Name Min Macs Initial Prev Current Enabled

A 11.5 “Virtuoso® Analog Circuit Optimizer” %
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11.4 “Virtuoso® Analog Circuit Optimizer” & O& ¢

Yirtuoso?Analog Circuit Optimizer (1) : Cadance ... g@@

State Display > Status: Ready 4
Menu - Session Goals Variables Optimizer Results Help
Goals @
# Name Direction Target Initial Prev Current Enabled e
Tl
Xyz
Goals Pane > j/
Variables
# Name Min Mack Initial Prev cCurrent Enabled
Variables Pane > E
A

Tool Bar

B 11.6 “Virtuoso® Analog Circuit Optimizer” & 0 %

K] 11.6 /& “Virtuoso® Analog Circuit Optimizer” % 1, LS 5 AN TAEX: “Status Display”,
“Menu”, “Goals Pane”, “Variables Pane” F1 “Tool Bar”,

11.4.1 “Status Display”

7. “Status Display” 57 (4 AT AL AR FTAR K TARRES . #1ln, “Status Display” ")k
IR AR AEREAT O 30, AU A T HAR I AR RS .

11.4.2 “Menu”

session Goals Varables Optimizer Results Help

Bl 11.7 “Menu” FHZ

“Menu” P THLAGHESR, BEATIRAL, Bos a8 R 24, R 11140 T “Menu”
HAAS T S L B AR ERAE

® 111 RENAES BABRE
DI I HAR$RAE

Session

184



Save State TRAF TR ) B

Load State B AR )

Save Script TS I BEE LA Ocean JEIAS 1) U AR A7

Option & A AL 3% I

Reset TR P A v

Quit KM “Virtuoso® Analog Circuit Optimizer” %
Goals

Retrieve Output

F¢ ADE HP BB 07 B H A R 5

FLAER BTN %, B “Waveform Calculator” 8 g it

Add
%
Edit LR
Delete IH g X
Enable SANERIE &
Disable LIPS
\Variables
Add/Edit NI TR 7 eV
Delete I v AR
Enable AR AR
Disable KRBT AR
LA 2%
Run BTN B IVTAE T4, ERE B bRk
Step BATRAE NI I —AME 1L TSR, BT R3S Ja s 1k
Run n BATRAC MBI ) — AN R S TP, BT E RE n TR
Stop TEMTAIEIR e G, s 1bife
Stop Now By A5 Ak, AT DAAS L 58 B4 IR BR
Reset BT 40T EL45 AR I, a5, W28 BR s ¥ B AR AN
/E
Result
Plot History o A AR
Set Plot Options WE BRI
Update Design SRt
Help
Contents FTIFAE LRI 3 B SRy

Optimization

About Analog Circuit

R BRI AT B ARARAS 5
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11.4.3 “Goals Pane”

Goals
#  Mame Direction Target Initial Prew Current Enabled
1 gain maximize 20 YES
2  bandwidth = 100 YES

A 11.8

“Goals Pane” WK 11.8 iz, 7 “Goals Pane” W ALF T 480 & XA G IME R, BARN R IR
11.2,

F 112 “Goals Pane” AR 5ThRE
i H iRe

Name X GIR T AR

Direction £05 LA R LA % £5:maximize, minimize, match,>=8{# <=

1) 1 Direction /& match, IAMiibgsls<s F UL —
A BRI B B D .
2) 415 Direction J& maximize 263 minimize, I4—4

FLAR 0 8008 B0 B B K & Yo 0 R B

Target 3) 14 Direction f&>=, 4 — Lk I8t 2 9%
$a ot TR,
4) W% Direction J&<=, 4 —ANBARREEBE W T
g 1R,

Initial L B AR G (AT 55 A 1

oo gt L R ER TP B A B O LT -t i 5
st

Current 7R T BT AR R T VS LR RN SR AR S

R yes B no. yes R XA R AL E A G LA

Enable .
no 2.
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11.4.4 “Variables Pane”

Variables
#  HName Min M=z Initial Frewv Current Enabled
1 res 100 10M 1E Yes

B 11.9 “Variables Pane” &
{E “Variables Pane” " €L T 475 e iR E2MFEE, RARNENLEK 11.3

£ 11.3 “Variables Pane” TN A5 IhfE

ok Dt

Name B AR T AR

[Min W AR T R

[Max VA ARG F IR

Initial W AR B AR E

Prev SR UG R AR A

Current s Y T IR TR A = A A e

Enable B yes B no.  yes FoRIXAN BV AL B A LA S ETAL
T B, no R2Z.

11.4.5 “Tool Bar”

Tool Bar A5 (R SCBL T UM e EEEL N Th g o $2 JHOH (A FU #cBE AN L3 T 4
A, AKIKN -

@

s WI/gmEEXRT % (Add/Edit Goals)

b
-
|

s WRI/gmEE AR B (Add/Edit Variables)

11173 (Delete)

CECIEAN

A TOUEE (Run Ak

o fFIEdE (Stop AL
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I/—V‘ : ot iRE (Plot History)

_% : BBkl (Update Design)

11.5 BTk
TH N EBNFEITIA R 4 NEEDIE,

11.5.1 B X%

TEIBATIRA LT i, AU ARAL RN 23 A1 8 L— Ao WG4 5 R T JLAMRFAE :
® X G ek A ] LI i 1 B i — N B B R .

® NG REAXAMAHBMM T . (UL 11.4.3 “Direction”)

BN, FILIRGIBORAS AR 1Hz S T S 2 e fr et %, /7 2ian ik K.

dB20(value(VF ("/OUT") 1))

PAT B MR, A THAEERM A, WRET 0k maximize. N A4 LR
X GIIT

11.5.1.1 ¥ e bt 5

1) 7E“Virtuoso® Analog Circuit Optimizer” & I 5% FL 1 £ $F “ Goals—> Retrieve Outputs”.
RJGAE “ADE” & L i, FAE N GAREAE “Goals Pane” 1, XA
GERNGERMAM, RIFE “Enable” 4R “no”s & 11.10 A 11.11 2050 WoR T
BRAEFIRAES R .
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Yirtuoso?Analog Circuit Optimizer (2) : Cadance ... |Z||E|rzl
Status: Ready 7

Session Goals |Varables Optimizer Results
Retrieve Outputs ...

Goals

Hame gigid | arget Initial Prev  Current Ensbled

£
Darderis
£
H

#  HName Min Maz Initial Prev Current Enabled

EHaE

Heni

Variables

B 11.10 K iiEmHE RS

Yirtuoso?Analog Circuit Optimizer (2) : Cadance ... |T||E|r§|

Status: Ready 7
Session Goals Variables Optimizer Results

Goals
#  HName Direction Target Initial Prev  Current Enabled
1 galn no
Varables

#  HName Min Maz Initial Prev Current Enabled

Bl 11.11 “gain” A5
2) EHXE “gain”, BERIXIFR S, RIFIEFE “Goals>Edit”, X% LR E,
G Gt o O B AR L 11.5.1.3,
3)  FEIEME 11.5.1.3 BRGNS g G, RIS T — Nt 5.

HER: HEIGE TN “ADE” & I RSN S, WA N “ADE” fi A f ) 2RIA X

MRBGEK . FF HAESR 22 %5, ©EFE “Goal>Retrieve Outputs” Bf AN 244 G i lATA7] 5%
.
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11.5.1.2 HESMA—NFRISTZ/FIHE “Waveform Calculator” B S — A HKIFT 5

1) #E# “Goals>Add”, 8 fiili “Tool Bar” H1[f] “Add/Edit Goals”, “Adding Goal”

Adding Goals — Virtuoso?Analog Circumit Optimi... @

0K Cancel| Apply | Help‘
Hame II |I
Expression |
Calculator Open | Get Expressiun| Cluse|
Direction minimize
Target |
Acceptable | _| % writhin Target
Enahled | |

K 11.12 “Adding Goal” &1
2) 1 “Name” FLHIHANTRALFR;
3) HFEEAPIINS: 7E “Expression” £2H14% i Cadence® SKILL & 5 &k G
HANBINFEA . BEAXTTLUE A, W2 —NE. GEn Bk
T4
FIH “Waveform Calculator” &3 —ASHT X e it “Open” $24#, JLi “Calculator”
[ARE
4) MHAES 12 ZH) 79, 1E “ Waveform Calculator” H g Sz i 22 () &35 2. &l 11.13
IR THE “Waveform Calculator” ZR#F YA B AS 3dB 417 v R IA

Calculator E@

Window Tools Memories Const Options Help

no data set
(wan ["ac [de [ sweptdc [ info [ noise ['rf |
Family [¥] Select Mode [¥] ® wf O if |
bandwidth/F¢'f OUT 3 "low™) | -
~bandwidth
|A|J|Jend hd [ | ‘
| Clear || Undo || Eval | Slgnal|‘v’F(‘fOUT) |
[ @ || eex || cist || Enter | Db 2 |
| + || 7 || ] || 9 | Tvpe|luw 'l
- 4 Js |6 |
Lx |2 J 2 || 3 |
L e J . e
| B | Ok || Cancel || Apply || Defaults || S |
. [cadence]

B 11.13 7Z£ “Waveform Calculator” PENFTFERNRIER
5) FHERrFEIA] “ Virtuoso® Analog Circuit Optimizer” % I H ) “Expression” 4%,

6) kiili “Get Expression” f%#8#, MIN7E “Waveform Calculator” 1)1k w0k AE
“Expression” £2HH L, 1E AN S IFREL;
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7) 1t “Direction” FHEHH, BN R FIAA MMEAA LR AR ES . Bk
IR 11.4.3;
8) 1F “Target” £ 4% Cadence® SKILL i 5 MIRIAAMVEE N HirRIAA . 8034
KOEhr#% 2 “Target” #2rh, %M 4~6 LI 7L “Waveform Calculator” 313 H bx
(ESYNW
HER: WRAE 3. 6 DHRBINRIRIEAE —Mrg, A HIsMERE 22
— M. RZ, WARMNBMRIELE MBI, Ba BFrMERE WS — N
9) 7t “Acceptable” FIEAMALK SRV . 78 11.5.1.6 H HARRRULALAE I Wi R
X G AAL SR VG R e A SAR S 1) o 3X B R ke SOX—AME .
® 1JLUI7E “Acceptable” £ HEIHASRF G Cadence® SKILL i 5 Flya R IA
BRI 4~6 BB T “Waveform Calculator” F 3RS RIEF.
HER: WA 3. 6 DB RIMRIEALE —Mrg, M2 BirfRIEAE
TR — M WA R RIS —MEE, 4 Hbrpgik X o] LUE—MEOE,
W L — AR .
W ARVHEHEE — M, I AT 202 N 2K iR e vria B2 — MR,
I AIXAPETE bR — s AR LR 11.4 12K,

R 1.4 AT 17 R A&

7 I R AC T W 2o v A A

(Direction)

minimize WAL H bR ik UK

maximize WAL H AR IR A B/
B T HArak sSCCAAMRAT I o 53 AR T A vr i 2

match TERIGE O, VG FBRBOR AT s B L H AR I8
K, BUEAEAT] A AR EE H AR EIE N

= WA E H AR I A IE /N

<= WAL H AR IA A IME K

® UIREFET “% wihin Target”, nJLAYE “Acceptable” #2HifiE — MR EL#H
BRI E 73t — AN/ NI 43 B it B AN S 56 200 5
HR: WERAEE 3. 6 D RBINRIRIAAE—Mrm, 2 HirfRIAAE
T i WA RN RIE AR —NETE, B4 HARI R ] DUE — MR,
WA U — MR
WHRAH T —AbrE o, B4 R R AR I 45 SR AE H R R FIAR /N R A5 2
AR AR T AN BE E A b, DTV B R WA S B A A B
HEEE,

10) AR ZAE TR L iz 5, WEEE S “Enabled” 4%,

1) i “OK” B x5 A% “Virtuoso®Analog Circuit Optimizer” % 1111,

Bl 1114 5on T DIISIRBORAR (47 58 X 5, H AR 4 58K 100Hz, A6 LV R 2%

MR E -
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Adding Goals — Virtuoso?Analog Circuat Optima. .. &l

Ok Cant:el| Apply ‘ Help
Hame |banc1wic1t1i_
Expression |baﬂ'ﬂWidthWF("!DUT") 3 "Low" )
Calculator Open | Get Expressiun‘ Cluse|
Direction E= =
Target |1UEF:.
Acceptable 2 B % within Target
Enabled |

B 11.14 DAL A% B H 52 A AL 5 g B B

K 11,15 B T 1114 & Z X % A 2] “ Virtuoso® Analog Circuit Optimizer” % I 5 II- L o

Yirtuoso?Analog Circuit Optimizer (1) : Cadance ... |Z||Elg|

Status: Ready 4

Session Goals Varables Optimizer Resulls Help
Goals @
#  Naome Direction Target Initial Prev Current Enabled EE
T+
1 gain no xrz
2 bandwidth 3= 100 ves y/
variables

#  Hame Min i Initial Prev Current Ensbled

A 11.15 HERIXNZEMAZ “Virtuoso® Analog Circuit Optimizer” & 5 HH L

11.5.1.3 gEiib s

1) 7E “Virtuoso® Analog Circuit Optimizer” 7 H % £ 77 BRI % . X3k k9
FISEE TN o

2) IEFE “Goals DEdit”, B(# ritli “Tool Bar” H1f#] “ Add/Edit Goals” #%4# . 1X I “Editing
Goals” 7 ¥ . BT H A FK, XN LA “Adding Goals” i I1—Ff.

3) EFBFRN “gain”, HIM “ADE” & RGNS, ARG M “Add/Edit Goals” %
B A D 11.16 iR
R 115100 3~10 25 B4 7 vE w5 %« S o (1) Editing Goals & W11 11.16
7R o
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Editing Goals #1 —— Virtuoso?Analog Circuit Op... rs_<|

0K ‘ Cancel| Apply | Help‘
Hame |'§fai1f.
Expression |'5520(V&lu3 (VE (" AOUT") 133
Calculator Open | Get Expressiun| CIDSE|
Direction maximize —
Target. |2':E
Acceptable | W % within Target
Enahled 1
B 11.16 gAML S O

4) g “OK”, RBLUEFERIX G Eauie, Wik 11.17

¥Yirtuoso?Analog Circuit Optimizer (1) : Cadance

Status: Ready 4
Session Goals Varables Optimizer Results Help
Goals @
#  Name Direction Target Initial Prev Current Enshled |-
727
1 gain maximize 20 yes Xz
2  bandwidth 3= 100 ves y
variables
#  Hame Min Mazx Initial Prev Current Enabled

B 11.17 FHEERReT S E D
11.5.1.4 BRI 5

1) {E “Virtuoso® Analog Circuit Optimizer” 7 I H ZERETF EMIBR AT G o X Gk b s K b
rse N e BIAER] 11,18 e 7 LLELZROK a7 0 A B A .
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Yirtuoso?Analog Circuit Optimizer (1) : Cadance ... T”E|§|
Status: Ready

Session Goals Variahles Optimizer Resulis

T
g
EH

Retrieve Qutputs ...
Goals
Add ...
#  Name Edit ... arget TInitial Prew  Current Ensbled K
— Delete 1 I
1  gain 0 ves

Enahle
Disahle

RIS

Variables
#  Name Min Mazx Initial Prev Gurrent Enabled
& 11.18 MR 5 &0

2) & “Goals >Delete” W 11.18 i, B fiihi “Tool Bar” H1[1] “Delete” %% .
K 11.19 Bon T RS G 5 “ Virtuoso® Analog Circuit Optimizer” % [ o

¥irtuoso?Analog Circuit Optimizer (1) : Cadance ... |T||E|§|

Status: Ready 4
Session Goals Variables Optimizer Resulis

Goals
#  Name Direction Target Initial Prev Current Enabled
1 gain maximize 20 yes xrz
Variables

#  Hame Min Maze Initial Prev Current Enabled

A 11.19 TR MRS “Virtuoso® Analog Circuit Optimizer” & 1
11.5.1.5 FFREHEKAMRUNE
1) £ “Virtuoso® Analog Circuit Optimizer” T I HIEREF5 EIF )3 B I . X5 ik

Ja K # s woR
2) #%F “Goals >Enable”, B# “Goals > Disable”.
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11.5.1.6 RALARANATAER H AR B b5 A VFG Bl (E

PACHAT IR IR HARMEL: A AL H s A SRR LU R 22 IT 9y
PR DL o

D) HARMEE A S e H oz

APACTT 1 E O match, >= B0 <= I, HARMEAE A G H AR I S0 =

HAREAS P P 2 B e 4 4 2R

AP TT [ E s “minimize” I, DU AR IFAN S U GRS RE /N H AR M43 14

A, MRS U) Al REE X G ARGE S/, £ 22 B EO SR e A i /T H bR

FIRES LA T 10 A “maximize” I, PEAb @ 0 SRIEXMERTRERR, Haiaa

KT HbME. PATT ) 5 EEE B e A 45 3% 11.5 s

RI1L.5 AT RS EXB K RALR

& X IARAL T 7] (Direction) P 2% 20 o % 2Rk 2 e

match A HARME— 2L

= W H ARk K

<= WG H ARk U /S

minimize AN HARME, RS FE X PER T B/
maximize ANEHBME, A FRIEXIER TR

VER: YR LSQ HiLH, MALBALSIX S “match”, “minimize” Al “maximize”. iiL#%
S AN Gk A B A A H AR — 3
2)  HAEE AR SRR R RE

P TT € K “minimize” A “maximize” I, HAERMEE NSNS AL LA 1I1E
FH SN 2 o AEIX P RRE GL T B AR A A S V38 AR A AR A AN X S AT S e A R
AXTE), AERAGTT 10 match, >= i <= I, HARE [FINAE R0 G ik B bR 6 9
IR o

I G A ARV FME S SR HARERS, 120 S8 H R e . AU, 2 HARH
DA AVFIEFLE BB, PN 352 R0 G S m (e Se 42

Sbr b, RSB T i R RIS E (D, HARE (T MAavriaH

@KA>#§$%%:ﬁ%%%ﬁ%ﬂ%z&%oMWH?%Hﬁ%%%%%W%O
F11.6 WLTE 5 BAr

[Name Direction Target Value Acceptable Value
[power <= 50 mW 80 mW
delay <= 50 ns 60 ns

WRMFPIRE T, “power” MIRIANME AN 90 mW, FBAE I E !
90mwW —50mwW  40mwW
S0mW —50mW  30mW
WRMEPRES T, “delay” HIRIEXMEN 90 ns, IS AAh IR &
90ns —50ns _ 40ns —a

60ns—50ns 10ns

VBRI EOLF . “delay” A7 5 mIORCE . DIIRILAL S8R S0 “delay”, SR )5

=1.333
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TN “power”,

11.5.2 HEZWIIEZE

FEAT ARG AT A Z B, 52245 44 ML B oA ] AR AL ds e I R e . i
Wk BB AR A UL T A AL, BN S HOR S A IR 24, ST B
RUAC R, st AT AR RE R 56 1

11.5.2.1 HFin—ARi-RE
P, fE “Virtuoso® Analog Circuit Optimizer” 7 F s I 1148 1 .

1) E$¢ “Variables” - “Add/Edit” ##F S “Tool Bar” "1 “Add/Edit Variables” 4%
B, MR “Editing Variables” % H gt . Wil 11.20 fior.

Editing ¥ariables — Virtuoso?ZA. .. @

OK | Cancel| Apply Help

Optimization Varables Must Be Simulation Variables

Hame cap
WN
Vi
Yoo
res
Initial Yalue

Minimum Value

Maximum Value |I |

Enabled

Bl 11.20 #in— MR E
VERE: XTHE 1.4 B “Design Variables” =1 11.17 # “Name” £ZHHETEE, AL
BEIAATR B . X ULBRL BRI BT R Tt X &, #REAE “ADE” HHOH
e E Lo
2) fE “Name” £ oG BERRATT ZLR N BBV A8 5, Bk b B AR Sl b e B,
WK 11.21 1 “res” Wil .
3) {F “Initial Value” ¥ FIANLEDAGES, XA R TR E . X BAYAIEA — N ERAE,
RI{E ADE 7 Xz v R S IR e 1121 1, B8 “res” (WAIGHRTEA
“1k”, Ml “ADE” % I v &35
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Editing ¥ariables — Virtuoso?A... &|

0K ‘Can-::el| Apply

Help

Optimization Yariahles Must Be Simulation Varahles

Hame

Initial Value ‘ 1§

Minimum Yalue }

Maximum Value I |I

Enabled | |

Bl 11.21 EBEATLA{E AR
4) 4 “Minimum Value” HIELAN BRI, RALSKEANSA BRI EREENTT
B )
5) fF “Maximum Value” FIEN IR LR, S KEASS R I ERRENT L
B )
6)  WRALE LA A X AN BT AR B, T E “Enable” B gL
SERITA YR K “Editing Variables” % E1, WKl 11.22 Fis.

Editing ¥ariables — Virtuoso?A... &|

0K ‘Can-::el| Apply Help

Optimization Yariahles Must Be Simulation Varahles

Hame

Initial Value ‘ 1§

Minimum Value ‘ 1d

Maximum Value I 10M |I

Enabled | |

Bl 11.22 58 B BEATT 4R 18 R AEL T O 3

7) ,I{—:_I‘\l:_E‘ 113 OK ”»
SIS, WA BN N2 “ Virtuoso® Analog Circuit Optimizer” % HH, Wik 11.23 iR,
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YirtuosoZ?Analog Circuit Optimizer (1) :

Status: Ready .
Session Goals Varables Optimizer Resulis
Goals

#  Name Direction Target Initial Prew  Current Enabled
1 gain maximize 20 VES 1~rz
7
Variables
#  Name Min Maz Initial Prev Current Enabled |,
1 res 10 10M 1E VES g
._E;

A 11.23 ZEHFRINEH “Virtuoso® Analog Circuit Optimizer” & H

11.5.2.2 wEGRITE

E P, 76 “Virtuoso® Analog Circuit Optimizer” % H H gmiE i 2L & .

1) £ “Virtuoso® Analog Circuit Optimizer” 7 [ H LR B4k 2w, #kh ik

AR RS AR RN, ik 11.24.

¥irtuosoZAnalog Circuit Optimizer (1) : Cadance ... TIIEI['T(I

Status: Ready a
Session Goals Variables Oplimizer Results

Goals
#  Name Direction Target Initial Prew Current Enabled
1 gain maztimize 20 yes
Variahles

#  Hame Min Maz Initial Prev Current Enabled

2) EH  “Variables > Add/Edit”
, LI “Editing Variables” # LI, 4 11.25 B,

K 11.24 LEGEREE
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Editing ¥ariables — ¥irtuosoZA_ .. E

0K ‘ Cancel | Apply

Help‘

Optimization Varables Must Be Simulation Variahles

Hame

Initial Value

Enabled

Minimum Value | 13

Maximum Value I 10 |I

E

Bl 11.25 ZERERE
3) KA CAH KR, FIZE “Name” £ dignig il AR 2O 8 & s
1. WRAE “Name” FERE A —DRH LR, IBAKSHIN— MR ERI
e I 11.26 7R, 78 “Name” £Hik$e “VG”,

Editaing Yariablez — ¥irtuoso?A... ﬁ_(l

(0] .4 |Cant:el| Apply

Help

Optimization Yarables Must Be Simulation Varables

Hame

Initial Value

Minimum value

Maximum Yalue

Enabled

;

K 11.26 EFEH—NETE “VG”

4) At “Initial Value” #XHIHALEVLALIS, ZBAZEHITAA{E .
5) f£ “Minimum Value” FFIRABIAZEBPI IR, s A LSRR R E N T

PR ARIAE

6) fE “Maximum Value” FIHABLARF ) LR, UL s A Bt 2 e i d KT

PR ARIAE

7) A RARAE A P IR AN B AR R, T RE “Enable” FAg ik
SERITA YR ) “Editing Variables” %, WKl 11.27 Fis.
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Editing ¥ariables — ¥irtuoso?A... D_(|

0K ‘Can-::el| Apply

Help ‘

Optimization Yariables Must Be Simulation Varahles

Mame =R =

Initial Value | i

Minimum Value |1D"§.

KMaximum Yalue I4I |I

Enabled | |

K 11.27 T8 “VG” RERKEHN
8) ,‘{—:T\T—J_:f “OK”
BEIS, F “Virtuoso® Analog Circuit Optimizer” T I & T AR R g0, 4kl 11.28
TR o

Yirtuoso?Analog Circuit Optimizer (1) : Cadance ... |T||E|&|

Status: Ready 4
Session Goals Varables Optimizer Resulis

Goals
#  Name Direction Target Initial Prew Current Ensbled
1 gain minimize 20 yes
2 bandwidth minimize 100 ves
Variahles

#  Hame Min JLERS Initial Prew Current Ensbled
1 res 10 10H 1E yes
2 G 10m 4 1 yES

K 11.28 TEEEFHEND

11.5.2.3 BERBRIHZE
1) {E “Virtuoso® Analog Circuit Optimizer” 7 [ H LR EMIBR &I, il ARk

SRR T A T
2) iEFE “Variables >Delete”, BUH il “Tool Bar” W] “Delete” %% .
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11.5.2.4 FFR B R4 T 5

1) 7 “Virtuoso® Analog Circuit Optimizer” i I H e 21 )8 sioC M wot A& . &t
S R AT
2) MEH “Variables >Enable”, ¥ “Variables = Disable”,

11.5.3 Ak 2 a0¥H a4

5SRO G SCRITRE Bt A2 i Ja  MAs rT IR PEAL AT 7o 1 T (0 21 HheRe A g fo]
IBATAE LA, DL R AN 5 LR A (07 46 R

11.5.3.1 BT

D) bR RO R R T 1k, 75 i “Tool Bar” W) “Stop”  Fict, RKikkR
CAHPRE
2) fE “Virtuoso® Analog Circuit Optimizer” 7 [ H LS N IIZ 1T 21 —Fh .
® EF “Optimizer” 2> “run” B3 fiii “Tool Bar” W[ “Run” fLfbas: MIKEM
WA I IRIsAT A, E 3 EARAECIL 11.1)45 200 2 .
® L “Optimizer” > “Step”: ML) —AMF LRI, 1847 —AEH, KRG

1k
RNV GAE UG, IS ALEER: “Optimizer” = “Step” FIIEF: “Optimizer” =
“Reset”,

® L#F Optimizer>Run n: AT (1) — AN 1 SUOFSG, 1247 BRI n IRTE3A
SIS 3 — A0 EHE, A&l 11.29 P

Eun for Fizxed Humber of Iterations — ¥Wir... &l

oK Cancel | Defaults Help

Humber of Iterations

B 11.29 ZTHEMRK n KEHRFREE D
ez RES, Al HEsh i Ok POE RN . Rl “OK” JFah M sl i) — M5
1T, AT AR n RGN, G RARMWIIR(E T 46, B AAEI%E+E “Optimizer”
- “Runn” FiiE# “Optimizer” - “Reset”.

ERRFIRIEAE G, RS EC BB “ Virtuoso® Analog Circuit Optimizer” 7 [ H % % Fl11%
AR “Prev” Ml “Current” FRI{H .

11.5.3.2 1L 2%

fE “Virtuoso® Analog Circuit Optimizer” % I H &£ R fifs by 21 —Fi.
® EFE “Optimizer” - “Stop” @iF fith “Tool Bar” H[1] “Stop” AL #s: 7E4H]
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PEFRTE G 15 1AL o
® EFE “Optimizer” = “Stop Now”: L s B, A8 i 17 Bt 5 58 .
A L R E £ “ Optimizer” > “Stop” i B b— UK KA H B T = 1IE 5545 1 (A0 A0 BT 3 1)

11.5.3.3 M E 4R

HEFE “Optimizer” > “Reset” ¥MIERITA 07 B A, XS, vl 28 8 FE /R 2 i AR Fr
AR,

11.5.4 Ertiibs R

s i S RTAB EAUL A AS DAL BERR ) 7 9202 s — IR AR A 7 A (R s A DAL 2R A5 T 32
MIGERIN, AT LIRS I v 0 2808 0 A A PRI -

5N T A FE T AR S 0 Y B SRR T, e s R e, AR DR et R I S
B AL IR B -

11.5.4.1 & BRE

1) 7E “Virtuoso® Analog Circuit Optimizer” 7 H %&£ “Results” = “Set Plot Options”,
SRJG “Setting Plotting Option” & FUEESHH, WIE] 11.30 FiR.

Setting Plotting Options — Yirtuoso?Analog Circuit... @

OK

Cancel ‘Defaults| Apply | Help|

Auto Plot After Each Iteration |

Display History of

Variables ]
Scalar Goals |
Functional Goals ]

Mo. of Functional Iterations to Display Iq

Waveform Window

a
Font Size | J_l
630
Wadth | L]
376
Height [ 11
6:H
¥ Location | J_|
926
¥ Location | J_|

K 11.30 BEnEEE



2) IR TFEBEANN B2, ATLUKE “ Auto Plot After Each Iteration” &7,
WMRATFEBEIAN 58—, A EA S G FEongs B, ml LU T K “ Auto
Plot After Each Tteration” ANk . FEHAN RN 11.5.4.2,

3)  EFE RS —FE B TR R R A
® % “Design Variable”, ¥ E s IR AR HI RE S e AR R T
® trh “Scalar Goals”, R i Rt AT S ALALAERE H R AAAT [a]) H bR 5L .
® ik “Functional Goals”, ¥&IE K 11.31 HERMBI 17, BR—NEES
Gz ) H bR SELT I

[erotion History
OutGoal
s Torget +: Acceplable o: I#E w: I§5
sEAm &! 14 e I#3 o: If2
N N
S588m
458m
o4 T
1,
. 3B8m |
e
— 238m |
188m
0.8 = = -
= 168m | | i | .
4.9 2.8n 4.89n 6.8n 8.8n 18n
Sweaep Porameter

A 11.31 FEENZ R

WRA K2 8 KADMPIE R 2R, 7 ELE “No. of Functional Iterations to Display”
BNBRCE N B EH
4)  W'E “Waveform Window” (1S4, LIy @AY 6 wnm] DLk & 58 I P AARRITE K/,
5)  miih “OK” SERE/RIEDI & E
Wik “Waveform Window” 24T, A% LR W E FP ML, A “Waveform
Window” WATHT I, 87 1A Tl 114 R Ah 7 22 T 50 B T g ST

11.5.4.2 B $aE

MR Bk kS T “ Auto Plot After Each Tteration”, A4 “Waveform Window” ¥ B
ST I, B8 BoREFRAAE RS . W RS R BA B e o, ] DIEAL e 5 Il PUR
10 B R,

HEH “Results” = “Plot History” B3 fiihi “Tool Bar” "] “Plot History”.
B “Waveform Window” % ¥4 EUE Rk Db (1w B vy, HARH AL 11.5.4.1,

USRS BB PR T s AT (Vi I A A i B A DA AT R A AR
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11.32 fioRe

Tteration History [13] E@@

File Edit Graph Axis Trace Marker Zoom Tools Help
S JFE [+|Label [ |

“Wariables El

oals El

Bl gain BEre: EEVYC  ERW_N

Z.0007

O

o750
L=
™ 250
-25.0
0.0 2.5 5.0 75 100 125 150 0.0 2.5 5.0 75 100 125 150
iteration iteration O

5 [cadence]
B 11.32 EFEFAFRHEREENER

11.5.4.3 EF&l

W T HEP R, KOS B Bert AR 548 DU R g [

1) 7E “Virtuoso® Analog Circuit Optimizer” % - &£ “Results “=>” Update Design “E{
# i “Tool bar” H1#) “Update Design” %4 .

2) {E ADE % I E$E “Variables “=> “Copy to Cellview”s
3) 7E ADE % I iE$e “Design” = “Check and Save”,

11.6 1&7F, EHMZEAHEZEFER
7E “Virtuoso® Analog Circuit Optimizer” % 1% 1% (Session) Fhizgiry, AT LLERAT

AR, BT CRAF IR ITOIRAS B A A IE TR ARG B 2 i 2 1 AR B BT AT

(PSS

11.6.1 RAFZHEIN RS
N NP B S IS O %, Wil s, Bk E, DEMAETT R E ).
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1) %EF Session>Save State, #RJ5 “Saving State” T I3, 41 11.33 fios

Saving State —— ¥Virtuwoso?Analog Circuit O... §|

OK | Cancel | Spply Help
Save As | statel] |I
Existing States :

statel
Yhat to Save H Goals
M Variables

l Flotting Options
H Algorithm Options
M Environment Options

A 11.33 “save” O

2) WA HBUAZER, ATLATE “Save As” FEHIANIRE LR,

3) {E “Existing State” FZHEFE— N CARFAERPIRE, BN “Save As” 20K Rk i )
REBR FIRSHAE “What to Save” B R, I IF A FIOCHIXEEFIRES, wIEA
POBAERAER TR R, X IR B RAT
HE: RARETHTFRE, ARBETREIUZRENEKE .

AL IRAFIR S I BN BR AR AL -
~/.artist_state/LibraryName/CellName/.asd Optimization/StateName

FEIXA A2, “LibraryName” A1 “CellName” ¥ MBIV RE . 10 “ StateName” U]
SERAPIRE IR T FPIRS A FR

11.6.2 BEHX LRI AR AF X T RS

F I CLN 10 BRI LA R R AT DA TR A
1) JEFE “Session” = “Load State”, #X)5 “Loading State” 7 13, WKl 11.34 fion
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Loading State — ¥irtuoso?Analog Circuit ...

Ok | Cant:el| Apply | Delete State‘ Help|
Library Cadance —
cell Optimizer —
State Hame étatel

stated

What to Load N Goals
W Variahles
_ | Plotting Options
_ | Algorithm Options
W Environment Options

B 11.34 S E ART AR A7 B IER A

2) fE “Library” g i P ORAT T ORI SR

3) AE “Cell” "N ik BEORAT T B CIRAS I 5T

4) {& “State Name” FZfRIRAFI R FR, ERETHEHURIRES .
5) fE “Whatto Load” "k s Z U FIRES

6) i “OK” SERCIRAS I ELEL

11.6.3 RFFEIA

i “Open Command Environment for Analysis” (OCEAN) x4, W LLSZIRHLES K1 70 Hr Fl
{li 5. OCEAN j& — LT 47T, 7T LAE Unix WAZ WA R 4884 # 76“ Command Interactive
Window” (CIW) HizfT. M AEAZ 05 i H P AL B OCEAN fii 4, 5 f£ OCEAN #ff
RN AL OCEAN iy & IRIIIAS,  #ERT LLSEHLHLES 1 20 BT A7 B

FATPTLALE ADE % [, FAHSC I ETEAL T H ()40 “ Parametric Analysis”,  “Optimization”)
SERTE AR BCE, SRS BCE A IR A TR AR AE T Ko I HOnT LAEORAF IR A o
]\lﬁ Wl o AL B A

T TP RAT LUK W DUAS R TE DR A7 T K
1) %EH “Session” > “Save Script”, #XJ5 “Save Ocean Script” % 3, W& 11.35 #

GIT
Save Ocean Script to File — VirtuosoZ?Analog Circuit Optimizer (1)
oK Cant:el| Hpply | Help|
File Hame . foceanScript. ocr ||
B 11.35 RIEFHAE O

2) f£ “File Name” #2IENHIALFR,
3) mith “OK” SEMORAFIIAS .

206



11.6.4 MR ET R B

RZHHU T, AT LSRRI R E . HZE, WRASE —MEE 5%,
B T B SR SR R THUN T A2 T T A R R4 T

1) JE$E “Session” > “Options”, #RJ5 “Optimization Option” & 13 H, 411 11.36 Fros.
Optimization Options — ¥irtuoso?Analog Circuit Opt... @
Ok Cancel | Defaults | Apply Help
Algorithm Selection Auto

Optimizer Control Options

Environment Options

Percentage Finite Difference Perturbation [ |I

Relative Design Variable Tolerance (LSQ Only)

Relative Function Yalue Tolerance

Waming Message for Long Simulation |

2)

3)

Bl 11.36 AL E
il — MR 5L, 7E “Algorithm Selection” N7 HIERE “LSQ” Fl “CFSQP”
A REAAS Ak — DA EN AL, LTS “Auto”s

LSQ Hi&E A 5e A e VCHC 0 #, F H. Cadence #E#7 HAEIX Rl il ™ d H LSQ H.vk.

XFTLSQ &k, Ak “match”. “minimize” F1 “maximize” AZSEAI, ARATTHS
FEARAL I B 28 45 A H bR — 3. Dtk 457 A5 LSQ HikrhaR i KR /ME, I
TN HAME B 2% Kz 2.

5 “ Algorithm Selection” EFE 12 “ Auto”, HBALERZENGI T, ifbasit$: CFSQP
e LSQ BVENANAE N 1 P A - 5L e I A
® JFAXZRINLA T M2 “match”.
® T RN HARES B -
N7 B R R0k A A2 e T
®  “Percentage Finite Difference Perturbation”: ¥k fUsE (UL 11.1) J&anfef
RIET
HR: £ AXAME B, SR A AT e IE R R W AR
BRI . G SR 658 K23 BT (1532 i A R %) ) B8, {E “ Percentage Finite
Difference Perturbation” #2rp4fit | 5B S b K ) ik
®  “Relative Design Variable Tolerance” FIM{EANAEMN LSQ Bk s 141k, X}
CFSQP SEBAT % o

B, WERZEYE A 0.05, B LSQ FyAAE BT AR AN AR L N T
5%, A5 ibpife.
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®  “Relative Function Value Tolerance” B RZ I T VL5 11441 -

Bian, WHAEREE R 0.05, B A 55, 78 “Virtuoso® Analog Circuit
Optimizer” % FHH A2k XA AN T 5%, 47 1R .

R 4 “Relative Design Variable Tolerance” F1 “Relative Function Value
Tolerance” £ FHIANE 5, MALAA AT P 2 SR SRR A AL ) A 1 4%
fF, MASFRREEAT FHERIAME . HhAh, AR PR AU N0 457

4) W'E “Warning Message for Long Simulation”
LEARAL WL BB 4TI, “Optimization” T A1 ADE % D #{8I2E, BEHSASRE R KL
A BL R W 50 2 o W R A BRAE AN ] IO A 5 i 5 B pE B, L FR 20K “ Warning

Message for Long Simulation” %1,
5)  midhi “OK” 58RO LA I i) e

11.6.5 HIBRFFIAE R ER B

e “Session” > “Reset” HIFTLUHERATABEE G R, GRS Bil 288 AL /RIET,
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=232

i

F12E “Waveform”

12.1 “Waveform” % O B9/E B

T 15 H a5 R A AE “ Waveform” & I H 7R . £E “Waveform” % I H AT BL5E ]
AR AARE I TR . £ e ORI EL R . YvsY PL#s, 18 m] DA77 B0 &5 AR i 5o (g Ak 2,
Bl H 20dB H, HUEAE, B A, UL AZRESR “Waveform” & MR, 7T LUKIEE &
PAENEERA P IOk i WA

12.2 “Waveform” & A& 7}

B 12.1 B T AN ) “Waveform” & K S, LLACRNE 0 I ThEE .

Nar 15 21:35:27 2007 [5]

Cadance Optimizer schematic :

SRR ———stFile Edit Graph Axis Trace Marker Zoom Tools Help
THR: ——e S B [Z]Label |
2 Fr P Expr w
I, SREEAH  — - gain
FREEIX
ﬁwﬁ » 59.35kHz, -52.73dE
2R TN AL PSS = ]
A, AR A XHZE R i
Pl I a0 !
&
=
Y4l —_75.,0- -
Xy e
bR ALk i S
v ™~
100 10l 102 102 104 10° 10y 107
ST hE Ak b 130.7Hz| -24.9608 freq (Hz) [[1118Hz| 2653d6
RS b [> graph-1 selected: double-click to bring up attribute dialog.

12.2.1

& 12.1

“Waveform” % [0SR H

“waveform” & O K& 43 ThEE

F* 12,1 “Waveform” [ A = L AIABATT ) T g
S AL IE T AR
|File
197 “Open Grap” XUEHE. MNIFTIF—A CARAF P TE
Open X
A
Save F1FF “Save Graph” X iEHE. MK M HT I E LL XML
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A PRAT

Save as Image

FTIT “Save Image” XF1HHE. AIMRE 24 Hirp B LA R 2
RA7

Reload BT RIS w4 B
Print FTEY T E O E R

Save Session

PRAY T “Waveform” & F 1 &

Close KM HT “ Waveform” % [
Exit KA “Waveform”
Edit
Move 51k AR A Bl 5
Swap BB NG AHSCARFR Al el [ 3
Delete MHERIEH IPRZ . ]S B, e EE
Hide BROIE H kRS il BB PR R
Reveal WIS 0T B, PR EE EE
Undo Ry L0 E.
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Grids On W R R PR
Layout T AR
H 3% A1 BB, AR &0 s R 1 B
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Font FARR/NERE, FHWARR AR BRI AR AR
Small INFAR
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Create FFF “Lable Attributes” X UFEHE. MM EEFRES
Edit 16 B P AR AS:
e 5, “Waveform” T 719 (13 AN T DAL kg AH S 477 BL &5
Freeze On

RO A
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Show Tool Bar

i P s A

Snap Off

b, OB BN SRS B AR S bR

Snap-to-Data

Erha, AL AUDUE AR O U b

Snap-to-Peaks

Erha, ARC U ARSI .

Color Schemes WEH

Defualt BT St EHE I AE

Gray B REBN KD

Black HREBN RN
Template YRy

Set Default fFH “.cdsenv” H B I ER AR

Set Current 21 AR R A A BRAME

Load FI TN 2 [RBE SCAEAE AR
Edit FTIT “Graph Attributes” X} i5HE .

AXIS
. . 16 TP R s R AR AR ) FE WA o 1 U A AR AR A
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i Ja A A -

Minor Grids On

6 AR 7 R AR BRI R R o I T AE AR B
i e e S

6 R I8 R AR D7) 4 B RS, I IR A AR

- A U A B
Strip AR B TE B A SR
Edit FTHF “Axis Atrributes” X UGAHE. 12380 H AE AR bREhE
Jei A R o
Trace
Symbols On AR AR P LI BT RS
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Pk I T AN ET Y B BCE A AR I Y fil .
ZEI AT AE “Waveform” & WP AFAEZANBTER A
o

New Graph

Copy New Window

Pk b e VLB — N H 2 ) “Waveform” & 1 H
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Pk I TERE B B —ASHT Y “ Waveform” & F1H

Copy New SubWindow [t i 2 $8 DL — AN B it i “ Waveform” % H .
Move New SubWindos PEFIE i TE RS 5h 3] — AN BT “Waveform” % .
Bus
Create MRAEE R P, BliE— &Rk
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Cut L IR B )
Copy 3 1) T A2 A
Paste HTING BY U7 58 A2 A PR T
Load FTIF “Load” XJUEHE, MTAII—48 P TE
Save FTIF “Save” XIEHE, M EL ASCIL 4% 2\ ORAF B
Eidt FTFF “Trace Attributes” XJIHHE. 1L A 7E P LA L
TN A
Select All Y ET “Waveform” & L H I ETA B2
IMark
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Trace Marker FEBETE LI — MR, A% s (A AR bR
\ert Marker TR B n—A bR, A& R AR bR, FFAi—]
Sl iZ AT H
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¥ SUBUREISNIOY G 5N
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Find Min VPR IC RS B B s 1) IME AL
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Create .
i
Edit 197 “Marker Attributes” X UEAE, Mg 4HIE H Fkrid
Select All EHMET “Waveform” & 1 H I BTG FRid
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Zoom SRS
X-Zoom AR EISES
Y-Zoom AR SES
Unzoom FiE b0 (M 4 U
Fit VAN I G NGN
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Browser T “Results Browser”
Calculator ¥ “Calculator”
Help
Help AR By SO
Accelerator Key R I S A A PR

12.2.2 T HF-PesEs

“Waveform” 7 ) T EA2WE 12.2 B,
S n#EETFE [«]Label |
B 12.2 fREERAEF

BAHEE I D R
o E. TEUWHOHIEE, EFAT “File” > “Print”.

o BN B L—PEME, FFT “Edir” 2 “Undo”.

o HE HU/BMKE, %[ T “Graph” > “Grids On”.

o E. HHLAPIERMNFEIR, FFHT “Axis” > “Strip”.

o I E&ERTHN, %FAT “Graph” > “Layout” > “Card”.

o B ygikri R BalE RN “Waveform” TH L, %fT “Trace” > “New
Graph” 2> “Copy New SubWindow ”,

[ J

o Bl PR BN RS Waveform "5 117, 257 T Trace>New Graph->Copy
New Window.

o Iy “Lable” drm bRz, ek BB R B BT BRI B T
“Lable” #%: Wit rFres.

12. 3 3TH “Waveform”H O

IS N TVE T LTI “Waveform” & H .

® 7F “CIW” HHH, IEFE “Tools” = “Analog Environment” = “Waveform”,
® {F ADE %, i#%EH£ “Tools” = “Waveform”.,

® YfE5EHMUE, fE ADE % IH, fith “Plot Output” BRLFEHE.

® 7 “Results Browser” ™', EFHTHLRILS “Waveform” IR,

® 7 “Calculator” ", HEEHGIEL RS “Waveform” IR,
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TG =R 7 SF T IF “Waveform” % 1B, R [R) B S s e H 4 S 45 2R

12.4 &8 “Waveform” & O

B TF—A “Waveform” & 5, AT DABCE EIR BB, DLRE W07 BLAE R 70 4

12.4.1 REERME

7E “Waveform” % HH ] GeFE 211 1. v DUE S DL R & X0+ 1 RS 7 2

® & “Graph” > “Layout Auto”: X & RGEINF & HHED 72, KEAR B i 1 e A v
Pl A sk He GaE B, 7% D B T B, KRB HA R 77X 475 H
() FE /N T B, ISR R A sy 1) 77 2K

® %+ “Graph” > “Layout Vertical”, f3ZIWIEl 12.2 Proxi)d Ho RHZIT AR, 18
PR R R 1)
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Cadance Optimizer schematic : Mar 16 09:49:32 2007 [12] M=1E3
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Cadance Optimizer schematic : NMar 16 09:49:32 2007 [13]
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Cadance Optimizer schematic - Mar 16 09:49:32 2007 [13]
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TERIEHEAER A H . R2Z ™ “autoTraceSelect” LIk “False”, 54 W20 s i T A BEKs JLIEFE
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12.4.3.2 BEiEx) %

“Waveform” & HH IR BIE AFREN. Arid ol bR S50 G v ARG P . fldn, 4
T LRI S — 2R DI, AT LK A e T e . BAR Tk R -

1) &%

2) &P “Edit” > “Hide”

NEF IR EATAE “Waveform” & HH B8,

12.4.3.3 EIRBAIN

“Waveform” i [ H 9 B 196 S ] LUs L — R 1 7 v E

1) E$ “Edit” > “Reveal”, M2 HBL— MR BoRg BN R4 FR, Wikl 12.6 Fr
e

2) FEHIRPIERETEEILIR G, WL o e S0k T ILAE “ Waveform” & 1,

mizer schematic : Nar 16 09:49:32 2007 [13] - [B]X]

Graph Axis Trace Marker Zoom Tools Help
S H Move [ E LA~ Mingmax [-120d8 [-20.008 |
Swap - :
Delate Expressions ' Transient Response E|
graph-1.axis Y0
Undo graph-1.markerQ 5'6.
5.4
5.2
Zg o]
- ]
4.8
4.6
T T T T T T 4_4- T T |
109 10! 102 102 10% 10° 10° 107 o 250 500 .750) 1.0
freg (Hz) tirme ins)
&
B 12.6 EIFIFEIXT R E

12.4.3.4 ZTHEX%

KA ERIIBIE . G—ERP I AEIC XA Y b5l DL N1 1R ] L
TR T R T VEAS A

1) EPE L

2) kP “Edit” > “Swap”;
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3) EREH AN

BRI HR R AN L A P RS e T

12.4.3.5 M35

“Waveform” & MH R #IE. brid 8BS bR 550 G n] LUIBRIY, {Hi2 “Waveform”
T e — AN R EASRERMIBR . ISR S 8 770

1) IEFXS

2) JEFE “Edit” > “Delete”, BiF#H sy b “Del” $at;

BEF X GBI “Waveform” 7 FTH IR .

12.4.3.6 #B#RAE

ML AT DA SO K R ZEFE “Edit” > “Undo”.

HER: AT “Undo” BAF 5, ol (X3 B2 K “ Undo ™ #8641 1 o PRIEER — ki $¢“ Undo”
i IR MR L B (K311

12.5 FEMEFER

12.5.1 EEAEH BArESEH & 0 e/

R HENURE TR AR A B, AEEER IR N EAE, sl 12.7 Pros. i HEAHER
SE T HTEIR IR
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Cadance Optimizer schematic : Nar 16 09:49:32 2007 [13] M=

File Edit Graph Axis Trace Marker Zoom Tools Help
& P TS [«/]Label | |
Expressions m Transient Kesponse El
~ gain JOUT
5.6
5.4
5.2
=5
=
4.5
4 65
T T T T T T T o o e o e e B e
109 101 102 102 10% 10% 10° 107 0 250 500 750 1.0
freq (Hz) time {ns)
|+ graph-1.traced:gain |cadence

A 12.7 BEAE A BAREREF & O KK/D

12.5.2 “Zoom” 74

W “Zoom “> “Zoom”, MLy AR AR ZCBE, ERIR PR ANEHE, 120
FERERE 1B BRI RN

12.5.3 “X-Zoom” Ax5

WL EFE “Zoom” > “X-Zoom” iy A IMYAN AR X . iEFE “Zoom” > “X-Zoom” J&,

BB I 70 i BURRI R X ARG 2 o BURRI 4, R BB 2 4
TR EE s AR AR I PRI X Ay [ B s R

12.5.4 “Y-Zoom” %

W EFE “Zoom” = “Y-Zoom” @y Al LIMMAN AL Y il iEFE “Zoom” > “Y-Zoom” 7,

BUPRAE Sy “ 7, ek BURRISE Y BN AG A, Hah OB 2 4 B, R B0 2 4
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TR EE R i AR AR PRI Y Ay [ T s Bk

12.5.5 “Unzoom” f54

MWRLEFE “Zoom” > “Unzoom”, R LMK LLRT K — RS I4R T80 AT -

12.5.6 “Fit” <

MR “Zoom” > “Fit” BRI I A6 K/

12.5.7 “ZoomIn” 2

IR “Zoom” = “ZoomIn”, LLEZRH.O AU ARARBOR IR, Wil 12.8 Fios.

*25% smaller

25% smaller

Criginal Graph =t Zoomed Graph

K 12.8 it %R “Zoom” > “ZoomlIn” JFKEFR

12.5.8 “ZoomOut” 2

HILES “Zoom” = “ZoomOut”, LUK Ly i A Ah ki NEZ, Wk 12.9 Fios.
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A

-25% bigger

25% bigger
- 33

Zoomed Graph —— g Criginal Graph

Bl 12.9 it % “Zoom” > “ZoomOut” 4i/NEFR

12.6 FBEFR

WL EFE “Zoom” > “Pan” YN NHZEHE “Pan Right”. “Pan Left”. “Pan Up”. “Pan
Down”, 4l 12.10 iR, AL EERAEYAS 5 AT PR . 1 1211 i T “Pan Right” iy
L R PR R

Cadance Optimizer schematic : Nar 16 09:49:32 2007 [13] =13
File Edit Graph Axis Trace Marker | Zoom | Tools Help
Sr#E OE# Zoom d |
: X-Zoom ;
Expressions Y_Zoom Transient Eesponse El
~ gain Wi g
Fit
Zoomin
ZoomOut
Pan ¥ Pan Right
Pan Left
Pan Up
5.2
Pan Down
=5 o]
=
4. EH
4. 6
T T T T T T |
10 10l 102 102 10% 10° 10° 107 o 250 500 750 10
freq {Hz) time (ns)
o[> [cadence
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B 12.10 BRTPBR R E

Graph panned right —*

B 12.11 “Pan Right” @45 FBE®R

ISR il X BIASRI 2 0~200, WV J5 X HIAL R 2 40-240. JLfit JLFIF-RS /7 20A Pan
Right” —HE, LU RIABERBING 20% 0 PR, SURTR I AT

12.7 4wiBEIRREMH

B BN P “ cdsenv” HHIE TGOS 1) W R FEAS SRR @ E, v RldEd LU R
BRI
1) %P “Graph” > “Edit”, s EEIR PR HAR, FTHF “Graph Attributes” X ifi
HE, Wil 12.12 Fizss

Graph Attributes

Create Help

Title [Expressions [] Default
SubTite. | [viDefault
Legend Ruws [¥] Show

Funt| Dialog v| |Plain v| |Medium -

FuregruundIBackgruund| I | | - |

Major Grids ¥ | [v] Show
Minor Grids * | [¥] Show

ok || cancel || Appty | o0

B 12.12 FREEERN BT

2) AE “Title” F2HFATLAGE IR A 44, sl 1k #E “Default” A FERIALHK.
3) A “SubTitle” " af DAL BRI T 7 heill, oiE IEHERIA T hd
4)  f£ “Legend Row” FXH AR A Wos (K B 61 (AT 8. A B BIRIAT RO T “Legend
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Row” HBE IHEUE, BB I — MRS 5. FRGEFE s Bl ailsl 12.13 Fros.

Cadance Optimizer schematic : N... |Z| |E| [Z|

File Edit Graph Axis Trace Marker Zoom Tools Help
S # B [FE[Label | |

Expressions

- res="55"0ain - res="7.75";gain @!

T T T T T T
109 10l 10?2 10¢ 10% 100 100 107
freg (Hz)

s> |[cadence

& 12.13 IABBIRATEK T “Legend Row” e MBUERT, BEIBIX M —/MRB)&

MIBH “Waveform” 7 LI, %% ERAFE] “.cdsenv” LA,
5)  “Legend Row” F*J5 1) “Show” JEINZR/R 2T Bor K B
6) 1 “Font” JGI=AN N RESEFAR IR B R SCAW TR, FHREMYE S,

7) {E “Foreground/Background” H173jl B8 & 1813 (AT SN SEE0 . L AR HE 1 &R

FIRREL. FhRl. ALFRGEFN AR bR AN 4 FR o
8) {E “Major Grids” HIEFE T WA, LA AT Bom 3 MK
9) {& “Minor Grids” HIEFER MRS, LA s IR A% .
10) sishi “OK” ek R B HEM I &

12.8 XFiRFHIBRIE

AR BT, SE B #R AT
°

M—AEIR BN TN EIR . s — A AC U7 B BB BRS IR 1, X AAbRAIT

ARBRRE ] — B3 )5 s, R0 AT AR RS AT A 5
® N—ATEHIS—ANTE
L I N | D R b
E kL A1 P T NS TN (B LY G AR R i1

ikt POTE, ATLGEE - h R B BB
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®  “Trace” > “New Graph” = “Copy New Window (@)”;

®  “Trace” 2 “New Graph” = “Move New Window”;

®  “Trace” > “New Graph” = “Copy New SubWindow ([~
®  “Trace” = “New Graph” > “Move New SubWindow”

L1 S AE TG L “Parametric Analysis” (K8 {7 45 R AP SE— A4 F @ BB WU N+ A

12.8.1 7= BREE

1 “Waveform” & I —ANEIRAE ZANBIER, AT LRS- N EIE R R, 821
BT N A, P A LT Y A krh, (HILRRl—A X ARFRHT . IXFh o2 s H
K EMABPRRA R WU, SEIARAR A R

B “Axis” > “Strips(E)7, B 12.13 Bon TARMEZE, B 12.14 SR T ARSI

RE o

Cadance Optimizer schematic : K. .. ['__]E|§|
File Edit Graph Axis Trace Marker Zoom Tools Help

& » # E0 B @[ ]Label | |

Exprezzions l

—~ res="7.75";gain — res="10";gain J

-80.0

1 (dB) 0 ¢dB)
fffffj ;/KIXJJ

-1:25
-a0.0

-130
-a0.0

2 (dB)
L1 1111
1

-130 T T T T T T
0% 1ol 102 102 10*  10® 100 107
freq (Hz)

of> |cadence
B 12.14 HEREEHERRET D

FEPIETCEZN o — A, AR A R I 2o A I BB

MR AR TSR, A AL AR
°
® CRBIEIEAE AR, AR A AL A ASE A s R O
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12.8.2 BRGS

WRAEPS EISINAT 5, LA ROHORHR I X 23 IT o Gl BL R A ) DL s B [ekipe /2 L
IDESRE

1%+% “Trace” > “Symbols On”, WKl 12.15 Fros. W LH) “X7 0“0 £%5, AR50
RPN BIEX 7. BAART SR BMB H BEE, It

Cadance Optimizer schematic = K. .. ['__I[E|§|
File Edit Graph Axis Trace Marker foom Tools Help

S S B E [ Label | |

Expressions .

# res="3 25" Qain —= res="10"0ain

-50.05

-70.04

-80.0

¥ (dE)

-90.0
-100

~110

_120- R | ML | R | L | R | AL | T
109 10l 10¢ 102 10 10° 100 107
freg (Hz)

ated: double-click 1o bring up attribute dialog.

B 12.15 BRF5

12.8.3 LTI T A brh

* “Waveform” & HBGH 7% AP A& 2 POER, wf LU BTG i E

o NHINY Hihis

o NCAHAEMY Hho WA Y B PRALABIEATT, WIAEAEFRENAZ AR B R
T RINIZAARR BT I K ) R

% 1:

EE 1216 1, AR IDERT “OUTL” 1 “OUT2” MBI —AN Y Shi s ;
EATAR & IF, “OUT2” WIEHIRT T —ANH i AL bR 4 .
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Graph ¥Yindow [171

File Edit Graph Axis Trace Marker Zoom Tools Help
S i E O F & [|Label | |
AL Analysis "act freg = (1 He -= 1 m AL Analysis "ac freg = (1 He -» 1 l
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> graph-1 selected: double-click to bring up attribute dialog. |(a dE nce

B 12.16 Y BILFESEABA Y #

i 2:

R 1217, EHRTFEOERT “NL” A “V0op” 2002 — AR BN —ANmisg: &
FIAR P O, BANEOEIE — AN ARFREl, I ARAREI B L FR %2224 (V2A), Fomiz Al bl
H—A I Y EE AT
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Graph Window [171

File Edit Graph Axis Trace Marker Zoom Tools Help
& i E (F ] v
AL Anakysis “ac': freq = (1 Hz -> 1 m Transient Anakysis “tran': time = (0 El
— Ml —¥0p — M1l E=Nop
2.2 400 2.5
250 ]
1 2.0
2.1—_ =00 1
| F2 50 1.5+
2.0
- o0 = =
= T | Lo
= = E J
1 150 ro
1.5+
] L100 5+
1 g Es 0.0 ]
| 0
o ]
1.7 T T T 50.0 -5 T T T
] 250 500 7S 1.0 0 250 500 750 1.0
time {ns) time {ns)
#[> graphl.tracel:V0:p (res=1.00e+00) |( adence

B 1217 B Y Bitr 5 & 284 Y RSN K ER

12.8.4 BHHTEE M

BICIERIN B 28 I “.cdsenv” WP IRIET B I . WER T LA B @M, vT LU DL R 2P 5%
K SEI o
1) Ek$E “Trace” > “Edit”, s XL, 17T “Trace Attributes” X IHHE, Wik 12.18
P
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2)

3)

Irace Attributes

Create Help
MName ¥ 0:p [[] Default

Strip Chan Yisible Rows|2

TvpefSl_yle| Line hd | |Su|id - | | Fine -

Symhn|s| Plus - | |2l.'l | - | [ Show
Foreground | NN ~
cursor X/Y 0ffser.|0.05 | |0.0A |
‘ 0K | | Cancel | | Apply |

E 12.18 BEBITEKIEYE

7 “Name” FEHENBIEMARR, SFHERE “Default” BRBINAFK,

WE: YH L AWBHEE TN, “Name” M1 “Default” R348 MK A, M AREERAE.
7t “Strip Chart Visible Rows” HIHN KR H 02 Ry, v LA WLATE 90 R0k
T KT LB R AT E, SRR 4, WImEREREIE, Wi 12.19 Jis.
Y EFrh AT — AN B, “Strip Chart Visible Rows” £22 LAEH], ZE K (G,

Cadance Optimizer s=chematic : Nar 18 13:24:59 2007 [21]

File Edit Graph Axis Trace Marker Zoom Tools Help
gl BHE []Label [ |

Exprezsions l

-~ rez="1";gain — res="3.25"gain — res="5.5";gain - res="7.75";gain - res="10";gain

-80.0 &
-55.0
-90.0+

=-95.0+

= 100+

£ 105
-1104
-1154

-1lz0
-70.0

-&0.0
- 300
=
—

2 _1004

-1104 ]

_120 T T T T T T
10" 101 102 102 104 107 107 107
freq (Hz)

#[> graph-1.trace2:res="5 5";gain |cadence

B 12.19 2 EHCK TR LB R AT H0R B — MR &
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4) 1 Type/Style H ik FRIE I
P v SRV = ISP I EANIEE

Line: £&K]

Point: ;i [&]

Bar: HZH
Spectral: A% P
Histogram: Hi/E K

AN TS IR R

Solid: 5£%:
Dashed: %%k
Dotted: )ﬁgf

DotDashed: »5 %1%k

A R R 0

Fine: 4%k
Medium: TEETEE
Bold: ik

5) “Symbol” BB FRUEIL LAFE ISR, BURAE S /S “Show” 5 75 i ikt

(]

o FETIRI ARG
Point: /5

Dot: KA

Square: SLLATE
Box: M
UpArrow: [n) F#7k
DownArrow: [ K&k
X: X

Circle: Z5/0El

6)  “Foreground” H kLWL IMEIEA

7)  “Cursor X/Y Offset” H B E bR X/Y AR ZE f o WERX P MEA N Z, AW TE
AR R A AR )2 AR 4R 3 PR A R AH B

8) miili “OK” eI IEm ML &

12.9 & EX MBI

AABREN BRI B T 2B L “.cdsenv” H IR TIA B o WA T EAS AL bRl E M, T LLE
— DB S
1) JETER “Axis” > “Edit”, i OGHEARRRE, FTIT “Axis Attributes” X iGHE, 416
12.20 7,
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Axis Attributes

Create Help

Label [v| Default
Scaling| Auto * | [v|Log [] Origin
Miny Max

Major/Minor Divisions

Significant Digits [¥] Default

Foreground | R ~
Sweep Var| freq -

‘ 0K || Cancel || Apply |

K 12.20 irEHERER D

2) {& “Label” FEHIHANARKRFZFR, BLHIERE “Default” {FHBIME.

3) {& “Scaling” LRI PR, R UCE ARFRGHTE FEFI A% K143 o
® Auto: [ BhIEFAAbREALTE RN KI 4o
® Min-Max: FaJWEMRHIEH, HIBRCEMERID .
®  Manual: T3l & AAARANTE IR A% R 25 o

4)  1EFE “Log” i X AL br

5) &FE “Origin”, JEATARbRENL 5 AL

6) f& “Max/Min” HHEANAFRAIER. Y “Scaling” HiEH: “Auto” B, MARK, K
o

7) 1t “Major/Minor Division” HHIEA F= WK RIS (14 43 75 3o T s A8 E 3 K1
SR JEHEFRIRAEIE A PRSI AN I A “ Scaling” Wk $E “Manual”
INECE @

8)  “Significant Digits” I NARRHNZIBE KA A7 £ L “Default” 1 HI BRI RLAL
., [AEE “Significant Digits” #2 I BT R

9) {E “Foreground” HHIEPEALARHIIFI A

10) 4w X BB TER, BF— FIE:

o NIk A TS LRI ELS R, WAL “Plot vs” £, WK 12.21
JR o LR NS i B A Bz T A e DU IEFE— M AR, $
My Y BlPEA X, R EIER TP EOR R RZ X AN BOR. XA TIREEELT “Results
Browser” ) “YvsY” UjRE, HATEWIE, 454,
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Axis Attributes

Create Help

Label [v] Default
Scaling tl.:mp [l Log [_] Origin
Min/ Max fN2vs JOUT

JOUT vs fOUT
Major/ Minor Divisions |/ N1
fNZ

Significant Digits|; oyt (v Default
Vi:p
Foreground
9 Y1:p
Plot vs| /OUT hd
| 0] 4 H Cancel || Apply |

B 12.21 FRRETEEFERIZRENTRER

o WRUERIBIE R A TR S BN, AL “Sweep Var” £, f1lE 12.22
J7R o AEARFE T h g P 5 I I AR &, (045 ADE tP B 1), LA “Parametric
Analysis” HE ML E. WIEEZ SRR g se, o DR R E R AT EAR
X Hh, EHEOoNEE. ER 1222 F1, “temp” & ADE R E, 1 “res” A&
“Parametric Analysis”H 1% & F1H AR & . fEK] 12.23 F, AU % 1 278 T Bl temp”
A X R B A R, ALK 75 P27 T BL “res” 1F0 X BT E 45 R o X P
RE 2017 T R 5 B ACAN [) A% 0] vl B 1k RE PR 56

Axis Attributes EI[E|E|

Create Help

Label [¥] Default
Scaling | Auto * | [ Log [_] Origin
Min Max

Major/Minor Divisions

Significant Digits [w] Default
Foreground | N ~
Sweep Var|temp v|
temp
res
| Ok | ‘ Cancel | | Apply |

B 12.22 “Sweep Var” EH FHRAPEEFHKAMEZE
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Graph ¥indow [32] E@Sl

File Edit Graph Axis Trace Marker Zoom Tools Help
SrEEJRE (A5 Mingmax [0.0 [Looo |
DC Analysis ‘de' temp = (0 C -» 2 m DC Analysis ‘dc' temp = (0C -> 2
— QUT (res=2.00e+01) — JOUT {temp=0)
— QUT {res=1.2%9e+02) — fOUT (temp=<4. 0E-2)
— OUT (res=2.28e+02) = — JOUT {temp=8.0E-2)
5.0 5.0 1
4. 545+ 4. 545+
4. 98+ 4. 98+
4 47+ 4 47+
= =
= =
4. 56+ 4. 96+
4,954 4,954
4,94 4 94
4.93 . . T 4.934
0.0 5 1.0 1.5 2.0
temp (C)
#[> Iaheld [cadence

B 12.23 “res” M1 “temp” {EAFZEKIHRLER

W XFhDHE A 7L LR PSS 0 2 IS DL A Re A A «
® LR LRI RBESA 1T,

o ENEMfEAE (W 7.7) B%dEsibT 200 4.

11) sl “OK” 58RO AR R

12.10 KT RIREIERIE

12.10.1 R IR

B hr e M HE BTN HDCER, ZChRRIAARAE B R I 22 T A 2o RN R AT R A 2
T BARERR AR . W 12.24 PR
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Graph Window [33] EJ@'@

File Edit Graph Axis Trace Marker Zoom Tools Help
& r EEL FHE [Label | |
DC Analysis “dc': temp = (0 C -> 2 ©) .
— OUT (res=2.38e+02)
4.98552
Bl
4.9855- —
i
.'/
/'/'
4.98548- /_,/
o B
= -
> /,/
Bk 4.98546 2
f/-/
1
//
S
4.985 44+ /
./‘ il
bR G AR AR B
4.98542 T T T
0.0 = 1.0 15 2.0
&ﬂ}jﬁﬁ;%ﬁ; 4 812.2mC| 4.985464Y temp (C) [ 1.201IC] 4.985458V
«[> graph0 selected: double-click to bring up attribute dialog. [( adenc eu

B 12.24 BTEIEAR

® Bt “Trace” = “Trace Cursor”, JTJHIIEY6hr.
® it LN ER Y kR

B BRI, BIEIGhR B ShERES bR bR
BENAZE [ R BB ehs A BB bR e bR A2 3

o AEBIBIIPIIIAT— A, A7 R bs
o FE—AEERAF HAAAE—NPIBhr.

A AN BICAAEN, WERBFRIEA — BB I RVER A, BT 6hs B sh Dl ez
ZOCARAL o B AR AL T P AN IV L A IURR I b b 1 e e 3 AR (KI8T L
B AR “Crtl” B, mial AT SR AT AR Sk bR

i}
[
[
[

ik UR S i 2] DL IR ehr i # 8l 7 2
“Graph” > “Snap Off”: B ChREEE R~ A3 .
“Graph” - “Snap-to-Data”: B hR N\ —AEHs Uk ER B N —ANEds 2.
“Graph” > “Snap-to-Peaks”: B bR N—MIE(EBRER S — NI

12.10.2 fFFHEEHR

e EDEhR e NI LIS B, XA E MBI AZIAL ] — A 2 O A B

7N

B Eths, MBI, CUA X/Y AAARE ARSI BT
® JEFE “Trace” > “Vert Cursor”, JF)BIEH hn. WK 12.25 Fror.
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_Fﬂe Edit Graph Axis Trace Markeri:um Tools Help |
&rn#EEl BdE [»/]Label | |
DC Analysis “dc": temp = (0 C -> 2 C) .
— OUT (res=2.00e+01)| 1.241C[ 4.999v ‘I
— OUT (res=1.29e+02)| 1.241C[ 4.992¥
— OUT (res=2.28e+02)| 1.241C[4 4.985Y E
5.0
REIAEXIY A
4,99+
1 b e ~

4,97+

E

-
4, 96
4,95+
4,941
4.93 T T T

0.0 .5 1.0 1.5 2.0
temp (C)
«[> Prass m key to place marker. |cadence

B 12.25 &% “Trace” > “Vert Cursor” FFBIEEEHR

12.10.3 fF K FEHhs

P Hohrm 2 — AT AR B K Bk, X 4% HLERNEIE I AS AR H — N4 i 2 e 2
INe ATIEARTT XY AEKRAE G X Y% TE A4 B o A N 7 o T i K STl bs B 2R A0 i it — M Bk
B Tehs, AR ant, AU AN X/Y AAARE AR SIS BT

® &P “Trace” = “Horiz Cursor”, JTa7KFhr, Wil 12.26 s,
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Graph Window [35]

File Edit Graph Axis Trace Marker Zoom Tools Help
Sn#EHE FE® [v/|Label | |
AC Analysis “ac’; freq = (1 Hz -> 10 MHz] .
— OUT (res=2.00e+01) [ 1.0[ 1.47mY — ouT (res=1.29e+02) [05E3[ 7.17m¥ F
74
— OUT (res=2.38e+02) [ 49E3[ 7.17mV — OUT (res=3.47e+02) [S7E3[ 7.17mvy (=
OUT (res=4.56e+02) [S9E3[ 7.17mvV — out (res=5.64e+02) [61E3 [ 7.17mV =
20
704
607
50? ey
— i \
- 4 L}
£ 404
S
& 307
= ]
20
10 \/
0_. —
10? 10l 102 102 104 107 107 107
freq (Hz)
[> Press m keyto place marker. -lc adence

B 12.26 3£ “Trace” > “Horiz Cursor” )3 /K45

12.10.4 fFFHEEHR

ZEAE Y OhR H— AL FN— AN E I ] LA B0 I = A T ChR A4 1 [R] I IX s % B AL & —4%
MACHRH A Y HIARAZ KPS, Fl—2 MOlhs th R X BAHAS I T B2k . n] Ld i s o Fl 3
A AT DA ZZ B AR U G B TR Bl o JERRXT N (1) XVY AAFR o E BRI 22 T A1, eI XY
ARFRIG ZE(E AR WoRfe A N A, W 12.27 Fos

® P “Trace” = “Delta Cursor”, JFJo ZE{EEhR, WK 12.27 s
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Graph ¥Window [36] E@@

File Edit Graph Axis Trace Marker Zoom Tools Help
& N # [ &) [7]Label | |
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Graph ¥Window [36] [Zl@|®
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® it “Graph” SEHIRMERZ
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Label Attribute=s

Create Help
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smmfmmuh Mjnﬂmu
Font| Dialog v | | Prain v | | Medium -
Foreground (I ~
Dirmiun| East - |
Cox | camcel | oy | Add

A 12.29 #£F “Graph” > “Label” > “Edit” ¥INFRE

HER: WHR “Label Attributes” XIFHEDEITH, WUEERRFEFREE - IMHRENZRETR
“Label Attributes” XFiGHE.

2) HEAFERMEE, BANEENR 12.11.2, fid “Add” 58545 .
3) EREA S A, BRI ga iR AR N B BRSSO .
©® H L PREEEE A AR AL IS AR

1) W “Waveform” 2N T4 0, @i SEFE DA LMARETHE, Rk
B o Bl R R B TAE SR,

2)  AEPREEEE T ARSI T AR

3 il B pnpbrss ).

4y A AR, KT AR R

12.11.2 ZREBIRE

X —FE A H B “Graph” SEARIERFEGE b IR A g PR A
® Hid “Graph” FHGHHFRZ.,

1))

2)

W T E AR OFRSS, ARG EEE “Graph” > “Label” > “Edit”; 8 Witi i 24
HRIARZE, IEI “Label Attributes” XJiEHERR Y, f0& 12.29 Fis.

7E “String” FHCAFHEAFRZ N A . “WaveScan” 240t T ZMASE (1% 12.2 Fr
IRy XA R AT LUK AN BIFR BN AT . RN BRI SR A BB ER S, X
S BN AE, VRS M4 S AR A T A N R IA S, DA T S A 1
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% 12.2 “WaveScan” RALKIZ T E

Bl Eitipa
06X X ALFR
%Y Y Ak fr
%W AX
%H AY
N RFE (AX/AY)
%N LS
%E Kk
3) {& “Expression” FHIHAFKIAI, KA SKILL ¥ 5 TG Kk 2 (1) Py 208 25
“String” £ “%E” i,
4) {t “Signif Digits” = PHAFRZE LA A AN EL . 1EFE “Default” K HEVAE
LR
5) 1E “Font” =AN FHSE K IKIEFEFRZE TP SCF I8 FIRRIT- 5
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—™ omv 3 T *n
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8) siili “OK” FEHUN FREE IS .
T I PR AR B R AA  E FR 2
1) ERETE MRS, 2 AR A DR SE  AR A P B oR .
2)  EPRAEEE P AR P RN T B AR ) Y
3 it D s .

12.11.3 BainE

MR AR, WA SR RRAE s HREANRER RS M AR —MhRid Eo
TEFE s R B bREE
KN IR TR — A T B B R4

1)
2)

FERRZE EAGAT bR o, AR BT ZEAL 1, AT BUbR 22 BORORE bR 25
A “Edit” > “Move”, FEFT B AL T oy ks e B HUPBCE AR o
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12.12 xF#ric

FrRACEAH Y R (S B BRI IE A A B, ARt BERIARRZE SR TZ A1 X AT Y Abk o
BEAR AT OB — AN R IR SURFR I AR I, AR e 9 N B3R 5, bnid AR 850 Wiz R ik 204,
HARECE vk 12123 3.

12.12.1 #mbrid

EEFRF AL g e . TEEARC AKPARid FIZEERC .
12.12.1.1 E BRI TER S EERCAK RS

K CAR 22 R i 15 B AR BRAS Db «

1) &EFH “Marker” > “Create”, BEHT “Marker Attributes” X iSHEZR H, Wil 12.31 Fiow.
i “Marker Attributes” XJTEHE 28T, B Ak+E “Create” > “Marker” fll—>
BrIFRd

Earker Attributes E| El El

Create Help

Label | | [ Default
X/ ¥ |5MHz | [arnv | [ use Cursor
Constraints [_] Trace [_] Data Points
Type/Display| Trace ~ || xv Mode |
Symbol Stv|e| Plus - | [¥] Arrow
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Cancel Add

K 12.31 & “Marker” > “Create”, ¥ EF AWM INARIE

2) fE “Label” F2PaEft MHIERE—FrERAE:
® M AARILHITAT A AR TATH PRI DMEIR 122 AR, ARl g n 2
el i SR AR B A R, A BRI DR AR AR R P A AR 5 AR B
DRI B L P PO T AR 2 AR RS AR T HO R S R B RR L 5 — b iR A
A HE
® ik “Default”, {HAERIME. BRMECR Boavhric i X Y AbR. 4 “Default” ik
HUE “Label” £ A AR AR
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3)

4)

5)

6)
7)
8)
9)

16 “X/Y” R ESE T AT — Ak

o WE X FIY MR, FHUAERR A R D IBCE AL KR OEARTAERE
REA 7 Shnic . Blan: T BAER I L X AFsh 10nS B4 FRCE FRid, WFE X
FERIEN 10n, M6 Y #2258, “WaveScan” HATHE AN A Y AAbR, FFBCE bR
ico

® i “Use Cursor”, 7E bR T IBUE RIC

7E “Constraints” HEFE “Trace” IO RIC A ERIT MNP L; EFH “Data Points”

WA bR B 7R B R T B B A

7E “Type/Display” £=HIEFFRIC IR ANZ R 7 CRarn 7 AL 12.12.2):

® Trace: AR

®  Vertical: T Aric

® Horizontal: /K F-Fxid
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12.12.1.2 18 ARG I TEAR S . EEARMCHK AR

W R iR 77, A LGl SR B R TS BB bRl HE EARL AR .
® L “Marker” = “Place” = “Trace Marker”, “Marker” = “Place” & “Vert Marker”,
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AN AR D) 808 “H” GRIIZKFARIE) .
“WaveScan” 23 H )8 b5 d i 0 21 88 bR s (3 o B £ 2 R E,
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2)  RHF AR
®  {ibnic FAe R bR 2o, bR IC BT E AL, FaTT bR 22 SRR bR i -
® It “Edit” > “Move”, 7177 22 AL ol BUbs Zc B E R IR brad
WERAE B R PR Z AN TE, Anid R4 T B2 2)) -
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TH T T R 5 R AT DARAF e T SCA:
1) RPN, EEEIImBCPERE “Trace” = “Save”, F2#H “Save” XJIHHE,
Bl 12.36 TR

Save In: |Ijo "" @@@ E

[T ERRAMP_silver
 woxch

D ade_wavescan.log
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12.13.2 HAEE
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1)

2)
3)

4)

FIFEAE R JE LI % 1, 25 “Trace” = “Load”, K& “Open” XJUGHE, WK 12.37
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[} cds.lib

D libManager.log

[} libManager.log.cdslck
D report_table_V.csy
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12.16 R7FEIFE

Al I XML % QAR A7 12 5 T LIGE G R A7 (6] 175 10 B e A W W % B R 194 J. o BA“ XML
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| Save || Cancel |
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4) R AT PP
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12.17 UEGENREFER
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2)

3)

4)

Save Image

Please select an image format to save in:

® PMNG (Best compressed)

i TIFF (Good compression)

) EMP (Uncompressed)

i) Auto ¢based on file extension

File: |snap5hnt.png | Erowse...
Save Cancel

Bl 12.39 DAEIBAR R RAEEIR
R R BB I s 2
WERIEFE “Auto”, “WaveScan” FHUHE {44 10 JE A4 B R AF R AL filn: {r “File”
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K2 “Open Graph” XUEHE. 411 12.40 FroR.
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B {f “Results Browser” Fi££ “File” = “Open Graph” = “Open Graph as Template”
JTA BT “ Waveform” % 1R R FHFIZ Y SCA-AH IR B
® FIEFEM “Waveform” B IAE M ABAR :
B 7E “Waveform” & LR “Graph” - “Template” - “Set Current”
B B 1) “Waveform” & H#0HE K FHATZ “Waveform” & FUAH A 3 B (HIEIXFE
FEAE I AR, OO BT N UG R B A R AT R S N iR, T X
“Waveform” & I ERAF A A, AEA0Ath DABIAR ¥ 7 XTI, A ReAl % “ Waveform”
TR E .
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B 7E “Waveform” & 1 IEH “Graph” > “Template” - “Set Default”
B B “Waveform” 7 TR “.cdsenv” HIRE . (HA& M ETH R IWEEREA
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